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Photography
Tips, Tricks &Fixes

Photography has always been a popular hobby, but with professional-grade
equipment now more available and affordable than ever before, more and more
people are picking up a camera for the first time. The right equipment will only get
you so far, however, and to truly take your photos to the next level, you'll need a good
understanding of what makes a great picture. That's where Photography Tips, Tricks
& Fixes comes in. In this bookazine we'll teach you essential techniques to enliven
your landscapes, enhance your portraits, sharpen your macro shots and more. Every
step of the process is covered — from preparation, to shooting, to post-production
— so0 no matter what stage of a project you're at, you'll discover outstanding advice
to edge you over the finishing line. Our Tips section will give you a comprehensive
overview of popular areas of photography, from landscapes to backyard wildlife. In
the Tricks section, we'll cover a host of exciting projects, including shooting fast-
moving subjects and creating gorgeous time stacks. And finally, in the Fixes section
we'll show you how to edit your images to achieve the ultimate finish. Read on and
help your photography to realise its true potential.
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Stand out
Ensure your images stand out with pro
techniques that include balancing flash 5
and ambient light, shown here in this % e = -
excellent capture from Neil van Niekerk IS 4 i
© Neil van Niekerk 4 L) =
¥ &
MEET THE PROS B '
! Katelyn James Ronya Galka Adrian Dennis h ' lan Rolfe Andy Farrer
\I| katelynjamesblog.com v ronyagalka.com adriandennis.com & 'l ianrolfelightscapes.com andyfarrer.co.uk

Professional wedding — § Street photographer Galka Award-winnng sports ‘; / lan Rolfe reveals how Landscape photographer

photographer James ~ +*/ »& considers wide-angle photographer Adrian Dennis /‘" ® sunstars can add Farrer shares his tips for

explains how to work \ & ,A lenses and how to shares his tips for capturing a > something special to a stunning landscapes

in harsh light. *_ ¥  capture movement. strong sense of movement. l ’ landscape scene. and seascapes.
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- Take your photography to the next level
- with these top professional techniques

ith photography becoming increasingly
accessible in recent years and the:rising
numbers of serious hobbyists ‘and amateur
photographers looking to flaunt their. skills:on
social media, it has never been more important to
make Sure that your photos stand out from the
crowd. [t is often easy to spot a professional image.
so we've complied ten top tips from some of the best
photographers in the business that will help you to
elevate your imagery and take your photography to the
next level, which should ensure that you have the stand-
out image. 4

e

Phil Drinkwater Moritz Schmittat ¥

Drinkwater discusses low light
and exposure compensation.

explains the benefits of
using a kicker light.

Neilvan Niekerk

neilvn.com
Discover how to balance
flash with ambient light

with tips from pro shooter 5 your work, as Christina
Neil van Niekerk. &

Over the next few pages discover how to handle
difficult light, expose your people pictures to perfection
and learn how to make the most of natural reflectors
in the environment. Find out what it takes to shoot
immersive street shots and stunning landscapes with
tips on using wide-angle lenses and composition for
striking results. We've also covered lighting tips that will
transform.mediocre shots into high-end, professional-
looking captures, which include off-camera flash tricks
and studio lighting advice. And if that wasn't enough,
discover the importance of colour in your imagery and
realise the power 'of shooting RAW.

™~ Christina Greve

christinagreve.com
Using RAW correctly ¥ Portrait, fashion and editorial
is incredibly important to h’ "? photographer Scheidt

S explores how to balance the
%ﬂn colours in your photos.

"'\1 Sean Scheidt

seanscheidt.com

Greve reveals in her tips.
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1. Meter
right in
difficult light

Capture perfect pictures
In both harsh light and
low-light conditions

Light from the Sun isn’t always soft and
flattering. At midday it can be very harsh,
creating very unflattering shadows.

“Harsh light often creates unwanted shadows
on faces and overexposed highlights on the
subject, foreground or background,” explains
wedding photographer Katelyn James. “Some
photographers would say that the only way
you can shoot correctly in harsh lighting is
to use artificial light to balance the Sun'’s
intense rays. | have found that's not always
true, especially for photographers like me who
prefer natural light styles.”

James follows a simple rule of thumb when
shooting outside. “The goal is to keep the
Sun to the back of the subject’s head, as that
protects them from spotty or uneven light
that can be hard to expose properly... Other
things | strategically try to do when shooting in
harsh light [include] finding natural reflectors,
keeping the light from my subject’s face and
chest and looking for diffused light.”

When taking pictures in harsh light, you
should set your camera’s meter to spot
metering, so you can select where your camera
is metering from. “In my opinion, metering
for the face is the easiest way to find proper
exposure in harsh lighting situations, and this
will immediately show you if your background
is going to be overexposed or not,” explains

your camera

Avoid high ISOs by placing
your camera on a monopod to
stabilise it, enabling you to shoot
at a slower shutter speed than
would be possible otherwise.
Monopods are much quicker
to use than tripods and
are very portable.

Above Left

Less atmosphere Take control

This image has been By using negative exposure
skilfully framed, but a compensation, Drinkwater
darker exposure would add prevented the camera’s meter
more drama to the scene from brightening the shadows

10 Photography Tips, Tricks & Fixes
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James. “You have to use spot metering in
these situations, or else your camera will
evaluate the situation for you and will decide to
underexpose your image.”

Low light can be just as problematic, as
Phil Drinkwater explains, “Let’s say you were
shooting a city night scene in an auto mode
(such as Aperture Priority) where 85 per cent
of the image was near black with just some
twinkles of light from houses. You would dial
down the exposure compensation in order to
compensate, otherwise the camera would try
to make the average of the scene grey — so
the black would be grey and the house lights
would be overexposed.”

Exposure compensation can be used in
all conditions. “Shooting in low light itself
doesn't lead to using exposure compensation
differently to using it in the daytime,”
Drinkwater continues. “I tend to use auto ISO
these days when using auto modes; not always,
but most of the time. By using exposure
compensation, sensible minimum shutter
speeds and maximum IS0, | find the camera
makes virtually the same decision as | would
95 per cent of the time. It's especially useful
when going from indoors to outdoors; [just]
change your exposure compensation to match
the brightness of the scene.”

Inset
Exposure
compensation
This button is one of
the most important
onyour DSLR or CSC

Above

Even tones

Spot metering and
careful positioning of
the couple in relation
to the Sun results

in a well-balanced
exposure with good

. skin tones

Left
Unbalanced
exposure

The camera has

struggled to record
all the tones in the
scene in a way that's
pleasing to the eye,
with areas of flare
that are distracting

2. Use natural reflectors

lluminate your naturally it imagery with reflectors found in the environment

Natural light is difficult to control, and P Lo 3
depending on where the Sun is in the sky it can ( : ”; v &x :xﬂ';%?g‘fgfg %
produce very undesirable shadows, especially = b e ; : s - white nghtmweudmg" %‘T
under the subject’s eyes. One solution is to i = 7 o 5 shats,uﬁné‘a'é‘@oﬁred 3
position your subject next to an object in the /4 . L . e "’éﬂec"”}" addwarmth - &
environment that will reflect the light and / 4 7 = ‘ _ ',‘- e '-'*°3'°£~b k)

fill these shadows. These natural reflectors
are perfect for wedding photographers in
particular, as it means less kit to carry around.
It's important for photographers to think in
terms of light and once you start searching
for natural reflectors you'll notice potential
sources everywhere.

“Natural reflectors are so important,” explains
Katelyn James. “When you are looking for a
natural reflector, keep in mind that it should be
light in colour and reflective of light” This can
be anything from a light-coloured pavement
or wall, a window or even a golden field of
wheat. However, you'll need to watch out for
unwanted colour being reflected onto your
subject. “When you are photographing a
bride and groom it's very important that the
reflecting light is clean and doesn't have any
colour to it," advises James. This is to ensure
that the bride’s dress stays pure white — but a
warm hue might be welcome at times.

O hotography Tips, Tricks & Fixes 111 |




3. Go wide and get close

Shoot with a wide-angle lens and get near to your subject for extraimpact
i .

Often photographers become far too reliant
on their zoom lens, and instead of getting in
close to their subject they shoot from further
back than they should - ultimately detaching
themselves from the scene.

For professional photographer Ronya Galka,

prime wide-angle lenses are the best choice
for street photography, because these types
of lens are close to the focal composition of
the human eye — her particular favourites are
35mm and 50mm. “They give a wonderfully
realistic vantage point for the viewer and help
depict street scenes in their most true-to-life
manner,” explains Galka. “A wide-
angle lens enables me to get
great shots up-close, but
equally allows me to tell
a more comprehensive
story when the context
of the wider scene is
given.” A simple wide
shot of a street scene

advantage

“Wide-angle lenses [offer]
much greater depth of field, [so]
it's much easier to obtain front
to back sharpness... the horizon

! ]\

© Ronya Galka

appears much further away from

with no foreground
interest will lack impact
and can often feel quite
detached - great street
photography should be
fully immersive. This is also true

when this technique is applied to landscape
photography; getting in close to a foreground
object while capturing the wider landscape
beyond adds context and a sense of scale to
the image.

2x © lan Rolfe
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4. Add some spark
lan Rolfe’s top sunstar tips

Use a small aperture | find any f-stop
smaller than 16 to be usually sufficient,
but f22 is the optimum.

the foreground, adding depth
and a sense of space,”
explains Farrer.

© Any Farrer

Street shot
£ “If you want to

immerse yourself

in a scene and get
properly involved in what you
see, there is nothing better
than to get real close,” says
Galka. As photojournalist
Robert Capa famously said,

“if your photographs aren’t

good enough, you're not close
enough' Galka agrees and
says that when a street image
is shot on a wide-angle lens
the viewer should feel like they
are part of the scene

= =S Professional
422 )i landscape
m photographer Andy
Farrer says, “Getting in close
to foreground objects guides
the attention of the viewer to
the elements which you have
chosen. It will also make them
appear larger in relation to the
background, adding impact”

( Y Old Harry
4

are getting flare it may just be because
of the angle at which the light is hitting
your lens, so consider changing your

composition to avoid it.

Lens choice If the amount of aperture

blades is an even number, it will produce
that many points — if the amount of blades
is an odd number, it will produce double as

many points.

of your scene.

Avoid flare Make sure your lens is
spotlessly clean and also avoid using a

filter of any kind in front of your lens. If you fog, mist or pollution.

Block the Sun In order to get a crisp

sunstar you need to partially block the
Sun with an element in the scene. This
basically just shrinks the size of the light
source and helps it to flare as opposed to it
just being a white, overly bright component

Light matters Clear weather is a must.
If you want a really crisp sunstar, then
the Sun should not be diffused by any cloud,
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= 5 Capture
— movement

A clear sense of action
inyour images adds a
very professional touch

A sense of movement and motion in your
photos will add dynamism and energy to your
shots, making them much more compelling.

As professional sports shooter Adrian Dennis
explains, “while it can be quite normal to shoot
a rugby or football match at 1/2000 secs to

‘ :Ill);‘tlgrbike pan capture the moment a player kicks the ball,
Be creative when you are photographing a racing car using a fast shutter
shooting a sporting event, speed freezes the wheels and makes the car
especially when there are a lot of look stationary” — completely removing the
cqmpeting phlotographers.This sense of movement.
2’;”;2"2 )S' (t):trlc'n;sgf:;f;g ;sz To capture this movement you need to
have perfectly frozen the action adopt a panning technique. With a slower

shutter speed set, physically move your body
The Rat Race and camera while keeping them in the same

important for me in the the subject is a racing car, for example, then
wisl subjects that | capture, somewhere on the main body should be sharp,
but itis also a fundamental part with the wheels showing some motion blur.
of my technique when shooting
street... | shoot while onthemove 1 N€ background shquld also be completely
and | think that movement makes blurred. It can be tricky, especially if your

ﬁ--,wovemem is not only part of the frame throughout the exposure. If

for images that feel much more subject is moving fast, and keeping it in the
dynamic and alive,” explains same part of the frame throughout is difficult.
Ronya Galka. There'’s no motion .

) Results can also be hard to predict, but a good
blur here, but each person’s . o
position gives a sense of action panning shot can be really striking.

6. Work
with waves

Incorporate the
patterns they create

Using the pattern of waves as lead-in
lines in your seascapes is a useful skill.
Landscape photographer Andy Farrer
explains that “connecting the foreground
and background will give better continuity
to an image, making it feel like one
image and not just a foreground and a
background. Waves provide a natural and
pleasing way to link the two.” These natural
lead-in lines will help to draw the viewer
into and around your image.

The sea is a constantly moving
entity, and unless you are shooting on a
particularly calm day, the motion of the
moving water will create lots of interesting
patterns that will add interest and help to
convey the mood of your image.

© Andy Farrer
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/. Balance
the light

Learn how to use off-camera
flash for shooting striking
portraits in ambient light

On-camera flash can often be rather harsh, but the
simple act of taking it off and moving its position can
utterly transform your imagery.

When it comes to outdoor photography flash
may not always be the obvious choice, especially
when you consider some of our previous tips on
tackling extreme natural lighting. However, in certain
circumstances balancing flash with ambient light will
really lift an image and give it more depth.

Without flash, if you expose for the subject your
background will overexpose, and if you expose for the
background then your subject will be underexposed.
So the best technique is to position an off-camera
flash to illuminate your subject and set your exposure
to underexpose your background by around a stop
or two. Experimentation is key here.

For professional photographer Neil van Niekerk, conservatively, | often see photographers Loop lighting. This way there are no

“the balancing of the flash and ambient light is who are new to using off-camera flash dramatic shadows and there's little risk
essential, but it's also just as much about the place the flash too low, or too far off to of the shadow of your subject’s nose
positioning of the light and how you pose your the side.” Van Niekerk goes on to explain creating a Charlie Chaplin moustache, or
subject in relation to it. The key here is to work that “I aim to have Butterfly lighting, or streaking across their cheekbone.”

8.Usea

kicker

Enhance the depth and
dramain your portraits
with this simple addition

“A kicker light is the magic ingredient to
making your portraits three-dimensional,”
says portrait photographer Moritz
Schmittat. “A main light, or key light,
typically lights only one side of your
subject’s face, and while this creates lovely
light and dark areas on the front of the
face, it doesn't do much for the subject’s
outline. This is where one or several kicker
lights come into play... | tend to place my
kicker light exactly opposite my main light
in order to emphasise the contour of the
hair. It's a good idea to place the kicker light
slightly higher than the subject and pointing
downwards. The most important variable
is power. If you overdo the kicker light your
portraits will feel unbalanced.”

a B

14 Photog

© Mortiz Schmittat
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Consider the

ambient light Take @ K
a few test shots without n ‘
flash and assess the 2
results. Once you know b |
T - what the exposure A
should be in order to 3
expose the ambient 2 ; J "----....,
o\ light accurately, set your 2 k Seeectnee aue,
£ § ';""' camera to Manual mode é " -
A A A A A A B and set the exposure
to underexpose the Set up your camera and position the
3 ambient by one or two flash You must ensure that your shutter
% stops. This helps to speed is no faster than the maximum flash
% create a high-end look sync speed of your camera — this is usually
A A AL L AL R LN RN NE and feel in the image. around 1/200secs.

-

D—

SPEEDLIGHT SB-800

Quality
of light

T
NOLLOYO
278

The closer you position your
speedlight or studio flash to your
subject the softer the light will be. Hard

. & light is characterised by hard edges
e between the light and shadow and
© Neil Van Niekerk Y soft light has a smoother transition.
If you want the light to be
Above Expose the flash Set the flash to harder simply move the
With flash Manual and start on 1/4 power to begin light further away.
Here the flash has completely n
i : o with. Once you have taken some test shots
ifted the image and illuminated ~ ¢ X
the model while balancing the you might find that you need to dial the
ambient light with the flash power up or down depending on the results.

O. Control colour

Sean Scheidt reveal his tips for
tonal balancing

What is the importance of deliberately  possible. It helps me to sketch. Take test

restricting the tonal palette in photos?  shots and really look them over. Notice

For me, everything comes back where your eye gravitates towards. Are

around to intent... using minimal there distractions? If so, remove them.

complementary colour combinations

really helps create a unified sense of a How can careful editing help to

‘world" within the photograph. There is a enhance this effect?

visual consistency that allows the viewer  After the usual dodging, burning

to access the subject, feel the tone or be  and contrast adjustments, | spend a

drawn into the story we are telling. great deal of time focusing on colour
toning... again focus on how your eye

What advice would you give to other travels. Remove any distractions to the

photographers when it comes to overall composition. This takes care of

dealing with colour? everything you weren't able to get in-

Remove all that is unnecessary... a camera or perhaps some things you just

plate of food made by a talented chef didn’t notice.

only has on it that which is absolutely

necessary for the overall dish. Anything ~ Right

else is superfluous, muddying u Tonal harmony
P ! ying up If you study the work of many professional

the experience. Be thoughtful as you photographers, you'll see that they are very mindful
shoot and plan your shots in advance if of colour balance

‘ Photography Tis, Tri
N

(
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10. Get more with RAW
] of detail will mean that you are able

to make large crops to your image

Give yourself maximum power to control the without losing too much quality.
|OOk Of your |magery The Brush tool Fix highlights or

open up shadows in specific areas

Despite many advances in JPEG quality, your shots. Technically every image that of the image. Control where you want

professional photographers will still generally is captured by your camera captures the the viewer's eye to focus.

opt to shoot in RAW format, favouring the entire sensor information, but as soon as you

extra editing options that it provides them with  switch to JPEG you are giving your camera Classic curves Play with the Curve

in post-production. permission to discard a large chunk of that by raising it slightly at the top and
“The control it gives me when | edit is potentially important information. It makes in the centre to add light, and lower it

absolutely wonderful, almost magical... As a far more sense to choose RAW and keep the i e (el o Sk corEEt

lifestyle photographer always on the move, power in your own hands.

there’s often little time to organise the Although best practice dictates that you White balance Shooting RAW

perfect setup for my photos like you would should perfect your settings like exposure and enables you to radically change

dq in a studio. Thgt's when shooting RA'Wlls wh|t§ balance in every sho't that you take, RAW and fix the white balance of your

a life-saver," explains photographer Christina provides photographers with a valuable safety

) ) . I ; images post-capture.
Greve. Each RAW image file retains all of the net and flexibility post-shoot that JPEGs don't.

information that is picked up by the camera’s The most important thing to remember is that Levels of brightness RAW allows
sensor, which means that you'll be able to editing RAW files is completely non-destructive, you to make radical adjustments
radically edit your images without degrading unlike JPEGs. to Highlights, Shadows, Blacks, Whites

"RAW provides photographers with a .
p ege xposure If you have shot in RAW
valuable safety net and flexibility post- you will be able to recover even the

most over or underexposed imagery

shoot that JPEGs don't” without losing qualty.

Contrast and Brightness.

v, v

-
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I ‘ : ; Develop your camera skills and explore
new genres with these top tips

Master pro landscape
compositions

Learn to capture portraits with
impact

Shoot your best black & white

Photograph wildlife in
your backyard

Creative sport & action
Master macro on a budget

Learn how to shape the light

Landscapes

Master composition
to capture stunning

outdoor images - Canon
—

CANON EF (g,

18 Photography Tips, Tricks & Fixes




TOP TIPS‘

v/ Gorgeous
landscapes

v/ Pro portraits
v/ Lighting tips
v/ Master macro

N

42

Take your éfUdib»—
lighting work to t

= “Knowing exactly
=182 what to look for in
alensis essential”
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uccessful landscape photography year or day the angle of the Sun will best suit it, Composition in landscape photography is

comprises two key elements — partly persistence and partly luck. in many ways a problem-solving activity. The
light and composition. Of the two, Composition, on the other hand, is very first problem is: how do you create a balanced
composition is arguably the more important: much within our control. Obviously, you have and harmonious composition when the natural
for most people, a well-composed shot in less-  to work with what is in front of the camera, world is, on the whole, visually chaotic?
than-ideal lighting is generally more pleasing because apart from small objects, it is not Secondly, how do you best represent the three
overall than a poorly composed shot taken in possible to physically move the elements in a dimensions present in the natural world, using
perfect light. scene or introduce elements into it. However, a two-dimensional medium?
Photographers have very little control over changes in viewpoint, focal length, camera

lighting in the landscape. Photographing a height and angle all have a significant impact
chosen location in the right light is partly a on what elements ed in the frame
matter of research to find out at what time of ~and how they are rer ‘ :

Balanced composition

Fantastic light alone isn’t enough for

a successful image. You also need a
composition in which the elements are
arranged to create balance and harmony
Allimages © Mark Bauer

20 Photography Tips, Tricks & Fixes
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Achieve
balance and
harmony

Understand these basic
principles to help produce
appealing compositions

Composition is the art of creating order
among the chaos of the natural world,
achieved by careful selection of what we
include in the frame and where we place
those elements.

Probably the best-known way of
organising the frame is the rule of thirds.
Imagine a grid dividing the frame into
thirds both horizontally and vertically. The
components can then be organised around
these divisions, with key focal points placed on
the intersection of horizontal and vertical lines.

The rule of thirds is a simplification of a
naturally harmonious proportion known as
the golden section, which has been used in
art and architecture for many centuries.
Start by dividing the image frame into two
rectangles, so that the ratio of the smaller one
to the larger one is the same as the ratio of
the larger one to the whole frame (this ratio
is approximately 1:1.618). If you continue to

22 Photography Tips, Tricks & Fixes

subdivide the frame along these lines, you
end up with something that looks like a
‘squashed up' rule of thirds grid and which
can be organised in a similar way.

The use of lines in the landscape — paths,
roads, streams and so on — is another way to
add structure. These leading lines are also
very useful for highlighting the main subject
in the composition. Diagonal and converging
lines are especially dynamic.

There's more to visual balance than the rule
of thirds or golden section, however. Thinking
of physical balance can help us to understand
its principles. If you place two objects of equal

Right

Rule of thirds

This peaceful river scene
is organised according
to the rule of thirds, in
particular the church,
trees and bed of reeds

Below
The golden section
This image’s harmony
comes from the fact that
the main focal point —
the chalk carving
—is placed
precisely on an
intersection

in the golden
section

Rule
of Odds

One simple tip to increase
harmony in compositions is to

weight on a seesaw, they will need to be
equidistant from the fulcrum in order to be
balanced. In visual terms, there is symmetry,
often considered harmonious but somewhat
static. With two objects of different weights,
the lighter one has to be further away from
the fulcrum to achieve balance, which in
visual terms creates asymmetric balance —
usually considered to be more dynamic.

We don't consider the physical weight of
objects in the frame, but rather the factors
which contribute to their ‘visual weight' -
including size, brightness, contrast, complexity
and texture — and place them accordingly.

remember that odd numbers are
more pleasing to the eye than even
numbers. So, if including a group of
objects, where possible make sure
the group is an odd number.
Three is often regarded as
the magic number.



FOCAL POINT

The churchis placed on
the intersection of two
lines in the golden section.

BALANCE

The horizonis placed on
a horizontal line of the
golden section.

LEADING LINE

The line of rock leads the
eye through the frame to
the main subject.

Strong foreground

interest creates linear
8¢ perspective, addinga
*i;‘x sense of depth.




Create depth

Use lines and foreground
interest to convey a sense
of distance

One of the main difficulties landscape
photographers face is how to create a sense
of depth using a two-dimensional medium.
Exploiting the same visual cues that the brain
uses to judge distance and depth can help.

The main way the eye judges distance is by
linear perspective — the fact that objects of
a similar size seem to get smaller the further
away they are, and that parallel lines seem to
converge in the distance. One easy technique,
therefore, is to get in close to foreground
objects with a wide-angle lens, making them
loom large in the frame with the rest of the
scene stretching out behind. Careful choice
of foreground is necessary however, as it
needs to complement rather than clash with
the background.

Lines are an excellent way to lend depth to
a scene. Converging lines are powerful depth
cues as they create strong linear perspective,
but any diagonal coming into the frame works
well. Lines can also direct attention into the
frame and highlight the main subject. Lines
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coming in from the corners of the frame

are especially useful as ‘pointers’ for subtly
directing the viewer's attention, and S curves
are excellent for taking the eye gently through
the composition.

Top

Converging lines

The path in the foreground
suggests depth as the lines
appear to converge, and it
directs the eye towards the
copse on the hill

Above

Diagonal

The strong diagonal line
draws the eye in, but
doesn't highlight the
focal point so effectively,
as it curves away from it



Geared
tripod heads

Tripod heads with a geared
movement — such as the Manfrotto
410 Junior Geared Head — can

really help composition. They enable
you to make very smooth, precise
adjustments and therefore let
you fine-tune compositions
with a high level of
accuracy.

Be precise

Strong compositions come
from identifying and only
including the key elements
of ascene

The best compositions are often the simplest.
Too many elements in the frame can be
visually confusing and dilute the impact of the
image, so try to exclude anything that does not
contribute to the composition.

The best way to start is by trying to identify
what it was that drew you to the scene and,
if possible, exclude anything else from the
frame. Even small changes in position can
have a huge impact on how things appear.
For example, lowering the camera can often
hide distracting elements, whereas a higher
viewpoint can ensure proper separation
between foreground and background planes.

Before pressing the shutter, have a good
look around the entire frame to make sure
that it is free from clutter, and fine-tune the
composition if necessary by changing camera
height, repositioning the camera or changing
focal length. A careful check of the review
image is also recommended.

E First attempt The overall shape of this
composition is pleasing, but the trees in the
bottom left are distracting and hide the inlet —
an important focal point.

B A slight refinement Moving to the right
removes the trees, but there is too much
foreground and the rocks on the right edge of
the frame are distracting.

EJ Final version A change of focal length
has refined the composition, providing better
balance with less foreground and reducing the
impact of the rocks on the right.

: Tips| TricksIFixes
P n g e e




/) | Tips| Tricks|Fixes
2 =~

Correct
framing

It's not easy to frame shots
with the intention of cropping later
to an alternative aspect ratio, but
luckily many cameras enable you
to select a different aspect ratio in
the electronic viewfinder. This
allows experimentation with
alternative framing
possibilities.

Work with aspect ratio orientation

Get creative by changing the camera orientation or image dimensions

The majority of photographs are taken with
the camera in a horizontal or ‘landscape’
orientation. This is partly because this fits
the human field of vision, but also because
most cameras are more comfortable to
operate this way. However, not all landscapes
suit a horizontal framing and sometimes
turning the camera on its side can
dramatically improve a composition.

A vertical or ‘portrait’ orientation is
obviously more suited to vertical subjects,
but also works well when there are strong
diagonal lines in the scene, as this places
emphasis on those lines and makes the
composition more dynamic. It is also an
effective way of placing more emphasis on
a strong sky or foreground.
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Landscape format is more effective when
there is a predominance of horizontal lines
in the scene or horizontal movement - real
or implied. With minimalist compositions,
where you place a small object in a large area
of negative space, horizontal framings also
tend to work best.

Another natural tendency when composing
images is to stick with the native aspect ratio
of the camera, even though this may not suit
the scene. For most cameras this is 3:2, but
micro four-thirds and medium-format
cameras use 4:3.

The 3:2 ratio works well in many cases, but
the squarer 4:3 ratio makes it easier to exploit
foreground interest when working in landscape
orientation, and is also more naturally suited

to portrait format. A completely square format
suits minimalist compositions, especially with
the subject centred or placed boldly towards
a corner. It also works extremely well with
symmetrical scenes. Using a square ratio can
really encourage creativity, as it encourages
photographers to look beyond the traditional

‘rules’ of composition.

Panoramic images have always been popular
with photographers, and for scenes where the
tendency is to scan across the image from left
to right, or where there is minimal foreground
interest, they are the natural choice.

If you are struggling to ‘see’ a composition,
try composing with a aspect ratio in mind — it
may simply be that the scene doesn't fit neatly
into your camera’s native aspect ratio.
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1 Native ratio Although this composition
works well in the native 3:2 aspect ratio, with
empty space to the sides attention wanders
slightly from the main subject.

2] Square format The square crop really
tightens up the composition, forcing attention
firmly on the main subject. The symmetry
works well in the square ratio.

ﬂ Panoramic format This scene also
works well in panoramic format, which places
emphasis on the strong horizontal line of hills
in the background.

I3 Portrait orientation Shooting this scene
in portrait orientation allows emphasis to be
placed on the diagonal line in the foreground,
as well as the dramatic sky.

E Landscape orientation Shooting the
same scene in landscape format creates a less
dramatic angle on the foreground path and
loses some interest in the sky.

Portrait or landscape?

How to choose the best orientation
for the scene you're shooting

PORTRAIT FORMAT

Vv Puts more emphasis on the foreground
and can therefore create more depth.

v/ Can emphasise diagonal lines in

the foreground, adding more drama to

a composition.

Visa simple way of giving more emphasis
to a dramatic sky.

X Can look unnatural as our eyes are
inclined to scan across an image.

X If the horizon is very dominant, vertical
framing can clash with this.

X Is harder to show subjects in the context
of the surrounding landscape.

LANDSCAPE FORMAT

Vv Works well with scenes that have strong
horizontal lines or movement in them.
Vs good for single subjects in negative
space, as it suggests isolation.

v/ Feels more ‘natural’ as it is closer to our
field of vision.

X Places less emphasis on the foreground
and therefore can give less impression

of depth.

X Doesn't allow you to place emphasis on
dramatic skies very effectively.

X Doesn't let you create such dramatic
angles with diagonal lines.
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Camera height
and viewpoint

The simplest perspective
adjustments can have the
biggest impact

Tripod height

H Tripod at head height There is a

strong, carefully placed focal point in this
image, but with the tripod legs fully extended,
there is not enough foreground to balance

it and too much emphasis is placed on the
empty middle distance.
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When organising the elements in the frame, it
is vital to ensure that each part has the right
amount of space. Camera height and angle

play a major role in this, especially when
it comes to achieving visual separation
between objects.

Visual separation is closely linked to depth
perception; without separation, it is easy for
objects on different planes to merge into one
another. This can be exploited for comic

HF Tripod at chest height Shooting slightly
lower — at chest height — is an improvement
as some bracken is now included in the
foreground. However, there is still too much
empty space between it and the tree, and the
shape of the foreground is rather untidy.

effect — with people apparently holding a
distant object in their hands, for example.

In landscape photography, however, the effect
of not separating the key elements in

a composition can be a lack of depth in

the image. Camera height significantly
influences visual separation: a high viewpoint
separates the planes and opens up the
middle distance, potentially creating a greater
impression of depth. A low viewpoint does

H Tripod at ground level Shortening the
tripod legs and setting the camera up just
above ground level improves the shape of the
foreground, so that it provides a lead-in to
the focal point and reduces the impact of the
empty space behind it.




the opposite and can be a good choice when
dealing with an empty middle distance, as this
can reduce its impact.

Low viewpoints can also add drama to
a composition by placing emphasis on the
foreground, making it loom large in the frame
and creating dramatic perspective. Care
must be taken to ensure foreground and
background elements don't merge together
and reduce perceived depth. The angle of

Cameraangle

1 Camera upright Keeping the sensor plane
level helps to prevent distortion, but doesn't
create the most interesting composition in this
case. There is too much sky and no interesting
lines in the foreground to lead in and create
depth in the image.

the camera — whether it is level, pointing up
or down - can also influence composition,

but it's not simply a matter of pointing the
camera up to include more sky or down to
include more foreground. With wide-angle
lenses, having the camera anything but level
introduces distortion. This can be exploited to
exaggerate the angles of objects in the corners
of the frame; lines can be generated to act as
‘pointers’ and direct attention within the frame.

B Camera angled down Here the rocks
in the bottom-left corner point neatly into
the composition, generating interest in the
foreground and helping to produce depth.
However, the 50:50 division of foreground
and sky is a little static.

Tips| Tricks | Fixes

Live View

Very high or very low
camera viewpoints make
framing awkward. Fortunately,
most cameras have Live View on
the rear LCD, and articulated
or tilting screens can make it
easier to compose from
difficult angles.

A Camera angled down further This
creates a more dynamic composition, with
leading lines snaking in from the bottom-left
corner, directing attention towards the rugged
headland. Balance is achieved by placing the
horizon on a golden section horizontal.
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Learn to capture.
ORTRAITS

.

=& 1IMPA

Discover how to create incredible
Images that convey a sense of character

apturing portraits that make people portrait with impact. Over the next few. pages,
‘ want to look twice is something that however, you will discover some of the key

every photographer desires to achieve, considerations and skills that photographers
and very often what'’s required for that to can utilise in order to increase their chances
be the case is plenty of visible character in of success in this respect. From lighting on
the image. This is obviously a very nebulous location to simple setups that you can try
subject and can be interpreted in‘a number at home, all the way through to street and
of different ways. What defines character to travel photography, there's something here for
one person is not necessarily what defines almost any type of portrait photographer. Read
character to someone else, and there are on to discover the techniques that
many different methods and approaches that the pros use to help them capture portraits
one can adopt when it comes to capturing a with character.

Photography Tips, Tricks & Fixes
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Capture character

A sense of personality from the
subject you are photographing will
make a big difference to your image
© Kerry Moore

Photography Tips, Trig




Choose your approach

The technical aspects of a character portrait
are often second to your interpersonal skills

As with so many elements of photography,
there are very different approaches that you
can choose to take when it comes to shooting
portraits with character. One might argue that
all portraits must convey character if they are
to succeed. “Portraiture is a broad field of
photography,” says pro photographer Jarek
Duk (jarekduk.com). “It can be broken down
into many more specific areas like simple
head shots, studio portraits, environmental
portraits and so on. Each one of them will
carry its own technical aspects but one thing
is true for them all: successful portraits need
to have personality and character.” But what
defines character, and how do you ensure
that this is present in your portraits? Perhaps
the most essential element is that you have
to show something that's real — a genuine
reflection of a genuine person. “You have to
learn the basics of your gear, lighting and
composition first.

However, you don't need to be, as many
believe, a master of all of the above to shoot
great portraits with character. You just need to
be confident enough so the technical aspects
do not stand between you and the human
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being in front of your camera — after all, this
is the most important ingredient of the work
you are about to produce. One of my favourite
photographers once said, ‘In order to shoot
great portraits you have to be 10 per cent
photographer and 90 per cent psychologist.

| could not agree more. So all the technical
aspects that beginners [sometimes] like to
focus on so much are contributing merely 10
per cent to your final success, the other 90
per cent is your ability to connect with the
subjects, your interpersonal skills, the respect
you give your subjects, the comfort zone you
will create for them so their personalities can
shine through.

The images you see actually feature real
barbers and their clients. No models would
ever give me this much personality and
character. Prior to the shoot | had spent pretty
much the entire day with these guys. | got a
haircut, listened to their stories, got to know
them on a personal level and even got a shot
of bourbon from under the counter. Yes, it
took a lot of time and preparation but in return
| walked away with a set of great images and
the feeling that it was worth it

Above

Real lives

These portraits aren’t of models, but instead feature real
barbers with their clients. Jarek Duk argues that the most
important part of shooting portraits with character is to
capture the stories of real, genuine people, and develop
good interpersonal skills in order to get to know your
subjects and build a level of trust



Right

Keep it simple

Window light is one of the
simplest but most effective
light sources, and the lack
of fuss involved can be
ideal for capturing portraits
with character

4x © Jarek Duk
Far-right
Shoot it quickly
Many of the best portraits
with character were
captured very quickly, in
a situation where the
photographer didn't have
long in which to get the shot

Tipsl Tricks|Fixes

Make it seem spontaneous

Photographer Pete Bartlett (petebartlett.com) discusses the work of Jane
Bown — a master at capturing the most engaging sense of character

I've been lucky enough to shoot a few of the
same famous faces as Jane Bown, and have
been told a number of times that I've chosen
the exact same spot that Miss Bown

chose herself. One example was lan Hislop,
who | photographed in the Private Eye offices
when | was starting out. It was print day and
there was a lot of stress around the office. |
tried a few different setups with him but his
mind wasn't really with me. When my time
was up | reviewed the images and | knew |
didn't have the killer shot | needed. In a move
of almost Bown-like tenacity | crept up beside
him while he was talking heatedly to the print
manager and asked nervously if | might grab
him for one last shot. | took him all the way to
the top of the internal stairwell where earlier
I'd spotted a little skylight window casting
some lovely Rembrandtesque light onto the
stairs. He focused for a few shots and gave me

‘the shot’, one I've always been fond of.

As we went down the stairs he told me | was
only the second person to take him to that
skylight to be photographed. The other was
you know who!

Jane Bown was a master of using natural
light for her portraiture. Famously she said, “I
last changed my camera 50 years ago. All
| need is a good face and the right light.”
Getting skilled at using natural light begins by
looking and noting down what you see ‘in real
life), then trying to replicate that in your own
pictures. For example, Bown's Beckett picture
is shot in a doorway. Doorways can often
produce a beautiful light. You want to get the
subject out of direct sunlight, as you want to

avoid harsh shadows. Having the door open
gives them a nice dark backdrop to pop out of.

For similar reasons, canal bridges can
provide beautiful light for portraits. Again, you
want to recess the subject out of the direct
light. This tunnel or doorway effect can be
replicated by setting something up in your
garden or wherever you have room. In the
past I've used the frame of a super-lightweight
greenhouse. |'ve covered the top and
partway down the sides with black sheeting.
Straightaway you have a tunnel/doorway that
you can move around to find the right light
and backdrop combo. It produces a beautiful
light for headshot-style portraits.

Bown uses window light fantastically well.
The general rule is that if it's a sunny day and
there's a lot of light kicking about, look for a
north-facing window. Skylights can work well,
but so too can a big window. In the portrait of
Jo Brand | sat her to the side of a big Georgian
window. So as to avoid too big a shadow and
also to get the window catchlights in her eyes,
| asked her to look out of the window. It's very
simple but the big light source gives a very soft
and beautiful light. Looking out of the window
gives a wistful, reflective look to the face.

In a more abstract sense | think an
important part of Bown's ‘technique’ was to
simply be herself. | am sure that because she
was honest and unpretentious, she got honest
and unpretentious portraits from people.
Beyond asking people to be positioned where
| want them, | never ask them to ‘do’ anything
for me. | want them to be who they are in
that moment.

2x © Pete Bartlett
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Work with
natural light

Trevor Cole discusses his
approach to capturing well-
exposed travel and street
portraits with impact

| try to shoot in the golden hours or at least
where there is shade from the Sun, and |
always use natural light. Most of my portraits
are shot while travelling and | strive to use
light in a variety of ways. The soft, warm light
at sunrise and sunset is unquestionably the
best, as the lower angle of the Sun creates
glow and shadows are less harsh. In some
cases side lighting can be used very effectively
by the photographer using spot metering to
highlight contrasts. Where the subjects are
facing the warm light their faces take on an
inimitable glow, which enhances the portrait.
In situations where the light is overhead

and generates shadow it is still imperative

to shoot, if opportunity arises. It is here that
the photographer must use a little enterprise.
Trees provide shade and diffuse the light.
Doorways, the shaded side of the street and
umbrellas all create opportunity to avoid the
intensity of the midday Sun. Natural light from
windows can create interesting reflections
and the presence of dust or smoke in the air
creates beams, which provide an atmosphere
in which to capture those inimitable moments.

Use spot metering

Trevor Cole looks at the benefits
of working with this mode

| use spot metering specifically when |

want a well-lit portrait to stand apart from a
darker background, and also when there are
marked contrasts in lighting. For example,
in the shot on the right | spot-metered on a
highlighted area to ensure it was exposed
correctly, while at the same time casting
the darker areas into shadow.

& Low-key Here spot metering has been
employed to create a low-key effect.

@ High-key | used spot metering here
to ensure that the subject’s face was
perfectly exposed. The background was

lighter, apart from the folds in the scarf, LOW-KEY
creating a high-key image.
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HIGH-KEY!

Left

Work with contrast

A Cuban on the streets of Havana. Here | took
advantage of bright, reflected light on the
street, but also a shadowed background to
provide the variation in lighting

With the colour taken away,
this portrait takes on a much
more direct and immediate
quality, with the attention going
straight to the woman's wizened
expression and haunting gaze.

Convert to black and white

If you are looking to emphasise character, removing
the colour can offer many advantages

WY
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Use shafts of light

An Ethiopian priest in a rock-hewn church

in Gheralta, Tigrai, Ethiopia. The light from a
window created wonderful tones and contrast
as well as casting light onto the rock face

Rather than being a means of
simply improving imperfect
images, converting to black

and white makes it even more
important that the portrait itself
is a strong one.
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Consider the pose

The success of a portrait often depends on the subject’s expression and position in the frame

Trevor Cole's approach to travel and street
photography involves deciding on both who to
photograph and how to capture them. “With
time | have come to select who | want to
photograph, envisaging the outcome ahead
of shooting,” explains Cole. “Taking portraits
of people in the marketplace, street or in a
tribal village requires interaction. There are
clandestine shots that are often taken with

a longer lens and are discreet, but most of
my portraiture is a product of interpersonal
moments. | like to get to know the characters
being photographed. | always ask and even
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when my efforts are rejected | respect their

choice. Sometimes, even with difficult subjects,

spending a little time and using a little humour
can yield positive results. In Ethiopia, one of
my favourite travel destinations, most people
are relatively easy to photograph except,
perhaps, for those who are more conservative
culturally and/or religiously. Even then, | relish
the challenge and will certainly try! If feasible

| seek backgrounds that are uniform or dark
in their colouration. Spot metering combined
with a wide aperture (f1.4/2.8) helps to ensure
that the portrait stands apart and there is

Left

Afar woman

A woman of the

Afar tribe, Danakil
desert, Ethiopia. The
extraordinarily direct
eye contact gives the
viewer a sense of the
woman'’s soul

Below-left

Keep it real

A young boy from the
Entoto hills, Addis
Ababa, Ethiopia. The
boy's direct yet hesitant
gaze suggest a youthful
vulnerability. For the
most impact, your
portraits should always
be believable

Below-right

Shoot the moment
An old Romanian man
on the streets of a town
in Maramures, Romania.
His expression and
facial characteristics
were encapsulated

in the moment. A
spontaneous shot taken
with the available light

Allimages © Trevor Cole

little distraction. Where this isn't feasible |
shoot to capture the moment, again using a
wide aperture to blur background distraction.

| may take a number of frames to ensure

that the image is sharp. With tribal peoples
photography is different. | am very sensitive

to the impacts of tourism, hence | will always
try to make visits sustainable and not promote

‘zooification’! | strive to capture light, colour,

emotion, insight, character and spirit. In the
right light, at the right time, the ordinary
becomes extraordinary and that is something
to aspire to.”
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ADD SOME FILL

Thefillwas a small, hard fill witha warm
gel and diffusion over it. The stand has it
raised up so | don't block the light.

MAIN LIGHT
My main (key) light was
my Profoto 22-inch Beauty
Dish/Softlight Reflector
fitted with a honeycomb
grid to keep the light

nice and focused, while
the grid gives more
dramatic shadows.

AVOID A FALL
Sandbags are my best
friend; it was a really windy
day and weighing your
stands down will stop them
from falling and injuring
your talent.

PORTABLE
BACKGROUND

The pop-up background
means | have aninstant
studio anywhere. It'sa
velvet-type fabric that
absorbs almost all the light,
making it really easy to get
adark background.

Shoot and edit on location

Go behind the scenes with pro Tom Barnes as he explains how he captures character

How do you define character? | interpret

it as capturing someone’s true personality,
which has to be the hardest part of shoots -
especially if you are photographing people who
are not used to being in front of the camera.
For this shoot with Jay from a callisthenics
group called BarSparta (look them up —it's
wild what they can do) | wanted to shoot some
action shots but also get the portraits — this is
my bread and butter and capturing people’s
character is why | get hired. | originally had
planned to use a large octagonal softbox as
my main light, but when we arrived at the
location we were stuck with heavy winds
which meant we were forced to use smaller
modifiers; luckily | love using the beauty dish,
especially on tighter portraits. The lighting
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doesn't necessarily affect the character of

the person in the photograph, but it can

make them feel uneasy if they aren’t used to
being shot with equipment. | get around this
by explaining what everything does (in basic
terms) and it seems to have a calming effect
when working with less experienced talent;

it wasn't needed on this shoot, but it's good

to know. | find posing people when trying to
capture character a little awkward — if you are
trying to capture their natural character you
should avoid getting them to do anything that
might be completely alien to them — it will
look awkward. | chat all the time to the subject
while | am shooting them, | direct them slightly
but instead of getting them to do specific
poses | get them animated through chatting

and telling stories. Some subjects just light
up when they are in front of the camera and
require little prompting, but sometimes these
look too [over the top] — it's all about finding
the balance. When it comes to editing | try to
keep it natural and realistic, | don't smooth
skin although | will remove blemishes and
spots. | tend to do an overall tone curve then
dodge and burn specific areas to give me the
exact look | am after.

Above-inset Opposite

Involve the model Let it flow

| always show people Rather than directing his
images throughout the models excessively,

shoot. It boosts their
confidence on set and
they feel more involved

Tom Barnes prefers to
let their character shine
through naturally
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Image selection Begin rating your favourite
images with a star. Then review these and
rate the best as two stars, then review and rate
with three stars and so on — by the end you'll

have four to five levels of refinement.

N, R

Skin | have a skin healing layer set to
Lighten and | use the Healing Brush to
then heal various blemishes. Set the brush to
a hard edge for sharper results. Re-select your

target point continually to get textures.

RAW tweaks | boost the shadows a little,

bring back the highlights across the scene
and make sure | get an accurate white balance.
| will also do lens correction and more general
tweaks, before opening as a 16-bit TIFF file.

Dodge and burn | put this on a separate

layer, set to Overlay blend mode. | then
paint on to it with a white or black brush to
affect the shadows and highlights — use this
sparingly as it can look overdone quite easily.

Convert to black

and white You can
use any one of multiple
methods — there are
arguments for each of
them — but | like to create )
a new solid fill adjustment i
layer and adjust the
Opacity to choose the
level of desaturation - | e Y
always use adjustment ~ omacty: 0% -
layers as these are non- [N
destructive and can be
adjusted throughout the
editing process.

WD H o@m

e

Radius: 531 Pixels

High-pass filter | use this in order t

give some of the shots an extra bit of
punch and micro-contrast — it is effectively
oversharpening an image so that it affects
tone rather than sharpness.
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Light and edit the human face

Discover a contemporary technique for capturing and
processing a close-up portrait that you can try at home

If you take a look at the work of many modern
portrait photographers online, you'll find that
they often adopt a look that has an almost
painterly feel to it in terms of lighting, yet at
the same time is edited to reveal plenty of
detail. Fortunately, this doesn't require lots of
professional equipment or a big studio space
— you can create this effect at home with just
a speedlight or two. The ability to put some
distance between the model and whatever is
behind them is useful, however, as this allows
you to take advantage of the inverse square
law to capture a background that is at least
fairly dark, but preferably completely black.
Achieving this might require an ambient-only
exposure of 1/200sec (or whatever your
fastest flash sync speed is) and a narrow
aperture of f11 or f16 at ISO 100. Positioning
your key light fairly high above your subject
will enable you to create a butterfly, loop or

Rembrandt lighting effect in terms of the way
the shadows form on your subject’s face,
depending on the angle of the light's position.
You can add a fill light beneath the key light in
order to make some of the shadows slightly
less dense. Soft light, achieved by attaching

a softbox, is easier to work with much of the
time, but you can experiment with a harder
light for the key light if you wish. Have your
subject stare into the lens directly and use

a focal length of at least 50mm (though the
classic 85mm portrait lens is preferable).

The processing involves careful adjustments of
micro-contrast and exposure, so it's definitely
advisable to capture a RAW file.

Opposite

Face full of character

This study was captured with both a key
light and afill light and then carefully
processed to create a painterly effect
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Adjust the sliders Head to the

Basic tab to increase global and
micro-contrast. The Clarity slider is
useful for the latter and it's worth
lowering the colour Saturation and
tweaking White Balance.

Boost the contrast You can
increase the overall image
contrast a little further by going to
the Curves and creating a slight
S-curve, which can be done via a

preset and then manually adjusted.
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Use the Adjustment Brush

This brush, found in both
Photoshop and Lightroom and
most other applications, is ideal
for making local tweaks to specific
areas of the subject’s face.

Adjust hues Another option

is to tweak the Reds using the
Hue, Saturation and Luminance
sliders. This isn't essential but is
useful for enhancing the painterly
feel of your images.

Add gradients These are

useful for tapering off the light
so that the sides of the photo
around the face are darker. Do this
with care, though, as you don't
want it to look too obvious.

Paint in Photoshop Head into
Photoshop and create a blank
layer. Use the Brush Tool set to
a suitable skin colour and a low
opacity and carefully paint over
areas of highlight on the skin.

Use vignette The Effects tab

can be used to add a vignette
to the edges of your image, useful
if you struggled to achieve a
completely dark background
during the shooting process.

Liquify For a deeper edit, you

can carefully use the Liquify
tool to push and pull parts of the
subject’s face — obviously this isn't
the way forward if you are looking
to achieve the most natural result.
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hen did you last see a black and
thite photograph that really
inspired and excited you?
More importantly, who took it — you? It's
very easy to get complacent, reaching a point
where you can produce work that's technically
excellent and creatively sound, but is still
. lacking that all-important ‘wow’ factor.
- Putting a finger on exactly what it is that
elevates an image from average to amazing
- is difficult, simply because there are so many
~ factors involved. The lens you choose, the
. quality of the light, the angle you shoot from,
the proximity to your subject — all these
factors can either add impact or take it away.
Henri Cartier-Bresson's best-known
photographs have impact, but it's very subtle
and a result of careful timing to capture the
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‘decisive moment, rather than because he was
photographing high drama. He took ordinary,
everyday scenes and elevated them to fine art:
a family picnicking on the banks of the River
Seine; a man leaping over a puddle; a grinning
child walking down the street clutching two
bottles of wine.

Although Cartier-Bresson's images appear
to be spontaneous, as though he wandered
the streets shooting on the move, he was

actually far more premeditated in his approach,

composing a scene to make use of geometry
— lines, curves, shadows, shapes and frames
— then waiting for someone to step into that
‘geometric pattern’ As he said in his book
The Decisive Moment, “Photography is the
simultaneous recognition, in a fraction of a
second, of the significance of an event as well

as of a precise organisation of forms which
give that event its proper expression.”

In contrast, American photographer William
Klein, one of the fathers of street photography,
was renowned for rejecting the rules of
photography — using blur in his images, getting
up close and personal with a wide-angle lens o~
so you feel like you're part of the story rather
than a voyeur looking in. His compositions are
often cluttered, with multiple points.of interest.
They seem raw and unplanned, sometimes
technically flawed, but that gives thema
vibrancy and urgency that few ever manage
to achieve.

Here we will explore the factors to consider
when shooting and editing a black and white
image with impact, along with tips on how to
really upgrade your monochrome shots.




Slowly does it

Long exposures record

motionin ascene and enable

youitorecordthe passing

™" oftimeinstead of mert .

: freezing it. The misty seahere \_\
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SURROUNDINGS
A Location carefully chosen
A so the subject would be

backlit by the setting sun.

AUTOFOCUS
Servo AF was used so the
lens continually adjusted

focus to keep the cart and
driver sharply focused.

EXPOSURE
Test shots were taken
to make sure the main
subject didn't record
in silhouette due to the
brightness of the sun.

HEAD-ON
A sequence of shots was taken
as the cart travelled towards the
camera and the best frames
were chosen for editing.

A MOVING SUBJECT
fast shutter speed
(1/1,000sec) was chosen
to make sure the moving
cart was captured sharp.
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Complete
the picture

How do we produce black and white images
with impact when faced with everyday
subjects? It could be argued that a lack of
colour makes it more difficult to achieve. After
all, colour has great symbolic and emotive
value. However, as wonderful as colour
photography is, it can also be too familiar. It
shows us what things look like and leaves us
feeling reassured and comfortable. But in art,
reality isn't always the best solution because
it doesn't encourage us to look beyond
familiarity and appreciate an image for any
reason other than what it depicts. As soon as
you remove colour from an image, everything
changes because it no longer represents
reality. It's an interpretation of the world,
rather than a copy.

Black and white images are more dramatic,
more evocative and more atmospheric. Our
emotional response to a colour image is often
rendered superficial by familiarity, but comes
from a much deeper place when we take
that colour away. Light, shade, texture and
shape take centre stage and what's actually
in the scene becomes almost irrelevant. Good
black and white images inspire the viewer to
complete the picture in their mind's eye.

The late French photographer Lucien
Clergue photographed a diverse range of
subjects, from bullfights in his hometown
of Arles to circus children. However, he's
probably best known for his depiction of the
female nude. In the ‘Nus Zebres’ series he
photographed models in New York; the use
of shadow patterns and contrast transformed
his images into poetic abstracts where light
and shade take centre stage.

Above

Travel inspiration

There's nothing better than travel to open your mind and improve
your skills as a photographer. Exploring different countries and
cultures will expose you to amazing photo opportunities

BEFORE
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Seeing in black and white

Purists insist that in order to produce
meaningful black and white photographs you
must ‘see’ in black and white — step beyond
the realism of colour, strip your subject down
to its bare bones and previsualise how the
final image will look as a monochrome print.

There is some truth in this, but it doesn’t
have to be the Holy Grail. If you're exclusively
a black and white photographer then you're
going to become attuned to seeing the world
in black and white — looking at a combination
of colours and instinctively knowing how
they're going to translate to shades of grey,
for example. You will also set out with the
intention of finding subjects that appeal to
your monochrome vision.

However, the reality is that few of us fall
into that category — we just love going out
into the world, shooting pictures, and while
the majority of them remain in full colour,
some end up as black and white simply
because they work better that way.

Does that mean those black and white
images are going to be inferior? Not
necessarily. The post-production control you
have over a digital image file today means
that creative decisions can be made long
after a photograph has been taken.

The master of pre-visualisation was the
legendary landscape photographer Ansel
Adams. His large-format black and white
prints of the American West, primarily
Yosemite National Park, have inspired for
decades. Adams was a technical genius,

and helped to devise the famous Zone system
that enabled him to set the exposure for an
image based on how he previsualised the final
print to look. His first ‘pre-previsualised’ image
was ‘Monolith, the Face of Half Dome), made
in Yosemite in 1927. Adams made that image
using his last glass plate and put a red filter
on the lens to boost contrast and darken the
sky. He later said, “I had been able to realise
a desired image: not the way the subject
appeared in reality but how it felt to me and
how it must appear in the finished print”. That
print launched his career and changed the
face of landscape photography forever.
Another master of the landscape image is
British photographer Michael Kenna. Kenna's
work gains impact through simplicity and
purity. He attempts “to evoke and suggest
through as few elements as possible, rather
than to describe with tremendous detail”
Kenna primarily shoots and prints in
the square format, which adds symmetry,
balance and tranquillity to his images, and
often his compositions are distilled down to
the simplest forms — a single tree in a snowy
landscape, or fishing nets out at sea captured
with a long exposure, for example.

“Step beyond the realism of colour, strip
your subject down to its bare bones and
previsualise how the final image will look™
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Repeat after me Quirky compositions

Use patterns and repetition to add impact to your images. Don't always strive to capture scenes in a familiar way.
This is easier to do in black and white because there’s Black and white is unrealistic by its very nature, so make
no colour to distract. Increasing contrast during post- the most of that by looking for unusual subjects, or
production is an effective way to boost shadow patterns shooting the ordinary in a way that makes it extraordinary

P
y

A

TIMING
This shot was carefully timed
so the cyclist didn't obscure

the graffiti on the wall. : PERSEVERE

It took several attempts to
get this shot right —a good
example of ‘if at first you don't

succeed, try, try again’!
MOTION BLUR
Shutter speed carefully l

chosen to blur the cyclist

by just the right amount. S ‘ . ?

- ENCADA

TWEAK IN POST

Contrast boosted during

post-production tomake {8 CONSIDER THE FRAME
the image punchier. The edges of the image
were darkened during post-
production to help frame the
revolutionary graffiti.




AMBIGUITY

The image works because it has
an abstract feel — it takes a while
towork out just what itis you're

looking at.

LOOK FOR

INTERESTING PATTERNS
The subject (an ornate lamp)

was photographed from directly
beneath looking up to emphasise
the pattern in the design.

VIGNETTE

The vignetting at the
image’s edges is natural,
created by the fall-off in
light from the lamp itself.

ISO SETTINGS
AhighISO (3200) was
necessary to take the
shot handheld in the low
light of the interior.
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COMPOSITION

Image cropped to a square
to emphasise the symmetry
of the subject and make the
composition more balanced.

Above
Celebrate
the ordinary
Though travelis
exciting and inspiring,
you can produce
fantasticimages on
your doorstep. The
great thing about
shooting locally is you
cango back tothe
same locations time
after time and make
the most of dramatic
light and weather
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Putting yourself into the right mindset to ‘see’
in black and white can be tricky, but it's an
obstacle that can easily be overcome. You
could set your DSLR to Monochrome mode
then shoot in both RAW and JPEG - the image
you see on your camera’s preview screen will
be black and white, so you'll have a good idea
of how the scene translates, but you'll also
have a colour RAW file on the memory card
which you can work on later. The other option
is to shoot as normal, in colour, then decide
later which images you want to convert. Some
will work, others won't, but there’s no reason
why you won't end up with some great images.
Ultimately, photographs of any subject can
have impact if you want them to, whether
it's a landscape, a close-up or a portrait. All
it takes is confidence and commitment. You
need to approach the subject purposefully,
be prepared to take creative risks, make
mistakes, push your skills to the limit and
see what happens. As Michael Kenna once
said, “Nothing is ever the same twice because

everything is always gone forever, and yet
each moment has infinite possibilities.”



Wide views

Wide-angle lenses add impact

to any image due to the way they
exaggerate perspective. Use lines

tolead the eye into the scene —
converging lines work best, and
shoot fromalow position to really
emphasise foreground interest

Keep it simple

Simple compositions have impact
because they deliver a more direct
message. Winter is agreat time to
shoot minimalistimages because
snow covers the landscape and
hides all but the boldest features

ENHANCED
Contrast has been
boosted during post-

S production to simplify the

tonal range of the image

and increase impact.

BETTER IN BLACK
AND WHITE

The black church stands
out boldly against the
snow-covered mountain.

WELL-BALANCED
The church has been roughly
positioned according

to the rule of thirds for
compositional balance.

MINIMALIST

Freshly fallen snow covers
most of the ground so
detail is lost and the
composition simplified.

l

LEADING LINES
Ridges of grass protruding
through the snow add
foreground interest and lead
the eye to the church.
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Original colour

Ilike to get my images close to
inished in-camera, so here |
adonthelens

he sky

Be bold

Producing black and white images with
impact requires confidence, especially when it
comes to image editing. Unfortunately, many
photographers are too subtle about the whole
process and end up with lacklustre results.
What you need to do is forget about realism.
Black and white isn't realistic, so your images
don't have to be. We're not suggesting that
you go over-the-top for the sake of it, but just
because a photograph started its life looking
rather flat and subdued, it doesn't mean it has
to stay that way. Throw caution to the wind.
Let your creative hair down. Be brave!

Conversion

Only basic editing was
required to maximise
the drama and impact
of the originalimage.
That sky is biblical!
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The final image may bear no resemblance to
the original, but if it says what you want it to
say, then that's absolutely fine!

There are numerous applications you can
use to convert colour images to mono at the
touch of a button. One of the best is Silver
Efex Pro 2, part of the excellent Google Nik
Collection (available as a free download from
google.com/nikcollection)

The High Contrast and High Structure
presets are ideal for producing punchy,
dramatic black and white images if you want
a quick fix, while the colour filter effects are
handy for boosting contrast and changing the
tonal relationship in the image.

Open the RAW file This shot was taken in

stormy conditions so the unedited file does
show potential for being a powerful black and
white image. However, to maximise the drama
of the scene it's going to need gutsy editing.

Convert to B&W Save the image as a
16-bit TIFF then open in Silver Efex Pro 2
(Filters>Nik>Silver Efex Pro 2). This is how
the basic black and white version of the image
looks. It's not bad, but lacks ‘wow' factor.

Almost there The second High Structure

preset produces a much better result —
plenty of texture and tone in the landscape,
and those clouds look amazing. Further tweaks
can be made using the sliders in the top right.

i
i
SRI6G) mh

Make basic adjustments In ACR, click

the Auto tab to see what effect this has
on the image. Contrast is given a slight boost,
but that's about it. Lens Corrections are then
applied and the image opened in Photoshop.

Work on the look Clicking on one of the
High Contrast presets, you can see the
effect is way too harsh, with the bright areas of
the sky blowing out. However, there are plenty

of other options available to try out.

Darken the sky A quick way to add more

drama to the sky is by using the Burn
Edges tool in the right-hand panel — select
the top edge, the adjust Strength, Size and
Transition to your taste.

Make selective tweaks Select the brighter

area of sky using the Polygonal Lasso Tool,
feathering set to 200 to give a soft transition.
Adjust Levels to darken the area of sky to
balance it with the rest of the image.

Final touches Make some final tweaks,
including lightening the small church using
the Dodge Tool so it stands out more against
the stormy landscape. The Exposure was set
to just 15% to avoid it looking too obvious.
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Long-term projects

You don't always have to travel far

to capture stunning wildlife shots.
Starting close to home can force you
to be imaginative and inventive, and
you'll learn much more about the
subjects and their environment

Allimages © Damian Kuzdak
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Ithough wildlife photography generally
conjures up images of exotic safaris
and majestic mammals, local subjects

can prove just as exciting to capture.

Shooting closer to home also enables you to

get to know the local creatures much more

intimately, not to mention the advantage of
cutting down costs in time and travel. This
doesn't necessarily make it the easy option
though and the genre still poses plenty of
challenges, particularly in learning to capture
your subjects without scaring them away in
the process.

The good news is that this feature is packed
with tips designed to help you make the most
of your backyard wildlife. Over the next few
pages, you will discover the ideal kit choices for
the job, including how to use a motion sensor

o A ;“’ﬁ

for shy subjects. As well as camera techniques,
the feature will also explore how to attract
subjects, and how to set up a feeding table to P
get closer with your DSLR. To increase your y
chances of seeing particularly elusive animals f
and maximise your shooting opportunities, f
there’s also some simple lighting suggestions {
to explore. L
If you've got a passion for wildlife but always
felt like the genre was just out of reach, then
read on. Your own garden is the best place to
start, but if you haven't got one, local parks,
reserves and even streets are also home to
countless species of fascinating mammals
and birds.
You might be surprised just how much o
wildlife is on your doorstep, and once you start £
looking, you'll be hooked.

i
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Pack the right kit

Wildlife photography is a challenge and opportunities are fleeting, so prepare with care

A DSLR is really essential for shooting fast-
moving targets and you'll benefit from a
model with a fast continuous burst rate and
autofocus system. It's an added bonus if
your body is fairly rugged, so you
can leave it outdoors without
worry of weather damage.

In terms of glass, a zoom
lens such as a 70-200mm
can be a versatile starting
option, depending on
the size and distance of
the subject in question.
Smaller creatures such
as birds will require much
greater reach, but as prime
telephotos can cost thousands,

a teleconverter such as a 1.4x can
be a versatile accessory to invest in,
increasing the effective focal length of your
existing lens without a substantial loss of light
or image quality.

Use a hide

A well-placed cover can make a big
difference in getting you closer to nature

Portable canvas hides are quick to
deploy, and will blend you into your
surrounding environment effectively,

Just because you're staying close to home,
that doesn't mean you shouldn't be prepared
with spare batteries and memory cards. You

won't want to disrupt or miss any wildlife
experiences, so select high-speed
memory cards that can keep
up with fast bursts of
continuous shooting.

You'll also need to give
some practical thought
to your clothing choices
before you head outside.
Wear materials that don't
rustle and opt for muted

colours so you blend in.
Jackets with a multitude of
pockets are helpful in providing
easy access to spare memory or

food, particularly when you might want
to avoid unzipping a noisy camera bag.

Once equipped, it's tempting to head
straight outside in the hope of stumbling

Weather-
proof kit

Don't just head inside when the
rain starts pouring, as inclement
conditions can really inject drama
and mood into your images. Invest
in a decent rain cover to protect
your camera body, choosing
one that retains full access
to change settings.

Top-right
Supplementary
food

Introduce or stop
providing food
gradually, and tailor
your choice for the
species at hand.
Peanut butter is a good
way to attract badgers,

however positioning and patience for example

is key to success. Choose a spot

where your intended subject visits Right
regularly, surveying your patch :)J;gzllltunities

beforehand to determine this. When
setting up, take into account the
direction of the light throughout

the day and avoid any distracting
backgrounds. Generally, the longer
you spend in the hide, the more
you're likely to see.

Be observant and you'll
find plenty of wildlife
on your doorstop,

even without a garden.
This wood mouse

was captured on
Wimbledon Common,
London, against road
lights behind

Above

Have patience

After you've erected the tent or hide, leave it in
position for as long as possible to allow wildlife
to become accustomed to its presence

Kit essentials
Take alook at our recommended list of equipment for success in the field

DSLR with quiet shutter Sturdy support Choose a
The Canon EOS 7D Mark II tripod with a ball or gimbal
has a silent shooting mode head that can handle the

to avoid startling subjects. Its load of your specific camera
65 focus points and a 10fps and lens combination. A
burst rate make it ideal for beanbag also provides
stability in awkward positions.

Zoom lens A versatile
telephoto such as Nikon's
80-400mm f4.5-5.6G will
suit a range of subjects. For
a premium price, a prime
lens such as a 300mm can
also offer wider apertures.

tracking fast-moving targets.

across a subject. In reality however, you'll still
need to plan, research and hone your fieldcraft
skills to have any chance of success. In your
own garden, attract the species you want to
photograph by providing a suitable food source.
Ascertain when they're most active and keep
an eye out for their presence.

Alternatively, it's worth getting in contact
with local wildlife groups to find out
what's been recently sighted in your local
neighbourhood. Spend as much time in the
field as possible to become familiar with
wildlife habits, and always get the permission
of landowners beforehand if you suspect a
location is private.



Utilise your
own garden

Attract wildlife into your
outside space with these
simple suggestions

Providing regular food is one of the
most obvious incentives to encourage
garden visitors. You can easily attract
birds by providing feeders and tables,
but water is also used by many
animals for drinking and bathing.

The best approach is to keep your
garden as natural and varied as
possible, which means staying away
from pesticides and chemicals, and
providing a variety of habitats such
as log piles, fallen leaves, old walls
and sheds.
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Develop your feeder
Once a feeding station has regular visitors,
try introducing perches or branches for

Consider the camera techniques needed for effective results amore natural resut

Once you've gathered your gear and sussed you can also intentionally underexpose to line between producing natural and staged
out the best places to photograph the native generate creative silhouettes. shots. If you're using bird feeders, for example,
fauna, the next step is to get practical and start If you know where your subject will appear, determine where the birds are flying in from,
shooting. Of course, specific camera settings such as with bird feeders, you can pre-focus and aim to capture them on these intermediate
vary widely between subject and time of day, manually on the target spot. Continuous/ perches, rather than the feeder itself. In a
but the same basic principles apply. Al Servo mode will track moving subjects similar way, you'll notice larger mammals often
Semi-automatic shooting modes enable you  through the frame. If you have time to do so, use the same pathways to and from a location.
to adapt quickly while retaining some control. practice selecting a single Active AF point, and As well as mastering the technical aspects
Choose Shutter Priority for subjects on the recompose so that this point is positioned of a shoot, fieldcraft is equally important. The
move, or Aperture Priority for those that are across the subjects’ eye, ensuring it is the more time you can spend outside observing
grazing or immobile. Exposure compensation is  sharpest point in the frame. the wildlife, the more you'll understand its
useful in overcoming tricky lighting situations, Feeding wildlife is one way to predict its patterns, and the greater your chance of being
such as backlit birds against a bright sky, but appearance, but remember there's a fine rewarded with the perfect shot.

Set upa feeding table Attractbirds, position your DSLR close and fire the shutter remotely

— I
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Prepare the setup Position the table and Alter camera settings Manually focus Use Aperture Priority Start with your
lay out food to suit the particular species on the feeder and set the shooting mode lens’ widest aperture and an ISO of
you want to attract. Mount the camera on a to continuous. Attach the cable release, and  around 400, depending on the light. When a
tripod facing the setup. lead it to a window or hide. subject appears in the frame, fire the shutter.
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Work with an
infrared detector

Take high-quality camera-trap
images with the Camtraptions
PIR Motion Sensor

What
is good
fieldcraft?

Keen wildlife watchers often use
this term. It means knowing what to
do, where to go and how to behave to

; ) maximise your chances of enjoying
Adjust the trigger Set the light a particular species or experience.
sensitivity inside the unit depending It also covers elements such

as timing and weather

on the species’ behaviours. D/N means o
conditions.

it will fire during both day and night.

Position the sensor Use an area

with signs of regular movement
such as tracks and trails. Mount the unit
facing where wildlife should appear.

gl
il

Set the perspective Tripod-mount

a DSLR and connect it to the sensor.
Compose the shot, paying attention to
the height of the camera and viewpoint.

Top

Think seasonally
Photographing nearby
enables you to follow the
cycles of animals overtime.
Create a seriesto tella
story about a particular
habitat or subject

%Y e, Above
= o ‘ 1 4 Animal behaviour
r 22 c “&¥  Capturing activity will
Choose camera settings Set Use off-camera flash Set the flash Check the setup Turn on the make your images more
Aperture Priority mode with an to TTL mode and connect it to your sensor and wait 30 seconds for it engaging. Try to anticipate
aperture of f8. Use an ISO of around DSLR. Direct it towards your subject, to initialise. Test the device by moving ;nrfgr:f;?fr:::fmmhe
640 or 800. Manually focus the frame. apart from the camera to avoid red eye.  in front of it. shutter speed to suit
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Use flash

Master off-camera setups and keep photographing
wildlife when the Sun has gone down

Some of the most characteristic animals
wake up just after twilight, and though this
is a magical time to photograph, the lack
of light poses a difficulty. Artificial lighting
isn't intrinsic to the genre, but some added
illumination is necessary to record the
activities of nocturnal mammals such as
badgers or foxes.

At dusk, one solution is to crank up the ISO,
but as the light levels fall further the use of
flash ultimately becomes unavoidable. A setup
of two wireless speedlights positioned off-
camera can be an effective solution, with one
used to light the background and the other the
subject itself. Once you've mastered the initial
exposure, you'll then be able to manipulate
the balance of light to add dimension. Always
avoid using the on-camera flash where you

60 Photography Tips, Tricks & Fixes

can, as it causes harsh results and can result
in red eye.

Position two units a few metres apart at
around a 45-degree angle to your point of
focus. By setting the second flash or fill light
to a wider beam, it'll cover a wider area and
generate a more even spread of light across
the background.

Any lighting system takes time to perfect,
but approach it methodically. Tweak both the
camera settings and flash power and spread
against the ambient light conditions, as well
as the position of flash units themselves.

Below

Simple solutions

Consider how external light sources such as those
from inside your house, streetlights and security
lights also affect the outcome of your images




Freeze

Take your position Be sure
to set up early; use either an
established or portable hide, or a
long cable release leading into the
house. Focus manually while it's

still light.

mammals with flash Larger nocturnal animals can

Prep the lighting Attach

one flash on the camera as
a key light. Mount the second
unit on a tree or stand to the
side of the camera to illuminate
the shadows.
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Set the camera Initiate the

silent shutter. Use manual
exposure mode, an aperture of
f11, shutter of around 1/200sec
and ISO 400. Check the system
is synced together correctly.

Tipsl Tricks|Fixes >

Backyard encounters

Using a speedlight not only opens up

a wealth of creative options, but also
enables you to shoot nocturnal animals

be photographed with two speedlights

Tweak to experiment Set

both units on 1/8 power. Take
test shots and check the balance
of light between the flashguns.
Tweak the outputs if necessary,
then wait for your subject.

e

-
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Fast-paced and
RE AT \/E SP OR T adrenaline-fueled,

( : sports photography
IS an exciting genre.
Learn how to create
unique shots with
our detailed guide

Stroboscopic
composition

By correctly timing your
subject movement, flash
frequency and count, an
eye-catching, balanced

composition can be achieved
© llko Allexandroff
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ports photographers often say that
Sthe genre is infuriating, stressful,

exhausting and addictively good fun all
at the same time. Its ultra-fast-paced nature
means a great deal of camera skill is required
to capture a perfect moment of order in an
otherwise chaotic environment. The main
challenges relate to correct exposure, short-
enough shutter speeds to freeze movement,
composition and accurate focusing of erratic
subjects. It's vital to know your camera inside

and out, so that you are able to recognise
where it will excel and where it will struggle to
deliver the results you require. Even the most
advanced cameras can find it challenging

to lock on focus and hold it, while tracking a
subject at high speed. Add into the mix the
need to produce clean, noise-free images

at the very high ISO sensitivities that are
indigenous to the genre, and a sports shooter's
kit is truly pushed to its limits. Yet on top of
these challenges, a photographer working

Tips| Tricks|Fixes

in this area needs to be as creative as those
shooting any other subject matter. Simply
freezing a football player in mid-air by setting
the highest viable shutter speed is unlikely

to be enough to draw in a viewer and inspire
their imagination, just as a well-exposed shot
of an empty landscape will fail to attract
attention. In this guide we'll walk through all of
the best techniques for capturing creative and
innovative action images, following advice from
some of the industry's leading photographers.
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Create compelling

perspectives

Producing dynamic sports compositions
IS deceptively challenging, but with these
pro tips you'll discover limitless possibilities

In the heat of the action, as you're trying to
capture a correctly exposed, in-focus image,
it can be all too easy to forget about the usual
rules of photographic composition, to say
nothing about actively seeking creative and
unique perspectives. It is a perfect example
of when a photographer’s artistic skill is of
greater importance than the technology in
their cameras — advanced AF systems can aid
anyone in producing a technically correct shot,
but the photographer’s vision dictates the
engagement of the viewer.

A common mistake is to forget about or
ignore the environment in the composition,
taking the subject out of the context of
the scene. Extreme close-ups of an athlete
can be interesting, but portraying them in
action tells a more engaging story. Surfing
photographer Karl Lundholm (kallelundholm.
com) always aims to make the most of his
dramatic workplace in his compositions.

“I don't think | see surfing as a sport when

I'm shooting, rather a complement to the
beautiful environment that [the surfers] are
in," he explains. “When | am out in the water,
it is hard to get the composition 100 per cent
correct because of all the factors the ocean
brings. Every wave and surfer is unique and in
constant moving water you never know what's
going to happen. | am always trying to get a
depth in my photos by staying close to the
surface, so | get an out-of-focus foreground,
then the surfer and the wave in focus and last
the sky or land in the background. | think this
draws the viewer into the photo and makes it
more powerful.”

Choice of orientation is also an important
consideration, as the frame shape defines how
viewers see the subject. Lundholm prefers to
shoot in portrait orientation — “I like to get a
lot of the ocean and sky in my photos. This
format is also really effective when shooting
sunsets or sunrises because you get a nice
gradient in the sky.”

3x © Karl Lundholm
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Opposite Above

Play with perspective Exposure and colour

Shoot fromunusual angles, suchas As withany genre of photography, .

these surfers shot from below, to colour themes and gradients are VERTICAL FRAMING - g CREATE LAYERS
immerse the viewer into the scene vitalin sports and action shots Shoot tall to focus attention ; A layered composition, with

on the subject clear fore-, middle- and
background produces depth

Gear for action

You don't always need professional kit to capture
dramatic action shots, but some kit is on most
action photographers’ wish lists

LOW ANGLE

Keep the camera close to the
ground (or water) todraw the £
viewer into the picture §

©
Q
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CREATIVE DEPTH OF FIELD
Use a wider aperture to diffuse any
foreground distractions

Sports shooter’s toolkit

Sports expert Keri Beal (keribeal.com) shoots using a Nikon D7200 and covers a
focal range from 17mm wide-angle to 500mm super-telephoto in four wide-apeture
lenses —17-55mm 2.8, 24-70mm f2.8, 70-200mm f2.8 and 170-500mm f5-6.3.
Having all of these focal lengths available is essential for rapid capture of near and
far subjects
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Perfect your panning technique

Thisis a very popular shutter speed technique for creative, eye-catching sport

and action images, but practice is needed to get the correct look and feel

Switch to TV mode Set your camera to
Shutter Priority mode to control shutter
speed. The camera will control f-stop.
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Change your ISO Set your camera
sensitivity to around ISO 100 to 400, in
order to allow for lengthened exposures.

Set the speed Lower the shutter speed
to between 1/60sec and 1/15sec to judge
the amount of blur you want to introduce.

Take a test shot Pivot around your
centre of gravity, tracking the subject as
they pass you, keeping them in the viewfinder.

- Creativity in motion
ShISShot by Keri Beal illustrates
‘anidealblend of artistic

bac undblur and pin-sharp
rience,
panning can transform

otherwise lifeless scenes
© Keri Beal

Switch to burst mode Use continuous
shooting to capture your subject in
multiple positions as they speed past you.

Adjust and reshoot Change the shutter

speed and ISO if you need more blur.
Reshoot until you capture the ideal picture.

- e = ==

INTENTIONAL BLUR
Any lack of sharpness should
be clearly intended

& BOSCH

Minimum
exposure
If you are worried about your
shutter speed dropping below
the value needed, try using your
camera'’s Auto ISO feature. Some
DSLRs enable you to set a minimum
shutter speed, which the camera
maintains by altering 1ISO
sensitivity.

© Keri Beal

Below bottom
Freeze the action
Aim to keep your
exposure above
1/1,000sec. Anincrease
insensitivity to ISO
6400 was needed here

Below top

Not fast enough
Althoughthe stadium
lights at this dog track
looked bright, the shutter
speed was still surprisingly
lowatISO1600
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SUBJECT
SHARPNESS

In all action images,
the main subject
should be blur-free

SUBJECT FOCUS

Blur minimises distractions

for added subject emphasis
ADDED ENERGY
Wheel effectively conveys
subject’s speed

Be inventive with exposure

Synonymous with short exposures, action images sometimes
benefit from longer shutter speeds for creative effects

Selecting the right shutter speed is essential Beyond essential exposure calculation, vehicle and the wheels, making it appear as if it
for action images to work. Whether you shutter speeds are a critical consideration is simply parked on the track. By lowering the
choose to freeze action or blur movement with  when attempting to portray motion creatively. exposure time to around 1/60sec and tracking
creative longer exposures, you need to commit  Professional sports shooters often use slower the subject with the lens as the image is taken,
to one or the other for the effects to appear exposures to convey speeds of subjects the important areas of the shot remain sharp,
intentional. Karl Lundholm’s area of work moving past a fixed point, such as the use of while the background is reduced to a creative
requires short exposures by default. blur of motion. When attempting

“I love to freeze that big incoming “Shutter Speeds are a Crltlcal this technique, practice is required

wave SO you can see every drop to gain the correct balance of

and texture of the water. To do this CO nS|de ratlon When attem ptl ng subject sharpness and creative

| will not go slower than 1/1,250 of . . " blur. By firing a burst of images in
a second,” he explains. However, tO portray mOt|On Creat|ve|y continuous shooting mode as you
shorter speeds also play a role in pan the camera, you can increase
his creative workflow: “I love when the sunhas  panning in athletics or motor sports. When your ‘hit’ rate, as you have more coverage

set and the surfers are coming to the beach. To  shooting cars or bikes, there is very little about  of the scene as it unfolds. Variances on this
get [natural-looking] silhouettes of surfers and  the subject that suggests it is moving when theme include zooming during an extended

a beautiful sky in the background, | do not keep  using a very fast shutter speed. An exposure exposure or moving ahead of the subject, to
my shutter speed that fast.” of 1/2,000sec will freeze movement of the produce different blurring effects.
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Work
with flash

Learn how to use
speedlights and strobes
for high-powered
lighting and dramatic
action effects

Flash plays a crucial role in the technique
repertoire of many professional action
photographers. Ambient lighting in sports
venues can be significantly lower than
anticipated, making it challenging to achieve
fast-enough shutter speeds to freeze
movement as desired. The short duration
of flash bursts, especially from speedlights,
means we can generate effective exposures
that are much shorter than would be possible
with conventional techniques. Often sports
photographers will utilise a high-speed sync
mode for their flash shots, allowing the use
of shutter speeds higher than the maximum
flash synchronisation speed their camera
offers. There is a trade-off in power,
with effective flash distance
dropping as the shutter speed is
increased, but there is a ‘sweet
spot’ where exposure time and
flash coverage is balanced.

At the other extreme, flash
can be combined with slower
shutter speeds for creative effect.
By extending the exposure to
around 1/15sec then introducing
a fill flash, the subject is frozen but
the surroundings are blurred, isolating
the key part of the image — the athlete.
Another creative flash technique is the use
of stroboscopic lighting; ambient light is all
but eliminated by using a black background
or stopping down the aperture, then a series
of high-frequency flashes illuminates the
moving subject at multiple positions in the
same frame, during an extended exposure.
This technique is useful for a range of action
photography areas, from track and field to
motorsports to dance, and is a artistic method
of illustrating the progression of high-speed
events, where multiple stages can't be
otherwise shown in a single shot. Whenever
flash is used, it is important that it is done
with the consent of the subject and where it
is permitted by the venue — intense flash light
can be distracting to athletes.
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creative colour
Another technique you may not
associate with sports shooting is
use of coloured gels. Set your white
balance to Tungsten and using a CTO
(Colour Temperature Orange) gel on
your flashes. Underexpose by about
one stop to produce a moody mix
of cool and warm tones — a
‘look’ popular with sports
magazines today.

-

CHOOSE NUMBER OF MOVEMENTS
The flash count determines how many ‘stages’ are
captured as your subject moves across the frame

STROBE LIGHT

| Canon580EXIlina
80x60 gridded softbox.
PocketWizard Il Plus

SETTINGS
Canon EOS 5D
Mk I

s 3 135mm/2

ARRANGE SEPARATION

Flash frequency (measured in Hertz)
determines how separated each stage
is in the composition

CAPTURE

PROGRESSIVE ACTION

Stroboscopic flash enables

us to see how action occurs

in stages — impossible to

capture in a stillimage by any

other method %

FILL LIGHT
Constant daylight
for the motion blur

MODEL
4 Megumi
Yuzuki

KEEP IT STEADY
Camerais on atripod
because of the slow
shutter speed




STROBE LIGHT

CONTROL THE

LIGHTING

Use ablack seamless
background or stop down
the aperture to cut ambient
light and underexpose the
environment

Left

Setting up

your shot
Stroboscopic flash
expertllko Allexandroff
(ilkoallexandroff.com)
shooting onlocation.
Hereheillustrates his
common setup fora
multi-flashimage

2x © llko Allexandroff

Nikon SB-26in a 90x20 gridded
softbox. PocketWizard Il Plus

Tipsl Tricks|Fixes N\

Shoot a stroboscopic sequence

Flash firing rate and output must both be considered for successful images.
Photographer Carlos Ramirez (cf-03.com) explains his workflow

Calculate movement duration Place the

athlete or model on your set, practise their
movement and then measure the duration of
the action.

SEKONTC>-.

I1ISO ¢} ’1'} il
o

E ]

Work out exposure Use a meter to set

the power of your speedlight or strobes,
based on the duration of the movement. Each
burst will be perfectly exposed based on that.

r/

Keep your shot steady Put the camera

on a sturdy tripod and connect a shutter
release to avoid any kind of movement and
improve sharpness.

4Arrange subject in image Switch to
manual. Set the exposure duration based
on the length of the movement you want to
capture and f/no based on the meter reading.
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Create your composition Decide on the

number of stages you want to appear in
your shot and set the appropriate number of
flashes (measured in Hertz) on your flash.

Shoot, review and repeat Start

shooting and practise the synchronisation
with the athlete. It takes both patience and
practice to achieve the desired final result.

Fencing

High flash counts and
frequencies combine
to create abstract

compositions
© Carlos Ramirez
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Composite your shots ”

You can utilise Photoshop and combine all your contrsstasimerts . (
desired elements into a single image

naturally in the final A
composite image
© David Lehl

Having the ability to merge several photo the subject in a studio, try using a rim light

components together in post opens up a to highlight their outline against a neutral

vast number of possibilities for dynamic grey background — this makes it easier for

composition and exposure. In a genre where Photoshop to ‘find’ the edges of objects

subjects are moving erratically and at high when forming a selection. In the Output

speed, it can be nearly impossible to capture panel of the Refine Edge dialogue, check the

a precise composition in a single frame. Decontaminate Colors box to remove any

Capturing a well-positioned, correctly lit, in- colour spilling from the rest of the image.

action portrait of an athlete is not realistically

achievable as they run around a track, but TR ¥

taking the shoot into a studio, where you

can pose the subject and sculpt the lighting,

makes it possible. A very common technique is

to shoot an appropriate background, edit this ; s

separately and overlay a posed, studio-shot, ) L .

in-action sports portrait in Photoshop. ) / €§ 'E*é?
The key requirement for compositing work . = T

is to ensure that lighting is uniform in each r & ¥ i

component and that the colour temperature O 2 ' \ ' - b

of the light on the subject matches the ' ; ;

background. It is possible to control the

colour of studio lighting by using gels, but in

the compositing workflow it is often easier

to change the white balance to match each

element, as this offers the greatest level of

control. Photoshop has several powerful tools

that are essential. The Quick Selection Tool Above - bottom

(W) is a go-to feature, due to its speed of Find a suitable background

operation and ‘smart’ characteristics — the Dave Lehl shot this Hong Kong street early one morning. Oftenit

tool remembers when selections are modified pays to shootimages with potential future composites in mind

and uses this informatiqn to gener‘ate more Pose the subject

accurate selections. Using the Refine Edge Shooting your main subjectin controlled lighting conditions

feature allows precise selection of detailed provides scope for perfecting exposure and composition

edges with a higher Smart Radius setting on Above - top right

the Radius slider corresponding to a more Foreground rain

complex and detailed selection. If shooting Oneway toaddrainis to create a black Fill Layer, go Filter>Noise>
Add Noise, apply aMotion Blur and change blend mode to Screen

- Pro photographer Dave Lehl (davelehl.com) explains how
PUt |t a" together he sgamle%sl)rl) blends each o1gthe Composit)e elepments

Above - top left

& Photoshop File Edit Image Layer Type Select Fiter View Window Help
%) S . .
- ¢ ; -
e : /
. N
Create mood | painted in a dark-grey sky, Photograph rider | shot my friend Andy Cut out the rider Going back to
altered local brightness and used Color in a Denver parking lot about a month Photoshop | cut out Andy using the
Lookups (Image>Adjustments>Color Lookup)  after the Hong Kong background, mimicking Polygonal Lasso Tool, as | personally prefer
to give the street signs some life. the low perspective and lighting direction. this over the Pen Tool.
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Remember

the shadows
David Lehl highlights the biggest
aspect that will give away the fact
you have created a composite — the
subject’s shadows on the ground.
“It's so easy to overlook, but it
can kill the entire shot,” he
explains
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Arrange the subject in the image Add mood to the subject | used Include fog and rain Some fog and

The extracted rider was then added to similar brightness adjustments and Color raindrops were added for extra depth. Tip:
the background and moved into the desired Lookups to make Andy believably match the use the Screen blend mode to remove a black
position in the image. mood of the background. background from a smoke/fog source image.
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Master macro

on a budget

Delve into this fascinating genre and get

acro photography is a genre of
M wonder, bringing to light the
intricate detail of our world
that often goes unseen by the naked
eye. There's great excitement to be had in
discovering flora and fauna up close, but this
added magnification can be pricey.

All image making benefits from a little
investment, and macro in particular is often
accomplished with highly specialised lenses
and accessories. Fortunately, though, there
are plenty of alternative kit options that will
enable you to tackle the genre on a budget.
One simple way to magnify subjects is by
using close-up filters; while a specialist lens
might set you back hundreds, a set of these
costs little more than £15/$20.

Over the next few pages you'll discover the
differences between specialist kit and budget

72 Photography Tips, Tricks & Fixes

great results without breaking the bank

options, provide tutorials on adapting your
existing lenses and address the challenges
you might face along the way. When you've
managed to master magnification, you

might find yourself facing another challenge;

how to ensure subjects are exposed
effectively. Of course, macro flash sets are
on offer at a premium price, but a standard
speedlight can also be used creatively to
great effect. And over the next few pages
you'll find out how to illuminate even the
tiniest of creatures. e

If you're interested in trying out this
fascinating genre of photography but don't
want to blow all your dough in the process,
read on. As you'll learn, there are many
inventive ways that you can create great
macro shots using little more than the gear
you've already got.

Above

A whole new world
Macro photography may be a
fiddly business but thankfully
there are plenty of affordable
alternatives to expensive kit
© Siddant Sahu
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Make the right kit choices

Explore the benefits of both pro and inexpensive shooting options

The most desirable macro lenses on the
market have fairly long focal lengths, offering
greater working distances as well as close
focusing capabilities. This means that you're
less likely to disturb any flighty creatures
you're trying to photograph, and also
makes it less likely for shadows
to be cast over your subject. In
short, such macro lenses are
an expensive outlay, so you
have to be sure that you
truly need their benefits.
Having bundles of
specialist kit doesn't
guarantee better images
though, and there are plenty
of budget ways to get closer to
your subjects if you don't have a
macro lens. For example, close-up
filters screw on to the front of your lens and

enable you to focus closer than usual. Like all
the options we'll explore in this feature, they're

an economical option if you want to test the
waters before spending more money on a

dedicated macro lens. However, these cheaper
alternatives can be fiddly to use, negate your
camera'’s automatic functions and in some
cases, have a negative effect on image quality.
Of course, however much your kit costs
you, the principles of camera
settings remain similar. Focusing
up-close is one of the genre's
biggest hurdles, and manual
focus is often the easiest
approach. To obtain the
largest possible image of
the subject in the frame,
set the lens to its minimum
focusing distance, and
move the camera until the
subject appears sharp. When
using a tripod, you may find it

easier instead to adjust the focus ring.

For moving subjects, once you've achieved
focus manually, activate the autofocus system
to maintain it. A

Depth of field becomes very limited at such

.close focusing distances and you will find

that you will almost always need to use the
narrowest possible aperture. If your subject
is in motion, you'll need to boost the ISO,
increase the ambient light or use flash so that
you can retain a fast enough shutter speed,
generally 1/250sec or faster, to freeze motion.
[t's more than possible to achieve stunning
1:1 magnifications using both specialised
macro lenses and their more affordable
counterparts, so long as you're aware of the
challenges and how to overcome them.

Below Opposite-top

Professional equipment
Turkish photographer Arslan
Ucar used the (500px.com/
arslanucar) Canon MP-E 65mm
2.8 lens to obtain this shot of a
jumping spider

Opposite-inset

Strive for sharpness

It's often best to focus manually
with macro subjects, so turnon
Live View and zoom in to check
that your intended focal point

is pin-sharp

Capture character
Macro photography lets
you see the smallest of
creaturesinaway that
you've never seenthem
before

Opposite-bottom
Budget solution
Reverse lens techniques
can provide a similar level
of magnification and image
quality as a true macro lens
at afraction of the cost




x
S
€
>
=
i}
=
T
o
2
3
[=]
©

© Siddant Sahu

2x © Siddhant Sahu

© Arslan Ugar
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Reverse your lens

This quirky method is an obvious option

for affordable macro images

You might be sceptical about using your lens
backwards, but in fact reversing rings provide
one of the cheapest ways to adapt an existing
lens for macro magnifications. Starting at
around £5/%$7 each, they take the form of a
small metal ring, with a standard filter thread
on one side and a lens mount thread on the
other. When screwed on, the lens can then be
mounted onto your camera in reverse, causing
subjects to become impressively enlarged

on the sensor at shorter focal lengths. As a
rule, wider angle lenses will provide greater
magnification. For example, near life-size
reproductions can be achieved with a kit lens
such as an 18-55mm, or the popular 50mm,
on a cropped-frame sensor.

One of the main downsides of using a lens in
reverse is the loss of the camera’s automatic
functions, a problem that photographer
Siddhant Sahu knows well. “First, forget
about trusty autofocus. Since there aren’t any
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electronics connecting the lens to the body,
autofocus and aperture control won't work. If
you own an old lens with an aperture ring you
can control it manually, but as modern lenses
don't have an aperture ring you have to set the
aperture before reversing,” he explains.

Another downfall is that there's an incredibly
narrow range of focus, even by macro
standards. However, if the subject is relatively
stationary you can overcome this by focus
stacking. Take a multitude of shots at very
slightly different focal distances, then combine
them together at the editing stage using
Photoshop layers.

In absence of the autofocus system, you'll
need to physically move the entire camera
back and forth, often mere millimetres, until
your subject is acceptably sharp. As with all
macro, even small movements can make a
great difference to your outcome, so hold your
breath to steady yourself before and while

taking the shot. Vignetting can also become
noticeable if you use a high f-stop with certain
lenses, but can be overcome by adding in
extension tubes or widening the aperture.

Although the reverse lens technique comes
with a few difficulties, most are conquerable
with patience. Few of the disadvantages
impact image quality, so they make one of the
best budget solutions for getting started.

Opposite

Enlarged potential

When reversing wide-angle lenses, subjects can be
captured larger than life-size on the sensor. Sahu
already owned an 18-55mm kit lens, and a 52mm
reverse ring costs less than £30/$40

Below

Double the effect

Dedicated macro lenses can also be reversed

to provide even greater magnification. Gustavo
Restrepo (500px.com/grestrepol3) used a Sony
100mm f2.8 and reverse ring for this shot
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Use extension tubes

Gain magnification using your existing lens
and overcome a few drawbacks

Extension tubes are light, tight cylinders that
attach between your camera body and virtually
any lens. Because they move the front element
of your lens closer to the subject and therefore
further away from the focal plane, they
enable closer focusing and an even
greater magnification.

These hollow tubes
are inexpensive when
compared to a macro
lens and they don't
introduce any additional
glass elements, so
there's generally no
significant loss in image
quality. The main price
difference between
extension tubes comes
from the fact that some
maintain the connection
between the camera and lens,
whereas the cheaper versions don't.
For tubes without electrical contacts
you'll still be able to meter effectively, but
autofocus will be disabled and you won't be
able to change the aperture unless your lens
has manual rings. As depth of field is already
limited with macro, being forced to shoot
wide open is a definite downside.

Another obstacle to overcome is a
certain degree of light loss, so ensure you
compensate for this when setting the
exposure. In terms of focus, it's best to do
so manually, checking Live View and gently
turning the focusing rings until your desired
area is acceptably sharp.

Although it's possible to handhold the camera
and still retain a sharp result, always use a
tripod where possible. Aim for a minimum
shutter speed of 1/250sec to minimise
camera shake, and if you need to boost the
exposure, increase the ISO instead
of widening the aperture.
How close you can get
depends on the lens used
and the width of the
tube, and a rough way
to calculate the added
magnification is to
divide the length of
the extension tube by
the focal length. As an
example, this means that
a 25mm tube and 50mm
lens would yield a 0.5x gain
in magnification.
Shorter lenses such as a 50mm
can actually cause you to get too close to
your subject so that shadows are cast across
it, but also bear in mind that a telephoto lens
only provides minimal gain. A medium zoom
such as an 85mm is ideal for striking a balance
between magnification factor and breathing
room, and keep in mind that you can combine
several tubes at once for greater effect.

Opposite-top Opposite-bottom
Shift the lens focus Vary the effect
Extension tubesincrease the You can combine several
distance from the back of the extension tubes and

experiment with varying focal
lengths to suit the size of your
subject at hand

lens to the camera sensor,
which enables closer focusing
and greater magnification

Opposite-inset

Simple to use

Because there are no optics
involved, generic sets of tubes
start ataround £35 (approx $45).
Image quality should match that of
the branded alternatives

Mount and magnlfy Increase the focusing capabilities of your existing lens with extension tubes

Choose your setup Position your

subject, attach the selected tubes onto
the lens, then mount the setup to the camera
body. You should always use a sturdy tripod
where possible.

Expose the shot If using tubes with

electrical contacts, select Aperture Priority
mode and start with a narrow aperture of f8.
Boost the ISO if needed, and experiment with
different combinations of tubes.
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Focus and capture Focus manually,
physically moving the camera or subject

closer if necessary. Use the histogram to check
the exposure, and add in artificial light if you're
casting a shadow on the subject.
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Learn to light effectively

There are plenty of different solutions for

brightening your close captures

Many lighting approaches exist for macro
photography, and while natural light is a simple and
affordable option, alone it can't always be relied
upon. Even in the brightest conditions such as broad
daylight, the intimate working distances needed in
the genre often cause shadows to be cast on your
subjects. When you also factor in the use of narrow
apertures to retain detail at such close proximity,
boosting the exposure with artificial sources of light
often becomes necessary.

Fortunately, even lighting setups can be found
to suit a modest budget, and the most common
specialist macro options are ring lights and flashes.
Circular ring flashes attach to the front of your lens,
enabling the light to remain close to the subject.
Starting at around £30/$40, they're generally cheaper
than off-camera flash options, but they're also less
powerful. Bear in mind that higher-end twin flash units
can cost into the thousands, making them unfeasible
unless you're really serious about the genre.

While these dedicated macro options offer
professional results, a standard speedlight can also
be used to stunning effect. Handhold the speedlight,

© Arslan Ugar

or use a bracket to attach it directly to your camera'’s
tripod mount, ensuring that the light isn’t going to

be obstructed by your lens and that the boost in
exposure doesn't look unnatural. When using his
speedlight, Siddhant Sahu uses a power of around
17128, “just to add a little more light, freeze the motion
and to prevent images from looking too ‘flashy’”

Most specialist macro flashes offer two separate
lights, which can be individually powered and
positioned to add depth to subjects. In the same way,
you'll improve your shots even further by introducing
a second flash unit, positioning the two either side
of your subject.

Sufficient lighting is critical to macro photography,
but that doesn’'t mean you have to splurge on fancy
setups for success. Whatever your light source,
experiment with its direction and power to ensure you
use it in a way that flatters your subject.

If there isn't enough available light to work with and
you don't have artificial options, don't be disheartened.
Purposely using a shallow depth of field such as 5.6
or wider can create a dramatic composition and hone
in attention to specific elements in the scene.

Above
Utilise daylight

It's generally best to avoid using
on-camera flash as it casts aharsh
light and has limited reach

Inset

Diffuse the light

Sahuuses a Yongnuo YN560-II
Speediite (£48/$64), wireless trigger
set (£23/$33) and homemade
diffuser in his setup

Sunlight canyield dreamy results.

4x © Siddhant Sahu

Opposite-top

Position the light

Using your flash off-camera will
enhance image quality. Angle the light
until it creates the dimensional

effect you're looking for

Opposite-bottom

Cast no shadow

Lighting can be tricky in macro
photography because you are
generally working very close to your
subject and so casting a shadow

Left

Dedicated flash results
Ucar uses a Canon Macro Twin Lite
MT-24EX (£950/$830) in his work.
Specialist units offer great flexibility,
butcome atacost
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Learn how to
shape the light

Master modifiers and take your studio lighting work
to the next level with our expert guide

to grips with how to create and control it in

a studio environment is rarely easy. There are
so many different lighting products on the market
that it can be difficult to know what you need to have
access to, when you should be using it and how to
use it to best effect. Pro photographers with plenty of
experience appreciate when soft light will flatter and
when hard light will define. They understand how the
nuances of where the light falls and where it does not
can make or break a photograph and they can employ

I ight is at the heart of photography, but getting

the correct techniques to diminish or create a shadow.

Trial and error is invariably an integral part of the
learning curve, but this detailed guide to the lighting
skills you need to capture portrait and product images
with that professional touch will certainly help you
on your way. From shadow control to incorporating
multiple lighting elements in one image, the next
few pages will attempt to demystify some of the
complexities of studio lighting and have you creating
your own masterpieces. You'll discover how specific
modifiers can be used to manipulate the light so that
it does precisely what you want it to, and you'll find out
why professionals choose one bit of kit over another.

Allimages © Double Exposure Photographic

Right

Magic with modifiers
Creating impressive images in
the studio is largely down to
your ability to shape the light
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Work with soft light

Discover how modifiers can banish harsh shadows

All light sources can show themselves in
different forms, whether it's sunlight or studio
flash units; direct sunlight is very hard but
softens with cloud cover and in the studio a
bare reflector is hard like the Sun, but you can
put things over it to soften or diffuse it.

Soft light is achieved when the light output
from a flash (or a continuous light source) is
interrupted in a way that breaks its direct line
of sight to the subject. This is often literally
achieved with fabric in the form of a softbox —
an enclosed lighting modifier that helps break
up and evenly diffuse the light before it hits
the subject. Increasing the size of the diffuser
will inevitably help to spread the light further
from its original point source, thus increasing
the ‘wrap’ of light around the subject. In
portraiture this means the light can fall around
the face, filling in areas that might typically be
in shadow. Other ways you may wish to soften
a light include a diffuser panel or a sheet of
Perspex — these do the same job as a softbox
in terms of how they affect the light waves, but
will enable greater control over direction of
light and reflections, as the light can be moved
independently to the diffuser.

Another fantastic modifier to consider is
the beauty dish. As the name suggests, these
are mainly used for portraiture and they do
deliver a lovely spread of light across the face.
Although generally considered a modifier that
delivers soft light, the beauty dish (especially
without a fabric diffuser) does provide an
appealing balance between soft and hard
light. The centre cap located in the middle of
it covers the bulb and stops direct light from
the flash tube hitting the subject, sending it
instead back into the modifier to diffuse out

evenly in a circle. Another benefit of this is the
circular and soft catch-light reflection it puts
into the eye.

Soft ‘fill' can be achieved by bouncing light
off nearby walls or ceilings, or just by holding in
white card or fabric surfaces. Soft light is also
your best option if you need to evenly increase
the overall exposure of an image.

-
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Top Above
Indian spoons Lipstick

A reflector softened up
using a piece of Perspex
helped to control the
reflections on the spoons

These were shot with a
strong backlight and two
strip softboxes double-
diffused with Perspex

Attach
a softbox

Place the softbox face down
on the floor, carefully line up
your mounting points, then slide
the light in and twist. Once the
head is back up on the stand,
swivel so that the softbox is
over one of the legs and is
properly supported.

Understand
softbox shapes
These come in many shapes

and sizes — here’s a quick look at
a few of the most useful ones

[—

Rectangular
softbox This is

a fairly common
medium-sized
softbox, a reliable
modifier for lots
of applications
where you need
an even spread of
soft light.

Strip softbox
Perfect for when
you're shooting
long, thin objects
and standing

portraits as it
channels the
light (normally)
vertically, rather
than spread like a
wider softbox.

Softbox or beauty dish?

Choosing a modifier for your main soft light

Simple softbox
portrait Shot
using a medium-
sized 60-80cm

Simple beauty
dish portrait
This image

was shot using Octobox softbox

softbox; the a 21-inch white This is a small
highlights are beauty dish. The example of an
soft and the skin definition octobox. The
light wraps is lovely and more rounded
nicely. On this you can see that shape can look
example, the the catch lights more natural
softbox material in the eye are than a square
added a small indeed more or rectangle.
amount of tint attractive. It'sa

to the light. very clean light.
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Photogr

Soft beauty
portrait on pink
The main light used for this
image was a beauty dish. The
model was flanked by two strip
softboxes to add fill and separate
her from the background. Some
white card was also added to
bounce a little light back into the
hadows under her chin.
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The Dance

This image was made using a
variety of hard light modifiers.
The main light is a Fresnel
spotlight; the highlights down the
left of the body are intense and
not wrapping like soft light does,
and its’s also casting shadow.
There is also a square-gridded
reflector up high lighting the
fabric, and a small round-gridded
reflector on lower power adding
a bit of fill-in on the body.
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Adding grids

to softboxes
Create different effects

Strip softbox
with fabric grid
This works the
same as any
type of grid and
makes the light
waves travel
straighter. It
will also cut
out a little bit
of exposure,
but you can
compensate

by turning your
light up.

Without grid
The grid has
been removed,
meaning the
light will spread
more. The fabric
grid can be
easily attached
using Velcro.

Using a

very minimal
light hitting

Honeycombs and snoots

Take alook at the different light-shaping qualities of a
reflector with a honeycomb grid and a snoot

honeycomb grid snoot only
only The highlight The most

on the curve of the intense

vase shows you highlights tell
where the light is you that the
most intense, and light hasn't
the rest of the moved, but
light is how much you can see
(or how little) the that the
honeycomb is spread

allowing the light to of light
spill. The shadow
is hard and there's

the background.
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Use focused and hard light

Learn how to create an edgier result for added drama

Focusing the light produces the opposite effect It is possible to create very focused light

of soft light — it's often purposely directional; using a unit called a Focus Spot - larger flash
‘channelled’ toward the subject creating very units can then produce a very concentrated
dark contrasting shadows. light on the subject or background. You use

There are various ways to focus light into an them by adjusting controls on the side of the
area, and perhaps the most widely used is the unit to soften or sharpen the flash, and to
Fresnel light modifier — this is a glass lens that ~ either increase or decrease the size of light
sits in front of the light and can be adjusted to emitted. When used in conjunction with a set
deliver either a flood or a spot of light. of Gobos, the photographer can create special
It's been used in the main image to lighting effects, which if used subtly are
create a focused hard light, which still relevant and interesting!
can even give the visual effect When you want an obvious
of working in sunlight. direction in your lighting or

Another popular method want to make a feature of
with a more basic kit the shadows, focused hard
is a reflector with a light is the type of lighting
honeycomb grid placed in you should be considering.
front of it. These come in It is usually more sculptural,
many different densities, very good if converted to
with medium through to black and white and especially
small holes — the smaller the useful for highlighting relief,
holes, the straighter the light texture and material surface.
waves penetrating through. You can Sometimes focused light and hard-
get grids for softboxes and beauty dishes gridded light is not particularly flattering
too, so although they are still regarded as soft for portraiture or reflective objects wh
light modifiers, the grids can just tighten up directly, rally it is better when
the spread of light they omit and stop it from  conjunctic
hitting areas it isn't intended for.

Snoots are er key
cone-sha;

Modelling
Lights
These are rather underrated.
They provide sufficent light to
enable you to focus effectively
while you work and for some
applications they can even be
used as a continuous light
source for your
final images.

Using a

is slightly
reduced and
a sharper
effect is

the result.
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Consider shadows

Don't overlook their importance

The art of flagging and shaping light after it has left the bulb is

a great skill to have. Often a modifier on its own isn't enough,

and more physical items are required to adjust the light further.
Controlling your light with things such as barn doors, grids and
flags can really add depth and interest to your photography. Detail
counts for a lot in photography, so if you can add little pockets

of light here and there, rather than always using a big spread of
light, then the viewer is likely to be captivated without necessarily
knowing why.

There are lots of different types of flags and accessories for
controlling light — there are many off-the-shelf products that work
very well, but it's often the case that you may end up making things
over time. It's not unusual to use a combination of objects and
accessories when trying to ‘build’ the lighting around a subject, and
this is because there are so many different ways to achieve the
look you're after.

Generally solid, flat, dark surfaces make good flags — objects that
can literally stop light from hitting a certain area. These work best
when used to keep light from reaching a background, or by being
placed near items that need to reflect something dark rather then
be lit whole by the flash light, for example glassware. When a less-
structural object is desired, ‘on-light’ barn doors are very useful to
close down the aperture of the light bulb and reflector — this helps
the photographer to direct light in a slit or smaller area. Gobos
used in focus spot lamps also allow very precise directional light
that can be extremely effective — they can often produce detailed
hard light and are very controllable.

Sometimes it's necessary to lift the light levels in areas that are
in shadow, and this might be required if the image has too much
contrast. A solution is white card; it is versatile and produces clean
coloured light that bounces back in the direction of the main light.
It will very subtly lift the light levels near where you place it, and
you can expect to see more detail as a result. If even more detail is
needed, usually some soft light from a softbox will work well.

Lifting detail Alookat your options for controlling shadows precisely

A very directional gridded reflector is In this version, simply bouncing some For this shot, a small amount of soft
being used to cast hard shadow — there light back into the object using an light has been added. The original
is very little detail in the shadows onthe  everyday piece of white card bringsouta  light was still very much the key light,
right-hand side of the object. good amount of detail. overpowering the fill-in for the shadow.
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Mix it up
Bring everything together
for more impactful images

To master lighting you need to understand that
various materials respond to light differently —
for example wood can be very forgiving under
hard light, whereas a metal surface is likely to
kick up unattractive reflections. Usually the
greatest differences are seen between matte
and reflective surfaces.

Experimenting either in or out of the studio
will help with this understanding, given time,
and most of the modifiers discussed in this
feature can be hugely versatile — softboxes can
deliver a really punchy light if placed very close
to your subject on high power, and the light
from a reflector at a distance will eventually
soften. Often the best lit images are achieved
with a combination of lighting modifiers and
techniques chosen for specific reasons.

The most important thing is to have a good
idea or concept in your head before you begin
to build your lighting setup, and the clearer this
is the better. Good images don't just appear
out of thin air, and a bit of thought normally
yields great lighting.

The best way to start is to keep it simple
and build your shot up one light at a time -
look at the image with one light, then another,
then another and try to be critical each time

— constructively! If something isn't working,
then just change it. There are lots of amazing
lighting kits out there, but you can get great
results with simple flash guns and even just
the Sun and a bounce reflector! Basic things
like black-and-white card can be hugely useful
for channelling light and adding darker areas
to images.

With portraits, the beauty dish as the main Above Below

light modifier is often the best choice. These Dessert o , EB watch
. This was created with a diffused but strong light from the left This advertising image was a combination of lights behind
can be supplemented by strip softboxes, as

rear, behind Perspex. A softbox filled in from the right and the Perspex and a harder focused gridded honeycomb, enhancing
these complement a human's shape more rear slit of light is from the focus spot the detail on the rear of the case
effectively than a rectangle. Strips are also
really good when gridded, as this focuses the
light and can be extremely attractive as a rim
or kicker light from behind. Harder and more
focused light can then be added in to pick out
certain areas, for instance to enhance hair and
furniture shadows. Snoots can be used to put
spots and gradients on walls.

As mentioned earlier, with products you
can usually ditch the softbox and use Perspex
or diffuser paper — the main advantage with
this is being able to move the light source
independently and change the modifier behind
the panel. Use smaller flags and reflectors with
most still-life setups, to increase contrast and
lift shadows at the same time. Also try to add
top light, which always helps produce object
shadows and ground items.

90 Photography Tips, Tricks & Fixes



Tips| Tricks | Fixes

Black wall portrait This image setup for this image with the beauty

uses a variety of hard and soft dish and clip-on barn doors, the
light, with lots of components to overhead snoot, the hard light from
help control the light further. In the left with grid and the gridded
doing so, you can draw attention to strip softbox on the right.
the parts of the image that you feel
are most important. Adding fill This is the large
silver reflector with flash head
Mixed light setup This mounted behind the camera, filling
photograph shows the main in for the main exposure.
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Create a

woodland sunburst

Head for the woods on a misty day and shoot into
the Sun for truly atmospheric results

This is one of those images that
photographers dream of creating. We
see similar shots in books, calendars or
magazines and wish that we could be lucky
enough to encounter such amazing conditions.
Well the good news is, you can, because they're
not nearly as rare as you'd imagine. All you
need is a damp day followed by a clear, cool
night so moisture rises through the trees and is

Set up your equipment Once you reach

your location, find a suitable spot to shoot
from. Next, mount your camera on a tripod,
attach a wide-angle zoom and fit a lens hood
to reduce the risk of flare.

Get the exposure right This shot is

underexposed due to the bright area in
the centre of the frame fooling the camera’s
metering. Increase the exposure by +11/3
stops using Exposure Compensation mode.

94 Photography Tips, Tricks & Fixes

trapped by cool air to form mist, then a sunny
morning. Autumn is the best season to shoot
woodland sunbursts as you have the added
benefit of beautiful foliage colour, but you can
also get the right conditions during winter and
spring, too.

The key is to locate suitable woodland. Ideally,
choose a location close to where you live — the
image here was shot just two minute's

Alter camera settings Set your DSLR

to multi-pattern metering and Aperture
Priority mode. Stop the lens down to f8 or
11 to give you sufficient depth of field, then
compose your shot and focus using AF.

Re-take the shot With the exposure

adjusted, re-take. Once you've got the first
image spot-on, shoot some alternatives by
varying your viewpoint, lens focal length and
camera format.

away from the photographer’'s home - so
you can get to it quickly, then keep an eye
on the weather. If you wake to misty
conditions, head to the woods with your
camera. Technically, shots like this are easy
to take because everything's there. You
don't need to use filters or employ fancy
technigues — simply mount your camera
and start shooting. It's as easy as that!

Take the shot You're now ready to shoot.

Use a remote release to trip the shutter
or, as here, set the self-timer to a ten-second
delay and press the shutter release. Check the
preview image and histogram.

EED o o

Do some post-processing Increase

Clarity a little to emphasise the sunbeams
and Vibrance to boost the colours. If any areas
are too dark, use the Lasso tool to select them
then Levels or Curves to brighten them.
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Createa
time stack

Give your landscapes a
painterly feel with this
creative technique

. I magine if you could create a picture

conveying a sense of motion and time
passing, created by clouds that move
through the sky during the course of
minutes, or even hours. You can use a time-
lapse technique and combine the images
together to capture this cloud movement —
cloud-stack. A time-stack sequence creates a
painterly look that is much different to a long
exposure, which blurs the clouds together over
several minutes.
The first step is to identify what type
of conditions work best for a time-stack
sequence. Look for well-defined clouds with
lots of contrast against a clear, blue sky.
Sunsets can also be fantastic and colourful,
. but avoid overcast days or dull light. Using a
graduated neutral density filter can help to
balance exposures if the sky is brighter than
the rest of the composition. The second step
is to set your camera up to record the action
using an intervalometer, shooting every two
to three seconds as the clouds move across
the sky. Once you've recorded your time-lapse
sequence, you are ready to take your resulting
images through the post-processing stage to
create your wind-painted clouds as a single
image. Photoshop is a great tool for combining
your sequence in post-production, but any
editing software that features layers and blend
modes will work just as well.

Cloud-stack

The final epitomised image represents 130
time-lapse sequence images combined into a
single image using the Lighten blend mode in
Photoshop to create a unique painterly effect
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Shooting
steps

Mount your
camera on a sturdy tripod. You

will benefit by using a wide lens to
take in all the action of the clouds.
It is good to use a wide-angle lens
that accepts a variety of filters. The
more sky you can show, the more
dramatic the image will be.

Find a
composition that will be easy to

combine. A static landscape (with no

foreground movement) or seascape
where the water will be blended as a

unique texture. Here, the composited
image results in a fascinating texture

of the rippled water with the unique
cloud structure.

Take a test shot to determine
the best exposure and make any
adjustments if necessary. Use
caution not to overexpose the cloud
area. Once the correct focus is
determined, turn off autofocus to
prevent the camera trying to refocus
during the time-lapse sequence.

A graduated ND filter helps
balance the overall exposure, toning
down the unevenness of a bright sky
compared to the darker foreground
elements. Use a soft graduated ND
filter, or reverse ND filter. A two-stop
graduated ND works beautifully for
balancing exposure.

Set up
the intervalometer for two to three
seconds, depending on how fast the
clouds are moving. Set the duration
to the maximum number of shots,
and stop the time-lapse sequence
when desired. You can create a time
stack with 100 to 200 images.

If your camera can
record multiple exposures, you can
create a short time stack in-camera.
This works in a very interesting and
beautiful way if you use ND filters
and long exposures for the short 10
image sequence. This creates a long
exposure cloud-stacked look.
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IDENTIFY THE BEST CLOUDS

Toidentify the best clouds for this type of composited
imagery, look for strong contrast between the blue sky
and moving clouds that will create painterly streaks
across the sky. If the day is overcast, the clouds may not
have enough definition for dramatic results. Experiment
with this technique at various times of the day for
different results. Clouds leading to a colourful sunset
create a vivid and fascinating image. You should shoot
in RAW to have flexibility in adjusting your white balance
settings in post-processing. With middle-of-the-day
shots, and clear contrast between your clouds and blue
sky, a sunny white balance setting can be stunning.

NEUTRAL DENSITY FILTERS

After you determine the elements in your
composition, take a test shot, and make any
adjustments needed to the exposure. In some
cases, a graduated neutral density filter will

help balance the exposure, like toning down the
bright sky compared to the darker foreground
elements. Use either a soft graduated neutral
density filter, or reverse graduated neutral
density filter. During the day, a solid neutral . pe
density filter is good to use for a long exposure to g ' ”
soften the clouds and to create more of a blurred 008
painterly look that accentuates the evolution i
of the clouds. This can be quite dramatic and
beautiful, and creates a very painterly look
compared to exposures that freeze the action.

<) . 9999 x 1
[©00:00'02" ] @17:34
0K [0].4

Nikon

SET THE INTERVALOMETER
Mount your camera on a tripod, find
a pleasing composition, and set your
in-camera intervalometer to record
several hundred exposures. Many
Nikon cameras have this feature
builtin, but other cameras require
an external intervalometer for this
function. Dependent upon how

fast the clouds are moving, here we
chose two or three seconds to record
the action. Fast clouds get two
seconds. You can set the duration of
time to record images in advance, or
control it yourself in case the clouds
become more interesting and you
need to extend the time so as not to
miss the best action. Any hesitation
between exposures will create a
noticeable gap in your clouds (just as
if you were shooting stars).
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Lens Correction...

corrections to the RAW files with " : Merge to Panorama...
your image-processing software. AT
Synchronise adjustments to all of | = ...
the images. Renumber images with
a simple numbering system, and
save to a new folder.

Load Files into Photoshop Layers...
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Load images to Photoshop
From Bridge, load the
image files into Photoshop
as a layer stack. Go to Tools>
Photoshop>Load Files Into
Photoshop Layers. Then, from
Lightroom, select the images and
choose Photo>Edit in>Open As
Layers in Photoshop.
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Create the blended effect
Select all layers in the stack, &
and change the Blend Mode to

Layers Histor
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result by showing or hiding various — Pt 100 [
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stack into a single image. e
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Photoshop or Lightroom. Make : i
contrast, colour, and texture : ‘ . e o
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Shoot stitched panoramas

Turn a series of digital files into a stunning panoramic

image by following our simple step-by-step guide

ow many times have you downloaded
H a set of new landscapes onto your

computer, only to be disappointed
because they just didn't fully capture the
drama and beauty of the scene? It's not that
you're a bad photographer, but simply because
your brain took in far more of the scene than
your camera did. When we look at a beautiful
view we pan across it from left to right, but as
a single image only captures part of this view,
we're often left feeling short-changed - it's
kind of like looking at a jigsaw with lots of the
pieces missing!

Panoramic photography gets around this
problem by enabling you to capture scenes in
the same way that your eyes scan and your
brain interprets them.

e Wy, S e e
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This elongated ‘letterbox’ format forces the
eye to scan across the image, taking it in

bit by bit rather than in a single hit, which
psychologically feels much more like looking
at the real, full scene.

Specialist (and expensive) cameras were
used in analogue days to produce panoramic
negatives and transparencies, but in the digital
age you can create stunning panoramas
using the camera you already own, simply by
shooting an overlapping sequences of images
then using software to ‘stitch’ them together.

This may sound time-consuming, but it's
actually quicker and easier than ever thanks
to vast improvements in stitching software.
The key is planning and consistency — get the
source images right and the rest is child's play.

Straight shot of the scene

This image is pleasant enough but it doesn't
really capture the sense of open space or show
the lighthouse in its surrounding environment
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Set up your equipment Mount your Take a test shot Take a shot of the scene Shoot the sequence Swing the camera
camera on a tripod in landscape or at f8 or f11 with focus set to manual. If all to the left and take your first shot. Next,
portrait format. Make sure the tripod head is  looks okay, set that exposure on your camera move the camera to the right a little and take
level on the legs and that the camera is level  so that you use the same exposure for each the second shot, ensuring it overlaps the first

on the head by using a spirit level. frame. Also set white balance to daylight. by about 40 per cent. Repeat as required.

Add Open Files

Process the Raw files If you are using Stitch the images together If you have Finish off the panorama After a few
the latest version of Adobe Photoshop or an older version of Photoshop, first batch minutes, Photomerge should finish stitching
Lightroom, you can create a panorama in ACR process the Raw files, then in Photoshop go to the images and present you with something
(Adobe Camera Raw) from the Raw files and File>Automate>Photomerge. Click on Browse, like this. You can then crop the edges, remove
save it as a DNG file for processing. select your images and click OK. sensor blemishes and carry out any final editing.
= N

- " FINAL IMAGE

re the wider view
of place is far stronger
ed panorama than in
nd the eye scans
from left to right
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Shoot stunnin
urban abstracts

Julia Anna Gospodarou on how to capture and edit a

Tips| Tricks|Fixes

monochrome architectural photograph that wins awards

ost of the photography tutorials
M you can find are about the

technical and processing aspects of
photography, but for fine-art photography
this is often not enough. Fine art is not only
about gear and software, or even about having
a good eye for the subject, but about how
the photographer interprets the world in an
artistic way. This is why, before even going
out shooting, it is important to define your
intentions for the image you will create, and
work on your personal vision that you want to
be transmitted through your image.

Of course, the way you shoot and process

your images is important because it is how
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you create the actual image, but what you say
to the viewer has to do with your vision, so
defining it is important. Start from the idea
you want to convey, then find the right subject
and the right way of processing that will
transmit your idea. | am calling this process
and the photography born from it (en)
Visionography (envisionography.com) and |
see it as an evolution of photography that
gives the photographer the chance to create
more personal and original work. This is one
of the qualities that can guarantee your work
will win awards, and ensure your images stand
out at competitions among thousands

of other images.

—

During the entire image-making process,
always stay focused on what you aim to
communicate with it. This will give your image
authenticity and make it stand out.

Keep in mind that architecture means first
and foremost geometry, so when you create
an architectural photograph you are dealing
with lines, shapes, volumes and intersections.

When you work in black and white you
are also dealing with the nuances of light
interacting with the volumes and shapes that
you shoot. You are working with space and
depth, revealed by light. For more information
on Julia Anna Gospodarou and her work, please
visit juliaannagospodarou.com.

What you'll need

@ DSLR or mirrorless camera (or any
other camera with Bulb function — such
as medium format).

@ Wide-angle lens, regular or tilt-shift (the
24mm tilt-shift lens is recommended
for architecture).

@ A sturdy tripod.

@ Neutral-density filter: 16-stop filter or
10+6-stop stacked filters.

@ Cable release or remote control.

@ Lightroom (alternatively DxO OpticsPro).

@ Photoshop + Topaz Labs plug-ins.

@ Optionally: Wacom tablet and pen for
more accurate processing.

Left

Equivalents | - Insidewards

This image is of the Pennzoil Place in Houston TX, a famous
building designed by Philip Johnson, and is a 252 seconds
long-exposure shot with a 16-stop neutral-density filter. The
series Equivalents is a homage to Alfred Stieglitz, the one
who used this term for the first time in the beginning of 20th
Century to create the first abstract photography series, with
the intention of communicating emotion.

The aim was to create a hierarchy in the importance of
the elements in the frame, so they culminate with the most
important point in the image: the subject. The split between
the two sides of the building separates them but also brings
them together. The meaning of the title is the idea of the
artist turning towards himself to find inspiration
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Shooting
steps

Depending
on your idea and the subject you're
shooting, you will find that a certain
angle is better than others to convey
your vision. Walk around the subject
and choose the best angle while
taking some test shots.

Having a good sturdy tripod
when you shoot architecture, and
especially long exposure, will pay
off, so be generous when you invest
in your tripod. Make sure you place
the tripod on a steady surface and
double-check how securely the
camera is attached to it.

Switch to Bulb and keep your
ISO as low as you can — 100 would
be the best. Keep your aperture
as close to the sweet spot of your
lens as possible. An aperture
between f8 and f13 will give you
the best results for the clarity of
your image; f16 and higher may
create diffraction in your image.

The best way to do this is to use
a long exposure calculator on your
smartphone. There are various apps
to help with this; state the number
of stops of your ND filter and the
shutter speed you would use if you
took a short exposure. The app will
calculate the long exposure you need.

To avoid

light leak during the exposure
when shooting with a square filter,
you can use a special holder designed
to protect from light leak, like the
Formatt-Hitech Firecrest holder. After
the exposure time has ended be sure
to check the result carefully so you
know that the image is sharp.

Be

sure to switch off the camera
when you attach the cable release,
otherwise it can interfere with the
correct functioning of the camera
during the exposure. Alternatively
you can use a remote control with
the same results.
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The setup

STUDY THE LIGHT

If you can, do not shoot in very contrasty
conditions, with strong Sun creating
dark shadows. Strong shadows and
intense light are useful in black-and-white
photography if you want to focus on the
relation between light and shadow, and

if you want to emphasize this or create
patterns, silhouette-like images and so
on. Otherwise, opt to shoot when the sky
is partially overcast or when there are
clouds in the sky. Even if you do not shoot
along exposure, this will give you a softer
light so you will have more freedom in
processing. If you do shoot long exposure,
make sure the direction of the clouds
works compositionally in your image.

USE STRONGER ND FILTERS FOR SOFTER CLOUDS
Keep in mind that when shooting long exposure, the stronger the
ND filter you use, the softer the clouds will be in the final image. If
you want more dynamic clouds go with a shorter exposure, and
alower intensity filter, 13-stop ND or less.

Use a tilt-shift lens

For professional results, be sure to invest
in this key tool for shooting architecture

The tilt-shift lens is one of the best investments you
can make if you want to shoot architecture at a

high level of quality. This lens enables you to control
perspective and correct the verticals so you can see
parallel between them and perpendicular on the
ground. The tilt-shift lens is first of all a prime lens,
which will guarantee a high-quality image. This is due
to their construction, and the tilt-shift lens follows this
pattern. You will also have better quality on the edges
of the photograph where most lenses are delivering a
softer image, plus virtually no chromatic aberration.
This means sharper images, which is important in
architecture, so if you can, invest in the tilt-shift lens and
you will get even more quality from your camera. One
thing to keep in mind when you shoot with the tilt-shift
lens is to focus and meter the light before you shift or
tilt the lens so you get correct results, otherwise they
may be altered. The tilt-shift lens may need a little bit of
practice to handle well, but once you learn to use it it's
an invaluable tool for architectural photography.
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CANON LENS TS-E 24mm 135 9
\\\\\\\

CHOOSING LENSES
When you shoot an architectural
subject, think if you want your
image to present the object from
afrontal view or an eye-level view,
or if you want to shoot itinamore
abstract way. If you intend to
shoot at eye level, try to compose
it so the verticals of the object
are straight and parallel to each
other. Atilt-shift lens will help you
control this. Otherwise you can
use software to straighten the
vertical lines in post-processing. 2
If you want to approach the —
subject more abstractly you have ‘ 4
the freedom of disregarding the y
parallelism of the verticals and S B B
using converging lines instead of ‘4 . 30
verticals. This approach can give
your image more dynamism.
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Editing steps

Start in Lightroom or
DxO OpticsPro with general adjustments on white
balance, exposure and contrast. The main sharpening
will be done later, and do not increase the contrast
too much as this will be done in a more controlled
way in Photoshop.

A recommended

solution for this is to use the Topaz Labs DeNoise
plug-in. Use the Light and Moderate presets, but
where you have increased noise use the Strong
preset. You may need to apply different levels of
denoising in the sky, which has less texture compared
to the rest of the image. You can do this by selectively
masking the areas in Photoshop.

This processing method is based on working
selectively on different surfaces and volumes, which
is why it is important to work with an image that has
well-defined shapes. Sharpening tends to slightly
modify the outline of the objects by applying contrast TSRS
and this may interfere with the initial selections when "%\“\“\\\\‘\\\
done later.

5
R

To have more freedom in Photoshop you
need to create a black and white conversion that
covers as many tonal ranges as possible and that
is not too contrasty. In case the file you start with
has areas that contrast intensely to each other you
may need to make more than one black and white
conversion and use different areas from each of them.
Do not try to finish the image in this phase since you
have more tools to work with in Photoshop.

Contrast

Highights

Shadows

Whites
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Below

Dimensions

By enhancing the spatial qualities of the
architectural object, you can guide the
attention of the viewer towards the most
important areas in the image
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Blend flash
with natural light

Seamlessly complement the existing light to create evenly lit portraits

atural light can be beautiful and create portraits that look as though It's important that you find the right location to
N plentiful, but often to create well- they don't use flash at all. Creating natural- create this look, so make sure you try and pick
balanced portraits that are flattering looking portraits is easy if you apply a few somewhere with lots of windows, ideally no
for the sitter we need to infill with a flash. simple rules; make sure you add the flash tungsten light and with light-coloured
Even in rooms that appear flooded with light, from the right angle, use the natural light to walls that will help to reflect the ambient and
using flash alongside the ambient light can your advantage and balance the ambient added light.
help infill the shadows, even the light between light with the flash. Ideally if you can use a
the foreground and background and provide large softbox to soften the light the shot will Inset .
beautiful catchlights to the eyes. Flash can be look more natural, but that doesn’t have to Dulland unflattering
. . . Shot using the available light this image is
used purposely to create dramatic and moody mean spending lots of money on high-end underexposed. The model's eyes look dark
images, with shadows and contouring, but it flash systems; you can just as effectively use and her skin doesn't glow in the way it should
can also be used to mimic the natural light and  speedlights with modifiers to the same effect. for a commercial beauty portrait

=1
¥ T
i v

Pick your location Choose a location Use a large softbox Set up your off- Position your model Face the model

indoors with plenty of natural light, but camera flash using a large softbox, towards the direction of the natural light
no harsh direct sunlight creating patches of the bigger the better. The light should be entering the room. Place the part of them
light. Preferably near a window, where you positioned so that the flash comes from the that will be in frame in the shadow or flat
can position yourself in front of it. same direction as the natural light. light, away from any direct sunlight.

Set camera Set your aperture to f5 or Add your flash You should only need to Review exposure Natural light means

less, as this will give greater balance use a low power to create a well-exposed constantly changing exposures as the
between ambient light and flash. Take a image. Check you are not overexposing the sun dips behind clouds. Keep checking and
test shot and check the image is even but face or foreground, and that the light looks alter the ISO and flash as required. Shooting
slightly underexposed on the model. soft and balanced with the rest of the image. on an overcast day can help minimise this.
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AFTER

Naturally bright
skin and eyes
Using flash adds a

sparkle to her eyes
and brightens up her
skin, creating a well-
exposed image with
minimal shadows
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Use ND filters
for flash

Create professional shallow
depth-of-field effects, even
Inbright ambient light

rofessional portrait photographers
generally favour underexposing the

ambient light by two stops or more
whenever they are using off-camera flash for
outdoor portraits.

However, this makes it very difficult to
simultaneously achieve shallow depth of field,
which is also often preferred. Underexposing
the ambient light requires apertures of around
f11 or smaller, so the background behind your
model will be in reasonably clear focus.

Though ND filters are often associated
more closely with landscape photography,
professional portrait photographers and
videographers often make use of them to
enable wider apertures to be employed when
the ambient light is bright.

The only thing you need to keep in mind is
that the ND filter will also limit the effective
power output of the speedlight, so you'll need
to set it to a higher value and this will in turn
cause the recycling time to increase. Fresh
batteries will help with this, however.

If you'd like to apply this technique to your
own photography, keep reading as we reveal
the steps involved in the next few pages.

Left

Dramatic flash effects

Combining off-camera flash with a neutral
density filter allows you to create images
where the ambient light appears to be darker
than the subject, even on a bright, sunny day

What you'll need

@DSLR
@ ND filter

& Speedlight

@ Wireless triggers
@ Light stand

@ Light modifier
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Shooting
steps

Switch to full manual mode

With your camera activated, start
off by turning the Mode Dial to ‘M’
to activate the full manual shooting
mode. Next, set the shutter speed
to 1/100sec, the ISO to the lowest
value (usually 100) and finally dial in
the widest possible apeture value -
for our lens, this was f2.8.

Setup your flashgun You'll

want to use your speedlight in its
Manual mode, usually inidicated with
an ‘M’ There's a good chance you'll
end up on full power (1/1) in order
to correctly expose your model, but
start on half power (1/2) to see if
that's suffificient.

Attach the triggers To shoot

wirelessly, you'll need a radio
trigger unit for both the speedlight
and the camera’s hotshoe. You must
ensure that both devices are set
to the same group and frequency
values or the system won't work.
Take a test shot to check that
everything fires correctly.

Set-up and position the flash

Secure the flashgun to the
bracket on the lightstand. If you're
using a modifier, attach this now.
Having the speedlight near your
subject makes it more efficient in
terms of power and makes the light
softer, but don't get it too close or it
may be visible in your images.

Pre-focus the portrait If you

are using a stronger ND filter,
composition and focusing may
be difficult to do once it's been
attached. If so, frame the portrait
and focus on your subject’s face
beforehand. Be careful not to move
position, switch the lens over to MF
and then attach the ND filter.

Take some shots Review your
initial results using the LCD
screen on the back of the camera.
If they're too dark, either move
the flash closer to your model or
increase the power of the flash.
Another option is to increase the ISO
sensitivity to 200 or higher. Carefully
review the focus, too.

114 Photography Tips, Tricks & Fixes



= P

NOTE THE SUN’S POSITION
Shooting directly into the Suniis likely

to prove challenging from a flare and
exposure point of view, while if it's behind
you the model will be squinting. Having the
Sun slightly to either side of you is ideal.

Vs s

Use a modifier

For that professional
studio-style lighting, a light
modifier is essential

If you're serious about achieving pro-
quality lighting effects then investing
in a light modifier for your off-camera
flash setup is an absolute must. A light
modifier allows you to soften the light
generated by the flash and create a
much more pleasing light with less
harsh shadows.

Modifiers come in a host of shapes and
sizes, including photographic umbrellas,
softboxes and beauty dishes. For this
tutorial, we opted for a beauty dish as it's
perfectly designed for portrait headshots
and is a great way of creating a softer,
directional light. It's worth bearing in
mind that in order to start shooting with
a light modifier you may need to invest
in a flash bracket that offers support for
the attachment of a light modifier.

OFF-CAMERA FLASH

In order to light our model, we
fired a flashgun off-camera using
a set of wireless radio triggers.

“tia “.ﬁ

SHOOT LONG

To ensure the background was
thrown out of focus and into an
attractive blur, we shot with a
70mm lens setto f2.8.
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Editing
steps

Remove blemishes With your
image opened in Photoshop,
grab the Spot Healing Brush tool
from the toolbox and with a soft-
edged brush carefully brush over
any spots or blemishes on
the model’s skin to swiftly

remove them.

Boost the contrast Head

up to Image>Adjustments>
Brightness/Contrast and in the
window that appears, increase the
Contrast slider to a value of around
25 to give it a boost. Click OK to
confirm the changes.

Brighten the eyes Grab the

Dodge tool from the toolbox,
then at the top of the screen set
the Range to Highlights and the
Exposure to around 5%. Now,
gently brush over the model’s eyes
to brighten them.
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“Grab the Spot Healing Brush tool [and]
carefully brush over any spots or blemishes”
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Sharpen and finish

Go up to Filter >
Sharpen > Unsharp
Mask. In the window,
start off by setting the
Amount to 50%, followed
by the Radius to 2.0 pixel.
Leave the Threshold at O
Levels, but adjust this to
suit the image.

Below

The final portrait

After a few simple adjustments
in Photoshop, our image has
been successfully cleaned up,
sharpened and is now bursting
with colour and contrast

Tips| Tricks | Fixes
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Shoot food
In the studio

with flash

Follow our simple guide to shooting and editing
an enticing food image with the help of flash

Difficulty level: Intermediate/Expert
Time taken: 6 hours

to shoot luxury chocolates in the studio,

using flash.

The most important part of a food shoot
is deciding on the styling and concept of the
image/project. This includes considering the
composition of the shot, the overall feel and
mood to be created with the lighting, and the
styling and timings when you add in the food.
Chocolates are quite small and they will melt
easily, so it can be tricky to arrange them well.
It is also worth thinking about what props you
might want to use to complement the finished

I n this tutorial we’re going to explain how
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food. After these decisions have been made,
you need to set up the studio. Using flash in
food photography is really useful because

it means there isn't a continuous (hot) light
source pointing at your subject, which could
potentially cause the food to wilt, melt or
generally deteriorate — something you don't
want in your beautiful imagery! That said, with
LED technology you could easily work with a
constant light source if you find flash tricky. We
used four separate light sources in this shoot
to achieve the finished piece, with each light
adding something to the final image.

Luxury chocolate stack
Aselection of luxury chocolates
photographed with studio flash. Styled
using hessian ribbon, veined marble and

chocolate shavings to give extrainterest
© Double Exposure Photographic
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This first decision can be a little tricky,
as you need to choose something that
mirrors the atmosphere you want to
create in the image. Marble would be
ideal for something luxurious, whereas
weathered wood might work well
for a rustic approach. Here we chose
black marble with gold veining, a real
showstopper from our local stonemason!

Keep it simple. You

don't want to use too many props in an
image like this because it is all about the
chocolates. Since chocolates are small in
size you want to choose props that won't
be too imposing within the frame; you want
the chocolates to be the hero. Think about
complementary props and check your
colours work together!

Ample preparation is key in a shoot
like this. You need to make sure you have
everything you need before you start, as this
will really slow you down otherwise. Make
sure you have spares for any chocolates (or
other food) you plan to use — it's likely you'll
want a few attempts at the composition
and styling. Fingerprints are an issue as the
chocolate melts, so having spares means
you can swap themin.

Take your time on
this step, as you want to make sure
you get it right. Choose the camera angle
carefully, keeping in mind that you want the
chocolates to be the main attraction. The

positioning of the chocolates can be difficult,
so try moving one piece at a time and taking
a shot in between to critique the adjustment.

Place your lights

and make a test shot. You can change
the power as you wish and keep moving
them until they are in the right positions.
The power settings and positioning will
make all the difference here. You're
looking for a main light source, fill that
complements that light, a rim light and then
something in the background. Don't be
afraid to add a final light in later to pick out
a detail if the shot needs it.

Now
it's the time to apply any final touches.

Any chocolate shavings can be added
now as they will lose their shape and
potentially melt if you don't work quickly.
We also take multiple images with light in
different areas at this stage, which we can
later composite together in Photoshop —
just make sure that you don’'t move the
camera between the shots!

The setup

BACKGROUND LIGHTS

For the background lights we used our Fresnel which
produces the rim light on the chocolates. Rim lighting

is really key here because it gives a semi hard light that
produces specular rim highlights and feels like daylight
streaming into the setup. The background radial gradient
was created by using a flash head with a snoot attached,
pointing at a brown piece of card clipped up behind our
chocolate setup.

4 7 »
y / \ ~
/
MAIN LIGHTS
We used two flash heads with strip softboxes on either
> side of our chocolates; on the left as the main light, and on
b the right as fill. We also used two rolls of tracing paper in

front of these softboxes to help diffuse the lighting. The
CAMERA AND LENS trace removes any hard highlights and creates a smooth,
We used our Nikon D810 with a wrapping soft light which improves the appearance of
Nikon 85mm tilt-shift lens. This the chocolates’ surface. The same effect could also be
lens enables us to choose our achieved by using white Perspex in the same position,
perspective, elevation and focus however we feel that trace is a lot easier to work with and
precisely. is generally more colour neutral.
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ﬂayers Channels Paths =
£ Kind B TR ®

Edit the shot e

Layers in Photoshop We load our photos into layers in
Photoshop, with the main image at the bottom. This way we can
use masking to brush through the areas that we want to see.

Spot retouching Remove any specs of dust, fingerprints or
general blemishes from the chocolates using the Clone Stamp
Tool or Spot Healing Brush Tool. Overuse of these tools, however,

will cause the image to look mushy and lose detail. The base and
background will probably also need some work too. 4
g probebpy ~¥._ Background )

“Remove any specs of dust,
fingerprints or general blemishes
using the Clone Stamp Tool”

)

e Al
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Fixing and airbrushing On the top chocolate we picked a colour

from its edge and used the radial gradient tool to add in some
colour where needed. Choosing multiple areas of colour will make it
look more realistic, then you can mask out any areas that you don't
need. Remember to add noise to the gradient in order to avoid banding.

Below

Editing steps

Once we're happy with what we have shot, we then exportimages

from Capture One to Photoshop for some final retouching and airbrushing

BEFORE
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Adjustment layers You may want to desaturate some areas, like

any areas of black that might be slightly coloured. To do this add a
Hue/Saturation adjustment layer and take down the Saturation slider.
Brush it off areas using the mask. Adding a Curves layer will exaggerate
the contrast.

Adobe Photoshop CC 2017

P slgned Sample: Current Layer  © W @

1n. side.if @ 50% (RGB/16) % Screen Shot 2017-10-19 at 102153 png @ 100% (RGB/8")  Screen Shot 2017-10-19 at 15.38.47 (2)png @ 25% (Layer 0, RGE/8")

o 2 4 o 5.l [22, l29 les, [28, lsb)  lse . [se, lse. lss, lso. iz las s

Properties.
& KX curves

praset:  Custom

Ro8

=/
2
i
G

2

wA

a

Input: 59 Output: 55

M AH o

Photography Tips, Tricks & Fixes 123




Master the Moon

Capture amazing images by attaching
your DSLR to areflector telescope

This is one of the most popular subjects
in night photography — the Moon

is beautiful to look at but also very
challenging to capture in a photo. Anyone
with a long zoom lens or a point-and-shoot
camera can get a decent photo, but it most
likely will not have the same impact as an
image with detailed texture of the Moon's
surface without any further processing. By
using the wrong camera settings, poor focus
or an unsteady tripod, the result will be a photo
that may look right at first sight, but upon
zooming in the errors will become evident. The
longer the focal length, the more attention

is needed in order to get a sharp photo. The
method that you will learn here uses a T-ring
adaptor coupled with a DSLR camera and a
reflector telescope. This method produces
stunning photos of the Moon that are rich in
detail, and at a very low cost. For this example,
a Sky-Watcher Newtonian telescope with a
focal length of 650mm has been used, along

Attach one end of
the T-ring to the camera and the smaller
end to the Barlow lens of the telescope.
Use the extension tube of the T-ring if you
require bigger magnification.
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with a 2x Barlow lens that came with the kit.
The total magnification is similar to a 1,300mm
zoom lens (it also depends of the length of the
T-ring). The camera settings are also applicable
when using a zoom lens.

Poor focus

Shooting speed is correct but the focus is poor.
At first glance the photo looks decent, but is not
sharp enough to keep detail when zoomed in

In order
to reduce vibration due to the wind, the
camera strap must not be hanging freely. Tidy
up the strap around the telescope or remove it
completely. Ensure the telescope is in balance.

Up close and personal

This final image is rich in texture; the
surface detail invites the viewer to
explore the lunar landscape. Apply the
techniques to get the same results
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Select mirror lock-up and
set the timer to ten seconds even if you
have a remote release. Select Manual mode
and an initial shutter speed of 1/180 sec and
ISO 800 for a half Moon.



Use the
viewfinder or Live View to centre the Moon
in the frame. In Live View, set the camera to
one of the automatic modes like Aperture
Priority, so the Moon will show in the display.

In Live View, magnify the
image to the maximum allowed. Find lunar
features (like craters) in parts far from the
centre of the Moon to help with the focus. It
may take a few attempts to get this right.
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Switch back to Manual mode
and recompose the Moon in the frame. Play
with the shutter speed and ISO for the right
exposure. Try to never go below 1/120 sec. If the
Moon does not fit in the frame, take a panorama.
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Creative
high-speed

photography =

Capture product images
using the TriggerSmart
and speedlights

n this tutorial you will discover how to
I drop an aftershave bottle through a pane

of glass and freeze the motion just after it
hits with some high-speed flash. The most
important thing when making an image like this
is imagination — don't even touch your camera
until you have a clear idea in your head of how
you want your image to look. After that, it's all
in the setup. If you're going to make a mess,
start with a clear studio, then put some things
in place in order to protect your floor, walls,
camera kit and so on. You'll be grateful you did
later, and if you are going to break glass do take
it seriously and be careful not to injure yourself.
This tutorial demonstrates the use of speedlights
to show that you can achieve high-speed shots
using fairly everyday kit.

In terms of studio lighting, there are lots
of options on the market that are capable of
freezing motion and PocketWizard can help
you sync to older, slightly slower lights, too.
There are lots of options and a bit of research
online will help you to understand flash duration
and high-speed sync.

Right

Aftershave glass smash

Shot using speedlights. The rear light accentuates
the opacity of the bottle and there’s a cool white
balance to complement the glass and liquid

What you'll need

@ Camera @ TriggerSmart unit

@Lens @ Diffusion panel,

@ Tripod or paper or Perspex
studio stand @ Lots of stands

@ 3x speedlights @ Glass panes

@ Wireless @ Bottle of aftershave
transmitter @ Plastic sheets

@ Wireless receivers for floor
for the flashes @ Stepladder
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Shooting
steps

Although the image you want to
make will happen in a split second,
you will roughly know where the
action is going to take place. Clamp
up a sheet of glass and put the
product on it. After choosing our
camera and lens combo, we could
frame the shot up and move the
background and lights into place.

Set up
and take a test shot. From here
you can turn the lights up or down in
power, change their position and sort
out any syncing issues. You'll notice
the two off-camera flashes are being
triggered with wireless receivers.

The TriggerSmart ‘

will fire your camera or an
auxiliary device (a flash, for example). '
It can do this in three different ways:
using a sensor for light intensity, a
sensor for sound intensity or using
both sensors to create an infrared
beam which triggers when the
beam is broken.

Here is the sound sensor
connected to the TriggerSmart.
This is close to the action and will
be really sensitive to the sound of
the smashing glass, which will trigger
the flashes. Make sure you know
what setting you have dialled into
the TriggerSmart and your camera.

Your studio

needs to be pitch black so that
when your shutter is open nothing
will expose. We fired our camera and
quickly dropped our bottle. Once the
sensor picked up the sound it sent
a signal to the TriggerSmart, which
sent a signal to the PocketWizard
that fired the speedlights.

This is
where that early prep really pays
off! The cleaning up is really quick if
you can simply whip it up. You can
also see we laid down some fabric
and polystyrene — this was to soften
the blow for the bottle, which did still
take a few knocks but not nearly the
damage a concrete floor would have!
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CAMERA, LENS
AND FIRST FLASH
We have a Nikon D810
with a Nikon 85mm t/s
lens, which is a staple
for product workin

our studio. We have a
Nikon flash on top of
that, which enabled us to
push alittle light into the
front of the image.

\_____________/

{

FLASH 2, FLASH 3, POCKETWIZARDS
AND PERSPEX

Here we have two stands with super clamps to hold a
pane of glass, and above that is our main light. It's just
behind where we were anticipating the bottle to drop,
so it was out of the way but also added contrast. A
PocketWizard receiver is attached to that. At the back
we have clamped up a large Perspex sheet that has
another speedlight behind it, creating backlightina
nicely controlled spot.

T
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TRIGGERSMART,
LADDER, PROTECTION
Next to the glass there's a
stepladder to enable sufficient
height on the drop to smash
the glass. On the white table
you can see the TriggerSmart
unit, which will trigger the
lights once the bottle hits the
glass. On the left side you'll
notice that thereis alarge
diffuser panel. There's no light
behind it but it's doing two
jobs: firstly, it's bouncing some
light back in and cleaning up
some reflections in the glass,
and secondly it's acting as a
shield and preventing some
glass spreading into the studio.
You can see that there is some
plastic and cushioning down,
but after just a few test drops
the glass is spreading out.
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Editing
steps

In Capture One, start by
tweaking the contrast, clarity and
white balance. This image really
lends itself to a contrasty feel,
and we're also running the white
balance around 1,000 Kelvin cooler
than white to create a modern, ! ) | a0 B Y
sophisticated look. P o e | o oo«
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The
aftershave needs to be the
star of the show. Spot retouch
anything off of the bottle that
detracts — dust, glass, fingerprints
and so on. If the glass is flying
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over it and looks purposeful then
leave it there; it's nice to keep
some reality, which is why the air
bubbles inside the bottle have
been kept.

Add more shards Adding a

few extra pieces of glass to
enhance the shape of the break
can be nice. You can't influence
how the pane will break, but you
can use the Pen tool to clip a few
shards and move them around.

Sharpen the glass Some

extra sharpening was added
to the glass to give it a bit more
presence. Photoshop has lots of
sharpening options to experiment
with, but the Unsharp Mask did
the trick here.
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Create captivating
cinematic effects

Learn how to inject detail and drama into your
images using the Develop module in Lightroom

) inematic’ can mean many different
‘ things, but here you will learn how
to create a dramatic, high-contrast

result. We have to look to Lightroom'’s detail
and colour adjustments to create this faded yet
crisp dramatic style.

On the one hand you want to avoid losing
detail, but on the other hand you want
to create a subtle softness that reduces
the appearance of an image fresh out of
the camera. To do this, you can combine
adjustments such as Dehaze and Clarity, and
then Sharpness, to give you a good starting
point. It's about keeping colours bright without
applying too much saturation, because this
type of effect is not so much about drawing

attention to colour, but more about making the
action a focal point.

BEFORE

© https://pixabay.com/en/bike-motocross-speed-outdoors-1164927/
Above

Action shots

This effect works great with outdoor action shots that
feature overcast skies, interesting colour and movement

Tweak exposure Load up your image into

Lightroom and head to the Develop module.
Under the Basic tab, boost up the Exposure
slider to +0.44 and Contrast to +53 to increase
the overall brightness and impact.

Colour and clarity In order to boost the

detail further, increase the Clarity slider up
to +70, Vibrance to -28 and Saturation to +9.
This will help give a cinematic appeal to the
overall image.
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Expose the detail To control the brighter
regions, reduce the Highlights slider
to -55. Set Shadows to +46, Whites to +40
and Blacks to -17. This will create a certain
amount contrast and add detail to midtones.

, ’

Vignette for impact Inside the Effects
section of the Develop module, add a

vignette by setting the Amount slider to -20
under Post-Crop Vignetting. The options can
be altered to reshape the vignette if desired.

Dehaze for depth The Dehaze slider gives
this effect further strength by boosting it
up to +22. Going too high with this slider will
reduce the shadows to a solid black. Going in
the opposite direction will add a mist effect.



To add a dose of sharpness,
head to the Detail tab, slide Amount to
41 and then set Radius to 1. Set Detail to 15.
The image should appear sharper and more
refined as a result.

Under Noise Reduction,
set Luminance to 43, Detail to 73 and
Contrast to 25. To smooth out any colour
distortion, slide Color to 23, Detail to 50 and
Smoothness to 75.
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W \ » adjustments¥and.kightroom'’s

I\ AP Detail and Effects/6ptions, you

can really‘bring the §9bject alive

If a particular colour
is overpowering, such as the greens or the
yellows, go into the HSL section and reduce
the Saturation of the colours down to between
-30 and -40. This helps create a cinematic style.
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Follow these simple tutorials
to improve and enhance
your problem photos

Perfect your processing Rescue shiny skin

Intensify specific tones Banish blotchy skin tones

in Lightroom
Control colour with

Use clipping warnings Camera Raw

in Lightroom
Use Content-Aware cloning

Colour correction in Photoshop

in Lightroom
Edit with clipping masks

Enhance portraits in Photoshop

in Lightroom
Create a tilt-shift effect

Retouch mature skin
Add a sky with more drama

Use High Pass skin softening

Turn your landscapes
into something special
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TOP TIPS
v/ Retouch skin

v/ Enhance your
favourite portraits

v/ Enrich skies
v/ Intensify tones




Digital darkroom

Using Photoshop or any of the image-editing
software packages available, digital photographers
have a vast arsenal of creative tools at their
disposal. Post-processing can now be considered
to make up half of the total photography workflow
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Perfect

your

W

PROCESSING

Thereis a photo-editing application to suit every
photographer. Learn to get more from yours

ost-processing of images has
P become an essential part of the

digital photographer’s workflow.
There are a vast array of photo-editing
software packages available, from highly

simplified programs for beginners, to
high-end specialised tools used by

professional photographers and retouchers.

Of these options, some clearly lead in
terms of popularity and number of users.
While choice is often attractive, it can be
daunting when it comes to choosing a
package to start with and because of the
sophistication and variety of tools found in
the professional software, it is possible to
be left feeling a little overwhelmed. In this
guide, we will cover all of the key areas of
post-processing in an effort to help
you build a structured and effective
workflow, from the essential

adjustments such as exposure control

and contrast, through colour correction
and on to effective image database
organisation. Then, once you are confident
with the baseline editing techniques we
will move on to those ‘tricks of the trade’
that will make your shots stand out from
the crowd, including noise control, next-
level sharpening policy and professional-
grade RAW file handling. This will give you
the confidence to work with any of the
most-used software and more importantly,
teach you how to make the most of the
powerful features at your disposal, without
the danger of taking things too far and
potentially jeopardising the quality through
over-editing.

© Juuso Hamaéldinen
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Why process
your images?

The key reasons for
editing and how it fits
with your workflow

While digital camera technology is constantly
improving, people’s perception of image
quality evolves in equal measure — even
non-photographers are now able to recognise
when a shot has been ‘Photoshopped’ and are
even aware of when an editing technique has
failed. It is therefore vital that photographers
recognise the need to develop their post-
processing skills, so that they have a rounded
skill set and are able to produce quality
images in-camera and intelligently process

these files with an end product in mind.

In most cases we will start our image
editing with basic adjustments such as
brightness and contrast, simple colour
correction and sharpening. These are often
referred to as ‘essential’ adjustments, since
errors in these areas are the most noticeable
if left uncorrected and should be applied to
every digital image as standard. Beyond these,
most software offer tools to precisely control
colour via colour profiles, remove unwanted
lens distortions and apply localised edits,
which affect only part of an image. Next you

© Peter Carr |o.
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Dramatic sunset
While compositionis
good, the original image
lacked contrast and
colours are not vibrant
enough. With some
careful exposure and
contrast adjustments,
this scene now shows its
sroe full, colourful potential

might consider using a third-party plug-in

- ‘satellite’ software which can apply further Below
bespoke effects and correct highly specific Washed out
technical defects. These are optional edits Lighting was too uniformin

and some of the effects they provide can be .

ted Iv. h th ft curves adjustmentand a
created manually, however they are often very darkening of the edges using
powerful and offer great advantages in speed alayer mask, the eye is now
and versatility. drawn to the insect

this macro shot. Withacrop,
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CREATE CONDENSED LIGHTING




© Ronny Garcia
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Correct your contrast

Contrast determines depth and mood in an image — highly important for
dramain a two-dimensional photograph

SHADOWS/HIGHLIGHTS

Similar to Lightroom, these sliders in Photoshop
can lift shadows and darken hotspots. Tonal
Range dictates which tones are affected.

ADJUST LEVELS

pull the input sliders until they touch the

More versatile than Brightness and Contrast,

histogram for a quick contrast boost.
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MICRO CONTRAST EXPLAINED

Global contrast is the difference between brightest
highlights and darkest shadows. Micro contrast
defines detail, controlled by Midtone Contrast here.

ADJUST CURVES
Highly powerful, Curves allow precise tonal

edits. A classic S-shaped curve boosts contrast,
while the centre adjusts the midtones.
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Control
exposure
and contrast

Brightness and contrast
control can really make
or break animage

It is desirable to achieve an accurate exposure
at the shooting stage, as this minimises
post-processing work and generally reduces
the chance of software-induced artefacts
like image noise and banding. It also
encourages the photographer to be mindful
of overexposure and loss of highlight detail,
which cannot be recovered at the computer.
It is almost always necessary to tweak
exposure and contrast, however — contrast
is often lacking in out-of-camera shots, while
an image that looked accurate on a 3.5-inch
LCD screen may seem slightly too bright

or dark when enlarged. Furthermore, an

‘accurate’ shot — one that produces a perfect

histogram and ticks all of the technical
boxes — may not be the most punchy and
attractive image possible; correct does not
always mean exciting or dramatic. There are
multiple ways of making these edits and often
you'll find two or three methods in any given
software application, from simple work with
the Brightness/Contrast control in Photoshop,
to complex Curves adjustments in Capture
One and advanced work in Lightroom using
the Shadows, Highlights, Whites and Blacks
sliders. In addition to this, it is possible to use
tools such as the Brush and Gradient tools
in Camera Raw/Lightroom and layer masks
in Photoshop to perform local adjustments,
thereby solving problems or enhancing an
isolated image area. This is a vital stage as
often an effect applied globally can spoil areas
that do not benefit from that change.

Professional photographers often shoot in
RAW format, as these files contain all of the
image data captured by your camera’s sensor.
So, unlike JPEGs, which are compressed files,
more editing can be carried out before quality
begins to suffer. While Photoshop offers
more tools for fine retouching work, RAW
processing applications now offer enough
tools to perform most of your workflow on
your RAW files, the other benefit being that
this style of editing is non-destructive. This
means it is possible to revisit an image at
any time and easily alter the exposure again,
without degradation.

Whatever software package you use, an
appropriate exposure and contrast will define
the success of your image.




Why local adjustments matter

Make your editing more precise with adjustments to exposure and contrast

Global adjustments enable us to correct major
image-wide issues, but in many cases you'll
want to look closer at individual areas that
might be lowering the shot's overall impact.

Open in Camera Raw Try to perform as

many adjustments as possible on your RAW
files to future-proof your editing decisions.
Capture One also works in a similar way.

In this image the overall exposure is good, but
there are some small shadow areas that need
brightening and the scene would benefit from
some localised lighting effects to add depth.

© Peter Fenech

Use Adjustment Brush (K) Available in
both Camera Raw and Lightroom, drag the
exposure slider to the right a little and paint
with the brush in areas you want to brighten.

Check your adjustments Tick the Show
Mask box to see if you've spilled over into
other areas of the image. Select a pin and
click Erase to undo brush strokes.

B e R R N N R

PETZHD PrEANPN
- o
§
1]
£

. A SEEN -

Use Gradient tool (G) The top left of

the scene needed a little added exposure
and warmth. The Gradient Tool was selected
and a gradient drawn down over the area.

Finish in Photoshop You will often find
it necessary to move into Photoshop for
more complex edits. Working on a duplicate
layer maintains a non-destructive workflow.

Apply local sharpening The edges of

the frame are slightly soft. On a duplicate
background layer, use the Sharpen Tool to
extract detail.
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Advanced portrait post-processing

Photographer Adrian Dewey guides us through the processing of one of his portraits

Camera Raw The first stage

of my editing process is to
open the image in Adobe Camera
Raw and make the initial changes.
Using the simple sliders | have
altered the exposure, shadows,
contrast and vibrance.

S e m o

. /
Actions | use a lot of
Photoshop actions, some that
| recorded myself, some that |
have bought. Here | ran one of
my actions, called ‘blue fashion,
for colour, tones and contrast. It's
often a case of experimentation.

BEFORE

Potential
Thisimage has all the
ingredients of agreat
portrait: effective
composition, pose
and lighting. However,
post-processing can
be usedtocreate

something unique
© Adrian Dewey

Enhanced in post
| finished by using Unsharp Mask

tomake the image even crisper, as
on portraits | like to see skintexture
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Open in Photoshop Next |

will open in Adobe Photoshop
(CS6 on my MacBook, or CC on
studio Mac) and using the Spot
Healing Brush Tool | take time to
tidy up the skin without losing the
skin texture.

Brightness and contrast
The previous action did
take some of the contrast out,
so | will go back and alter the
brightness and contrast from the
Image>Adjustments>Brightness/
Contrast option.

Gels As | had used gel lighting
| now enhance where the
colour hits the skin. Using a soft
brush set to Soft Light at 30%
opacity, with a colour similar to
the gel colour, | go over these
areas to make the colour stronger.

aaaaa

Selective colour At this
stage | just used Selective
Color to make the whites more
blue and the blacks darker. As
a portrait | am happy with the
image now, although the photo as
a whole needs more punch.

Colour balance In Image>

Adjustments>Color Balance |
use the sliders until I'm satisfied.
In this case, with Midtones
selected | moved towards the
cyan levels, and then for Shadows
| went for red and yellow.

Brushes | felt the background
was looking a bit dull. Using
some ‘light’ brushes | downloaded,

| added some white and blue
lights in the background and
overlaid the model to make the
image stand out a little more.




Craft colour
and tone

Produce special effects
while avoiding the
common pitfalls

Colour correction is one area where shooting
in RAW provides arguably the greatest
advantage, as applications like Camera Raw
and Lightroom have the option to change
the white balance of an image at any time,
just as it is possible to do in-camera. Presets
are available that mirror most camera white
balance settings, including Cloudy, Daylight,
Tungsten and Shade for rapid one-click
adjustments, and for more precise alterations
sliders are present for colour temperature and
tint selections. It is also possible to eliminate
colour casts easily using the White Balance
selection tool — simply click once with the tool
on an area of neutral grey to remove colour
bias. Beyond this, highly advanced colour
and tone adjustments can be made using
Curves, where each of the RGB channels can
be manipulated individually. By controlling
each of the Red, Green and Blue Curves, the
dominance of each colour can be varied
to either remove or apply colour casts, for
correction or creative effects respectively.
Tone refers to brightness values found in
an image (luminosity) and the warmth of
the colours present (temperature). When
editing either the colour or tone of a shot, it
is important to remember that in most cases
one affects the other and so they should
be considered in unison. When making
contrast adjustments (altering tonality) colour
saturation is often increased, emphasising any
temperature bias. In Photoshop it is possible
to avoid this by using the Luminosity layer
blend mode on an adjustment layer.

Bibliotek | Framkalla | Karta | Bok | Bildspel |

RAW COLOUR ADJUSTMENT £&

Above
Mood lighting

Using a RAW processor
like Lightroom, itis
possible to greatly
enhance colour and
tone. In sunsetimages,
these colour edits are
required to retain the
mood of the scene

© Johan Lennartsson

BEFORE
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Know when to stop

Part of developing a professional post-production workflow is
recognising when you've gone too far

There is a disadvantage to having so many degrade the final image. A useful technique

editing packages at your disposal, each is to lower the opacity of any effect you've
with a vast number of tools. Sometimes applied or even turn it off completely, then
it is useful to combine effects for creative gradually increase it again to see how or
reasons, but you have to be able to define if it benefits the image. If you're unsure,
the point where further adjustment will you've probably reached that critical point.
Top
In need of
improvement
The tones and

colour of thisimage
are pleasant, but
could do with some
boostingt. There

is little depth and
the colour doesn’t
accurately recreate
the real-life hues

Middle

Over the top
This shows
unrealistic
saturation,
introduced partially
through aggressive
Curves adjustment
and an unnecessary
application of
Vibrance. The
changes have also
accentuated noise

Below

A correct
balance

Inthe final shot there
is an equilibrium of
depth, dramaand
realism. The clouds
have added shape
andimpact, but the
colours are easier on
the eye and noise is
less pronounced

g

i

© Peter Fenech
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Add the
finishing
touches

Take these final steps to
guarantee viewers see
your work at its best

If you shoot in JPEG format it is possible to
select the level of sharpening that is applied
to your images in-camera. This is quite
limiting however, since these changes are
non-reversible and so any over-sharpening
is difficult to eliminate. This is an especially
inconvenient problem because the amount of
sharpening an image requires is influenced
greatly by its output destination — images
bound for the web often don't need as much
sharpening applied than those destined for
print. The same principle is applicable to
noise reduction, in that it is better to have full
control at the post-processing stage. In Adobe
Lightroom and Camera Raw, the level of
sharpening is controlled by the Amount slider,
Radius handles the softness of the effect and
Detail enhances fine textures. Capture One
has a similar set of sliders, but the Threshold
slider determines how pronounced an edge
has to be before it receives sharpening — low
values include more flat tones and higher
settings limit sharpening to high-contrast
edges. This is useful for minimising noise in
flat areas. This equates to the Masking slider
in Lightroom and ACR. The Unsharp Mask tool
in Photoshop is effective when sharpening for
print; try sharpening a duplicate layer (Layer>
Duplicate) and changing the blend mode to
Luminosity to prevent any colour shifts.

Regarding noise, there are two types: Colour
and Luminance. Use the respective sliders
in Lightroom/Camera Raw to reduce both,
visiting the Detail sliders and Contrast slider
to compensate for detail smoothing and
flatness introduced by removing noise.

Meanwhile, lens corrections are a staple
adjustment to most images. In Lightroom
you can apply a lens profile under the Profile
tab and customise distortion and vignetting
removal for your image, before switching
to the Colour tab to remove distracting
chromatic aberration (coloured fringing) from
high-contrast edges. In Photoshop you can
apply lens corrections from the Filter menu,
choose a camera and lens profile and apply
custom tweaks to all other factors.

While noise reduction, sharpening and lens
corrections may be subtle, they can make
the difference when submitting your work for
commercial use.




The perks of plug-ins

Plug-ins canreally expand the
capability of your software, so
here are some recommendations

There is a plug-in for almost every
adjustment you could need to make

to an image, and they are often hugely
beneficial because they are designed
for specific functions — they do a small
number of things very well.

HDR EFEX PRO
HDR can be used

: for artistic effects or
“| versatile exposure
balancing. Photoshop
has its own HDR
feature, but HDR Efex
Prois one of the best
third-party options.

SILVER EFEX PRO
The main advantage of
this plug-in is the wide
array of film simulation
presets, capable of
producing stunning
analogue-like effects
for dramatic black and
= White conversions.
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Added realism ) AD
Controlling colour This plug—m is us_ed for
temperature ensures % enhancing detail and
scenes appear colour in your images.
realistic — unnatural < It'saquickand intuitive
colour creates 1 route to stronger colour
emotional barriers P i and depth, where you
between animage fadlls Koo 43 ,%‘ can create gritty artistic
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Keep your images organised

Devise alogical and structured archiving workflow

It is critical that you keep an organised and
structured database. This should be backed
up to ensure you have redundant copies

of every shot should your main storage
location be compromised. It should be easily
searchable, so that you can quickly find
images later. It is important to remember that
once you start with an organising workflow,

it is helpful to stick to it from that point on

to minimise the chance of misplacing files
and creating searching conflicts. For example,
when utilising Lightroom to organise your
work, it is a good idea to store all images for
that collection in a single folder; this feels
counter-intuitive if you have been manually
sorting files into folders based on date or
genre on your hard drive, but it will make it
easier for Lightroom to keep track of your
photos. If you have some images stored on
an external hard drive and others on your

Keywording ¥

Keyword Tags | Enter Keywords [2
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desktop, you may find that Lightroom has
missing photos if you remove the external
drive from the system. Being sure that all your
images are available in synchronisation can
help streamline your workflow.

When importing images or outputting an
edited version it is useful to add keywords
to the files so that you can find them later
in your database. If you hope to sell work to
publishers or stock image sites, intelligent
tagging will make your work easier to find,
giving you an advantage over the competition.
Add tags in Photoshop by visiting File>File
Info, where you can also embed descriptions
and copyright information into your files.

Keep your edited images alongside your
originals at all backup locations, so you know
that you have both safely duplicated and
available. With ACR, remember to back up the
XMP files, generated when you edit a RAW file.

FELEASE NOTES

Fun, free Photoshop design contests

o-—
Above-top

Other software options

There are lesser-known editing options to consider.
The free application Gimp is surprisingly powerful
and offers many features found in high-end packages

Above-bottom

Endless creative options

Professional digital photographers have learned to
make the most of what the medium has to offer.

To motivate yourself to creatively experiment, try
entering a post-processing contest
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Noise reduction
Noise in shadow areas can
become more pronounced

with exposure adjustment.

Using noise reduction on
RAW files smooths grainin

anon-destructive way
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Storing your images correctly

\ is just as important as how

‘ you take them

It is good policy to have at least two
copies of every image you take on
separate drives. Many professionals have
a third copy located at another physical
location or in cloud storage. It's best to
back up as you import originals and then
as you save edited finals. When copying
images, always duplicate originals —
don't copy copies as this can eventually

lead to file corruption over time. Choose
hard drives of 500MB or more.

Never too safe
Cloud storage is
aconvenient way
to create off-site
backups. Sites
like Dropbox or
Google Drive offer
considerable
storage space
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Intensify specific
tones in Lightroom

Use the Adjustment brush to convincingly
enhance colours in a matter of minutes

hether you are boosting saturation
Wor altering tone and temperature,

editing colour needn’t take hours
to do. That's why the Adjustment brush
in Lightroom is rightly the go-to tool for
improving an image that's lacking impact.
Instead of adjusting the image globally, which
is what the Basic set of adjustments is there
to do, the Adjustment brush gives you the
freedom to make edits as locally as you need
to. What's more, you can apply different
settings to different areas of the image
according to how you need them to look.

Here you will discover how to boost the

tones and warmth of the main subject, as well
as increase the saturation of the foliage in the
foreground, to make this image a touch more
appealing. There's also a look at setting up the

e, 3 L
Load image In Lightroom, head to
File>Import Photos and Video. You'll need
to locate the folder and then tick the image
before pressing Import. Once imported, click
on the Develop tab along the top.

N\ %,
Prepare adjustments Before applying
the brush, set the Saturation slider for the
Adjustment brush to 70 and also Contrast to
20. This will tell Lightroom that whatever is
brushed over will be given those changes.
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brush and applying new brushes to control
different areas, techniques that you can apply
to any image.

BEFORE |

A\ \
© https://pixabay.com/en/wildlife-young-mammal-animal-wild-1367217/
Above
Before editing
A good composition with plenty of natural light makes
for a strong shot, but flat colour lets this image down

N\ \
Alter brush settings Find the Adjustment
brush tool underneath the Histogram
panel. At the bottom of the brush'’s
adjustments, set its Size to 11 and Feather to
100. A Flow of 100 will give maximum effect.

Brush on colour Pick an area of colour,
such as the grass in the foreground, and
brush over the area to apply the settings from
the previous steps. If you find the saturation is
too high, simply lower the Saturation slider.

AFTER

An easy fix

The Adjustment brush is ideal
for selectively enhancing tone,
such as the animal’s fur and
leaves in the foreground

Reset brush settings Now that we've

adjusted colour, we can boost tones for the
main subject using a new brush. Click on New
at the top of the Adjustment’s panel, and then
double-click Effect to reset the brush.



Set up for warmer tones Slide up

the Temp adjustment to 60 to give us a
starting value. Brush over an area of the image
that needs warming up, such as a person or
animal, to see how the brush affects that area.

Tips| Tricks|Fixes

Complete the effect Continue to brush

over the entire subject, lowering the brush'’s
Size for smaller areas such as legs and ears. If
you make a mistake, click the Erase option in
the brush settings and brush over those areas.

Add more red If the tones appear too

yellow or orange after brushing, slide up the
Tint adjustment to 50 or more to add warmer
colours. In this image, the fur of the deer
should look a warm, orangey-brown colour.
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Use clipping warnings

in Lightroom

Discover how to adapt lighting and contrast
using Lightroom’s clipping warnings

C lipping warnings are found
throughout photography, from your
camera’s image review function to
post-production software. It's a feature in
photography that informs us about the areas
of the scene that fall outside of the dynamic
range that is accurately rendered in the

image. In Lightroom, the histogram reveals the

BEFORE

Observe the histogram Open up an
image with high contrast so you can get a
better feel for how clipping warnings work. Go
into the Develop module and make sure the
histogram is open in the top right of the screen.

Control the highlights To fix the clipping

in the overexposed regions, decrease the
Highlights slider until the red mask disappears.
If your image shows a lot of clipping, you may
need to decrease the Exposure slider by 0.30.
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distribution of light across any one image,
from the darkest regions, which show up on
the left of the histogram, to the lightest areas
over on the right. With the clipping warnings
feature active, we can greatly improve the way
we adjust exposure and understand light in
general. Knowing the practical applications of
clipping warnings will ensure that we don't lose
out on any details across an image, whether
it's at the time of capture or post-editing in
Lightroom. Follow these steps to find out

how to perfect exposure using brushes and
adjustments using clipping warnings as a guide.

Left

Look out for clipping

Clipping warnings help to avoid loss of detail,
whether it's due to very high contrast or a
generally over or underexposed image

View clipping Clicking on both the two
small arrows in the histogram will activate
the clipping warning. Any completely black
areas will show up as a blue mask, and any
areas completely overexposed will appear red.

; Lt
Rescue the shadows To retrieve the Set up the Brush Set the Adjustment
shadow regions from clipping, boost the Brush settings to 100 Feather and a Size
Shadows and Blacks sliders together. If your large enough to fit over the shadow regions.
image gets lighter overall without retrieving the  Increase the Shadows slider to 50 and set
clipped areas, click on the Adjustment Brush. Blacks to 40. Ensure all other sliders are on 0.



i
r the blacks Paint over the
clipped shadows in your image to apply
the Adjustment Brush settings. You should
see the blue mask from the clipping warning
gradually fade away.

Alter exposure The clipping warning

feature is also useful so that we don't stray
outside of the visible spectrum when altering
exposure from a low-contrast image, keeping
the detail in important areas.

AFTER

" Rescuing the exposure

We were able to identify the
clipped areas and bring back
details that were there but
invisible to the naked eye

Keep active To make sure you always

have the clipping warnings active while
editing, press J to load them instantly. If you
ever stray outside the visible spectrum, the
overlays will be there to warn you.
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Colour corrections in Lightroom

Learn how to use Lightroom's essential tools
to tackle colour correction head-on

hite balance is a part of
photography that many of us now
take for granted. Letting your digital

camera take care of everything is just fine,
right? Well, ‘not really’ is the quick answer. Set
to Auto mode, it's hit or miss whether the
correct white balance has been accurately
calculated. Even setting a camera’s white
balance mode manually to match that of the

Focus on the eyes Load up your image
into Lightroom and head to the Develop
module. Press Space to zoom in to 100% and
then drag the image to bring the eyes — which

are a good starting point — into view.

Warmer colours Hover over the whites of

the eyes and click once. These should be
close to white and will adjust white balance to
normal. The image will warm up considerably,
which works well for this outdoor portrait.

(/

s

Remove blue tint Brush over the model's

eyes to reduce the blue tint that remains.
Be careful not to go over their edges and affect
the skin. Press Close at the bottom of the
adjustments to confirm these changes.
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primary light source can produce inaccurate
results. Very often, we need to count on post-
production techniques to correct the white
balance in our images, whether that's warming
things up or cooling them down. This technique
uses Lightroom'’s principal colour correction
tools, along with more accurate tools at hand,
such as the Adjustment brush, to adapt colour
in shadows to get a better correction.

White Balance Selector Under the Basic
set of adjustments, click on the White
Balance Selector tool (W). For correcting
white balance, we need to tell Lightroom
what areas are supposed to be white.

Above

Too blue

Due to poor light, blue tinting has
started to appear, which the camera
has struggled to compensate for

Adjust colour temperature If you notice

a slight blue tint still visible in some areas
around your shot, click on the Adjustment
brush option just under the histogram and set
Temp to 25 with all other sliders at O.

Tone down colour If the image is now

too orange at this point, try reducing the
Temp slider by approximately 5. Push up the
Vibrance slider to around 30 to bring more
colour to the model’s hair.

7

Sharpen details Boost up the Amount

under Sharpening to about 90, Radius to
1.5 and Detail to 5. This will make the details
seem crisper. View a before and after using
the small boxes along the bottom left.

Smooth skin Go into the Detail section

and boost up Luminance to around 40. This
will soften the image and smooth skin, and
reduce the noise created by the white balance
corrections we've applied.



Warmer tones
It's better to edge towards
the warmer tones for
outdoor portraits, as these
look more natural and are
more pleasing to the eye
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Enhance portraits

in Lightroom

Take inspiration from Dave Hill, a photographer
whose style made him synonymous with drama

Ithough Dave Hill is an accomplished
Aall-rounder when it comes to

photography, it's with his classic
portrait work that he has made a name for
himself. He's managed to make his name
become an adjective — the ‘Dave Hill’ look is
commonly referred to online to describe an
effect that focuses on skin tones and lighting.
Good lighting is essential so skin appears soft
yet dramatic. A colour scheme is also applied
to help place more emphasis on skin tones
and atmosphere, and it's this combination of
lighting and colour that makes the whole scene
appear surreal yet natural. We're going to show
how you can imitate this style using Lightroom.
Despite not having Layers, Lightroom provides
the tools required to get the Dave Hill look.

Apply basic edits With your image in
Lightroom, head to the Develop module.
Boost Exposure to +0.12 and increase the
Contrast and Shadows adjustments to +40,
Whites and Highlights to +25.

Check the Tone Curves Go down to the

Tone Curve and lower the Highlights and
Lights to between -40 and -50, and Darks
slider to -10. This will flatten the image’s tonal
range. Set Shadows up to +80 to retrieve detail.
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BEFORE

Above

Light source

Atungsten lamp gives us an
orangey yellow hue to work with,
which we can use to emphasis
the tones of the skin

Adjust colour and detail Under the
Presence section, set Clarity to +100 and
Vibrance to +55, or until you see an increase
in colour. The Clarity will make skin look
overly textured, but this is easily restorable.

HSL colour tweak In HSL, select
Saturation and reduce some of the
colour saturation of non-dominant colours.
Emphasise colours similar to skin tones. Make
sure the main colour is the strongest one.

N

Exaggerate colour Click on Luminance
and increase the values of the strongest
colours to brighten them even further. The idea
is to draw attention to the person as much as

possible through the use of colour and light.



S
|
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AFTER

Inspired effect

A strong vignette, subdued
colours and strong tones all go
towards making this portrait
stand out from the rest

Set up Adjustment brush To counteract Softer skin tones Brush over the areas of Sharpening and detail Set sharpening
the Clarity, we can soften skin. Select skin to apply the Adjustment brush settings. high to 100 and Radius to maximum to get
the Adjustment brush and set all sliders to Notice how the skin softens and almost blurs. the most out of the image. Add a post-crop
0 apart from the Clarity, which needs to be This helps to replicate the look of the images vignette to finish the effect off and make it
about -26, and Noise which needs to be 100.  created by Dave Hill. more dramatic.
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Retouch mature skin

Discover how to use Photoshop to convincingly lessen
the appearance of skinimperfections in older subjects

etouching skin is rarely simple. Unless
Ryou are retouching a portrait from a

high-end advertising or fashion shoot,
you invariably need to retain a sense of
realism, which means you walk something of a
tightrope while you work. Do too little and the
result may not look professional; do too much
and the retouching may be all too obvious,
undermining the effectiveness of the portrait.

Create a blank layer Zoom in on your

subject’s face. Begin by creating a new blank
layer. It is a good idea to name each layer to
make it easier to know what each is for — for
instance, name this one ‘smooth skin’

Retain realism The secret to retouching

mature skin convincingly is in bringing
back some of the original detail of the image.
To do this, simply lower the opacity of the layer
slightly. Between 80-90% works well.

Bring back detail As in Step 3, it's time to
reveal some of the wrinkles you removed
in the previous step. Take the opacity of the
layer down to about 60 per cent so that your
model's appearance isn't anachronistic.

156 Photography Tips, Tricks & Fixes

This becomes all the thornier when faced
with retouching a mature subject. Whereas it's

plausible for a younger model to have relatively

flawless skin, we associate wrinkles and age
spots with older subjects, so their removal will
destroy the creditability of the image.
Discover how to ensure your retouching is
subtle enough to retain believability while also
diminishing blemishes in mature skin.

Smooth the skin Select the Brush tool
(B) and hold then click while holding
down the Opt/Alt key to choose a skin tone.
Using a low opacity, 20% or less, paint the

model’s face to even the skin tone.

Remove skin flaws Click back on the

Background layer and duplicate it,
naming it something like ‘heal imperfections’
Use the Healing brush set to either Replace
or Normal to banish obvious skin flaws.

Reduce teeth discolouration Flatten the

layers and make a selection of the mouth.
Press Cmd/Ctrl+J to copy this to a new layer.
Use the Sponge tool (O) set to Desaturate and
a low Flow to reduce teeth discolouration.

\ \

Above

Mature model

It can be challenging to retouch a
mature model’s skin, as you need to
ensure that the result is plausible

Deal with skin creases The next stage
is to reduce wrinkles and skin creases:
duplicate the heal imperfections layer, rename

it suitably, then use the Patch tool, set to
Destination, to get rid of the majority of these.

Brighten the teeth Use the Dodge set to
Midtones and a low Exposure to brighten
the teeth. If you feel you've gone too far,
lower the layer's opacity. You can also apply
these techniques to the whites of the eyes.



Tips| Tricks|Fixes

AFTER
Subtle Photoshop

The secret is to ensure that
you work with layers and
reduce the opacity at key

points while you work
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Use High Pass
skin softening

Utilise Photoshop's filters to retouch your
portraits with this alternative technigue

sk a group of portrait photographers
Ahow they go about skin retouching

and you'll probably get very different
answers. The truth is, there are a variety ways

to retouch skin and smooth out blemishes
in Photoshop, but they all have their own

BEFORE

Set up layers Open a portrait image

that needs skin softening into Photoshop.
Make sure you look for an image that hasn't
been processed or retouched. Duplicate the
Background layer by pressing Cmd/Ctrl+J.

Convert for Smart Filters Before

applying any filters in Photoshop, we need
to convert the layer for Smart Filters so that we
can re-edit them at any point. To do this, click
Convert for Smart Filters in the Filter menu.
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advantages. It's all about finding a method
that works for you, and one that you can
comfortably fit into your workflow. This
particular technique puts the High Pass filter to
good use, but not in its usual way. By applying
it and inverting the layer, a reverse effect to
sharpening can be achieved. By combining the
filter with a layer mask and Photoshop'’s Color
Range selection method, you can single out
everything that isn't skin and soften everything
that is. The advantage of retouching skin in
this way is that you reduce the risk of leaving
behind any signs of heavily retouched pixels,
resulting in an image that appears very natural.

Left

Eye-catching portraits

This is a strong portrait image, but notice how
the skin texture is not quite blemish-free

memaa

Az
L &

Blend your layers To blend the

exposure of the duplicate layer into the
background, change its blend mode from
Normal to Overlay. The contrast will appear
very heavy at this stage.

Invert image Head to Image>

Adjustments>Invert (or press Cmd/Ctrl+l)
to invert the first layer. Because of the Overlay
blend mode, you'll notice some grey areas
appearing around the skin.

AFTER

A softer complexion
Using an inverted High Pass
filter creates a softening
effect that retains much of
the original skin texture

R
Use High Pass filter Head to the Filter
menu again and go down to Other>High

Pass. Start by reducing the Radius slider to

its lowest value and then gradually increase it

until the skin appears softer.



Click on the Background

layer. To select just the skin, go to Select>
Color Range. Set the Select drop-down menu
to Skin Tones. Slide the Fuzziness adjustment
up until all the skin is white in the preview box.

Press Q to load Quick
Mask mode. Use the Brush tool (B) set

to black to add red to areas of the face other
than skin. Press X to add areas to the selection
then Q to return to normal mode when done.

Click on the High Pass
layer and add a layer mask. If the edges
of the face haven't been included in the mask,
use the Brush tool set to white and an opacity
of 30% or less to blend in the High Pass effect.
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Rescue shiny skin

Getto grips with Photoshop's brushes and
adjustments to tackle flash hotspots in portraits

lash is never an easy one to get
Fright, and even the most experienced

photographers get it wrong some of the
time. Much like everything else in photography,
it's trial and error, but fortunately for us
Photoshop is at hand to give us the freedom
to correct problems such as blown-out skin
post-shoot. Using a combination of brushes
and layers, shiny foreheads and noses can be

Y

-,
. i \
Add a layer First we need to set up the
Layers palette. Add a new layer above the

Background by clicking on the Create New
Layer button that can be found at the bottom
of the palette.

Change layer’s opacity Lower the opacity
of the new layer to 20% using the controls
in the Layers palette. Changing the layer’s
opacity instead of the Brush tool's opacity lets
us boost the strength of the effect later on.
o

W
{
Y

(14

/

) S

Bid highlights farewell Brush over the
highlights on the portrait to reduce the
shininess. Because we're using a colour similar
to the skin tones, the results will look as

natural as possible.
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brushed back to a normal exposure. However,
we're not directly editing exposure. By applying
a similar skin colour over these areas and
blending them in, it's more as if we're applying
make-up in the form of digital paint. By the end
of this tutorial, you'll learn the skills required

to use Photoshop to save your images from a
bright flash exposure, saving you the time it
would have taken to arrange a reshoot.

R

= ‘
. , ‘

Set blend mode We'll be applying all the
edits to this layer so we can work non-
destructively. Change the blend mode of the
new layer from Normal to Darken using the

drop-down list.

Set Brush’s opacity Now press B for
the Brush tool. Set the tool's opacity
from the Options bar to 80% to help
reduce the strength. Make sure the Brush's
Hardness is set at 0% so the edges are soft.

v

Increase effect If you don't see any

reduction in the highlights, you may need
to increase the opacity setting of the Brush
tool up to 100%. If still no changes appear, you
might need to select a darker skin tone.

© https://pixabay.com/en/closeup-beautiful-female-face-1434850/

Above

Great shot, poor exposure
This image has been slightly
overexposed and the subject’s skin
looks rather shiny as a result

TPG0Fan v RN rNSN AR

ead

-,
\‘ - Bd

Sample from skin Before applying the

Brush tool to the skin, press and hold Opt/
Alt. A small eyedropper will appear. Use this to
sample an existing skin tone colour. Sample a
colour that's neither too dark nor too light.

[

s LI ] Nansmaassen b7
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Boost visibility To see a significant
change, boost up the layer's opacity
setting to 40-50%. This should get rid of all
highlights. Use the Eraser tool (E) to remove

any brush marks, over eyebrows for example.
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Banish blotchy skin tones

Use Photoshop'’s brushes and blend modes to deal with uneven complexions

The question of how much we should
be editing portraits has always been
a topic for contention. How far from
the truth should we change someone’s natural

appearance? The answer will be in part down to

the model, just as much as it is decided by the

photographer. The model may actually request

their skin be retouched to improve complexion
or reduce redness. Importantly, making these

corrections doesn't take years of experience, as

Photoshop makes this a fairly painless process
that anyone can put into practice. Using soft
brushes combined with colour-sensitive blend
modes and adjustment layers, we can disguise
unwanted colour tones in minutes.

Sample the skin Select a colour of

unaffected skin tone by pressing Opt/Alt.
If there isn’t any normal skin tone to sample
from, input ‘# daad9a’ into the Color Picker
palette for a skin tone colour to use instead.

Retouch uneven tones Use the Clone

Stamp tool to sample areas of blemish-
free skin by pressing Opt/Alt. Gradually brush
over uneven skin tones to fade out any heavy
blotches that still remain.
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your portrait. We're going to be working with
brushes and adjustments, so it's important to
create a blank layer on top of the background
layer first by pressing Cmd/Ctrl+Shift+N.

Fade the red Start to brush over the

red blotchy skin to apply the new colour.
You should start to see the redness fade.
Increasing the Brush tool's Opacity up to 30%
will help to apply more colour.

Create new adjustment layer Add a
Hue/Saturation adjustment layer from
the bottom of the Layers palette, and set its
blend mode to Lighten. Inside the adjustment,
change Master to Red.

Set up tool Set the new layer’s blend

mode to Hue, as this will help us adjust the
colour with any brushwork. Select the Brush
tool (B) and make sure its Hardness is set to
0% and its Opacity is 20%.

W i

Utilise Clone Stamp Set this tool's

Opacity to 30% and add another new
layer. Set the blend mode of that new layer
to Lighten in order to prevent removing the
highlights on the face.

N RN

Reduce saturation Lower the Saturation

slider to -20, then click the adjustment’s
mask and press Cmd/Ctrl+| to invert it. Use
the Brush tool set to white to brush over any
leftover red areas to remove them.



The end result
" Working with existing skin
tones, we can create an
effect that's natural and
still maintains the lighting

- Natural as it may be
“skin tones appear reddis i
which could be enhanced by;\cl !

lighting or poor white balanciné AN 1>

by
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Control colour
with Camera Raw

Dig deep into ACR’s adjustments for the ultimate
control over hue, saturation and luminance

hen we talk about editing colour
Win an image, it's not just a case of

simply pushing up the saturation
slider to achieve better tones. The Camera

Raw software from Adobe lets us take our
images straight from the camera and process

them to perfection. The HSL adjustments (Hue,

Saturation and Luminance) enable us to adapt

= ——

Locate HSL If using the Camera Raw Filter

in Photoshop, convert the image to a Smart
Obiject first. If you are importing RAW files, this
won't be necessary. When inside ACR, head to
the HSL/Grayscale section.

Improve colour throughout Observe

other prominent colours and push up the
relevant ones inside the Saturation section to
between +50 and +70. You may need to do this
for Oranges, Yellows and Greens.
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colour so that we can create realistic, eye-
catching results. Instead of tweaking the Color
Balance, Temperature or Tint sliders, which will
modify the image as a whole, the HSL sliders
allow us to adjust specific parts of the image
depending on their colour information. This
means that we can achieve brilliant blue skies,
luscious green grass and soft, glowing reds

all in one image, completely independently

of each other. Start with the Saturation
adjustments and then move on to the
Luminance sliders to create a better balance.
Finish with tweaks to the Hue sliders and your
landscapes will never look the same again.

Left

Where’s the colour?

This may be a beautiful landscape, but it lacks
depth and colour. The HSL sliders enable us to
alter the trees, river and sky separately

Start with Saturation The best place

to begin in HSL is with the Saturation
adjustments. Increase the Blues slider to +70
or above to deepen the sky's colour. It should
look like a graduated filter was used.

Control Luminance Click on the

Luminance tab. These sliders control the
brightness of colour. If you wish to enhance a
blue sky, decrease the Blues slider to -30. To
reduce colour noise, decrease Aquas to -3.

AFTER

HSL to the rescue

Using the HSL sliders in Camera
Raw, the image is replenished
with colour and saturation and it
appears natural and bright

Eliminate colour noise Take a look at the
darkest blue areas of the sky. If you notice
any noise distortion, you can increase the
Purples slider to +70 under Luminance. This
will help to offset any noise.



Adjust slightly You may not want to

boost the Luminance sliders for all the
colours in your image, as things can quickly
turn pale. Usually, boosting the Greens and
Yellows is sufficient to get natural results.

F A

Intensify colours By tweaking the Hue

colour sliders by no more than +/-20,
colours such as blue, green and yellow can be
intensified. Adjusting them any more than this
could alter their natural colours.

Tips| Tricks|Fixes

=

Improve colour transitions If you notice

that some colour distortion or noise
remains at this stage, head to the Detail tab in
ACR and boost the Color slider up to 40-50 in
order to combat this.
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Use Content-Aware
cloning in Photoshop

Learn how to completely remove a distracting
subject in your landscape and travel images

The tools used for cloning pixels have account the surrounding pixels to assist you

come a long way over the years, and in creating an accurate result. Don't get too

they are now well and truly part of the carried away, however, as the Content-Aware

Adobe Photoshop experience, providing a method of cloning pixels isn't perfect every

way to remove or reposition objects with time. Here we'll show you how to use the

the software making an effort to take into Content-Aware Fill and Move tools, along with
some basic cloning, to get great results. As

" BEFORE e p—— with all cloning projects, we want to reduce

the appearance of repeating pixels in order to
make the final image as believable as possible.
We're starting off with the Quick Selection tool
because it gives us a straightforward way to
select the pixels we want to clone.

Left

Changing composition

The Content-Aware tools work best on images
that have similar pixels to reduce repetition,
such as grass or sky, for example

Ll 3 t i \ ' Y o :
Select the subject Start off by duplicating Modify selection area With the selection
the Background layer (Cmd/Ctrl+J) and complete, go to Select>Modify>

going to the Quick Selection tool (W). Form a Expand. Set Pixels to 20 and hit OK. This will
selection over the subject you want to remove. push the boundaries of the selection outwards
Lower the tool's size to select smaller areas. to include more of the background.

/2 ’:
A / . 4 {‘ | 43 ol

Content-Aware Fill With the selection Patch tool settings Press Cmd/Ctrl+D to Patch things up Use the Patch tool to

active, go to Edit>Fill. Set the Contents remove the selection. To remove anything draw around an area, such as a shadow.
menu to Content-Aware. Untick Color left over from the subject, locate the Patch tool  Try to select just the shadow with as little
Adaptation and hit OK. The selected subject (J). In the Options bar, set Patch to Content- background as possible. Drag this selected
should vanish, but may leave a blurry edge. Aware, Structure to 5 and Color to O. area over neighbouring pixels to replace.
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AFTER

A big difference
w Using a number of Content-Aware "

* and cloning tools, you can patch up 4
© areasthat are left behind after the "’“ o
removal of a large subject :
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Content-Aware tool The Content-Aware Retouch the scene By dragging and Healing pixels If any small areas look

Move tool does a good job at cleaning dropping new areas over the fuzzy areas fuzzy, add a new layer and use the Clone
things up. Set it to Extend, with a Structure of  with the Content-Aware Move tool, the image Stamp tool (S), set to Sample All Layers, to
7, and select an area of ‘good’ pixels, similar in can be retouched. Using the Patch tool set to retouch those areas away. Press Opt/Alt to
size to the area being removed. Normal also helps remove repetitive pixels. sample good pixels over the bad ones.
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Edit with clipping
masks in Photoshop

| earn how this often overlooked function can aid
your retouching and editing work

C lipping masks play a key role in
Photoshop’s ability to combine the
contents of two layers. They function
as a sort of visual image wrap. In this tutorial,
you will learn how to combine adjustment
layers with clipping masks to make sure

that the adjustment only alters the layer
underneath. This means you're able to split
the image into layers, separate the objects
and apply independent adjustments non-
destructively to each one.

To illustrate the techniques, here you'll learn
how to select one colour in an image and
make it the centre of attention by converting
the remainder of the image to monochrome.
This effect can be produced in many ways in
Photoshop using layers and adjustments, but

Make selection To create this effect with
clipping masks, we need the main object
in colour on a separate layer. Use the Quick
Selection Tool (W) to make a basic selection
around the object that'll remain in colour.

Loy
Pxnd moeTnA®
Normat Opaciy._100%_

ok B b DL @ Rk o

Convert to mono Click the Background

layer (the bottom layer), then go to
Layer>New Adjustment Layer>Black & White.
In the pop-up box, tick the option ‘Use Previous
Layer to Create Clipping Mask’ and hit OK.
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this is one straightforward example of how
clipping masks can be applied with help from
selections as well.

2 °
0 g ¥
= o\ -
© Pixabay.com (773021) N
Above
Colour clash

You may have an image with multiple colours that just
don’t work, or don't have enough colour impact overall

Apply layer mask With the selection

complete, drag the Background layer onto
the New Layer button in the Layers palette.
Then click the Layer Mask option to apply the
selection as a mask.

13 Properties
WX Biack & white

Prasst: Defoult

& O | Auto

Reds: =

Yellows: 7

Adapt mono effect Alter the colour

sliders in the Black & White adjustment
layer to create the desired look for the
background. We can adapt the colour of the
main object separately in the next step.

AFTER

Clipped colour adjustments
A selective colour effect is ideal for
separating the strongest colour
from the rest of the image using
clipped adjustments

©® H0O0DaR

Clip an adjustment Click the topmost
layer and go to Create New Fill/Adjustment
Layer in the Layers palette. Add the Levels
adjustment, hold Alt/Opt, then click the line
between the adjustment and object layer.



Tips| Tricks|Fixes

Alter Levels adjustment With the Levels

Z=S

Apply more adjustments Now add the Edit colour balance Use the Color

adjustment clipped to the layer below, we Color Balance adjustment and clip it to the Balance adjustment to enhance and
can edit the brightness and contrast of the layer below (you can also go to Layer>Create strengthen the colours of the main object so
main object without affecting the background Clipping Mask). Both adjustments should be they stand out. Because it's been clipped to
or any other part of the image. stacked up with clipping masks applied to both.  the layer, it won't change the background tone.
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Create a

tilt-shift effect

Give your captures a unigue
perspective twist in Lightroom

with this simple tutorial

style that's become renowned
Athrough perspective-control lenses,

the tilt-shift look is an increasingly
popular effect in photography, with many
compact cameras now embracing the effect
through creative filters. Yet not all cameras can
produce it, and that's when we have call upon
Lightroom to re-create this style accurately.

- BEFORE

Set up Grad filter Load up your image into

Lightroom and go to the Develop module.
Click on the Graduated Filter tool just the
under the Histogram graph. Set the Sharpness
slider to -100 inside the list of adjustments.

At first glance, it appears impossible to
create the tilt-shift look using Lightroom,
because there are no blurring adjustments to
make the extreme depth of field required. But,
fortunately for us, there is a workaround, and
this involves using the Sharpness adjustment
with the Graduated Filter tool. In fact, it's
only possible with Graduated Filters, because
we do this by sliding the Filter's Sharpness
adjustment into the negative figures, creating
an effect opposite to sharpening — blurring!

So go ahead and try this out on your
images. Be sure to pick one with a bird's-eye
perspective and a busy environment for the
most interesting tilt-shift masterpiece.

Left

The perfect setup

A good image leads to an even better
result — make sure you have an image
with an angle similar to this

Apply Grad filter To apply the filter, click

and drag from the centre of the image
downwards. Apply a second Grad filter just
below the first and drag it in the opposite
direction to make a strip of in-focus pixels.

Double up Grad filters Place another set
of Grad filters on top by repeating Step
2. Make these larger so as to create more
blurring over the background and foreground
areas to replicate a perspective-control effect.
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Boost colours Close the Grad filter's

adjustment panel. Inside the Basic
adjustments panel, boost the Saturation slider
to +30 to increase colours across the whole
image for the characteristic toy-camera look.

Alter Contrast In most cases, the image

can do with having more contrast and
brighter highlights. Increase the Contrast
slider up to about +40 and lower the Blacks
and Shadows sliders for deeper contrast still.



Noise reduction With these adjustments,

you may find your image has acquired
noise. Go to Detail adjustments and set the
Luminance slider under Noise Reduction to
+50, or until the noise begins to disappear.

Tweak blur position Now we have the

colour and detail looking right, click back on
the Graduated Filter icon and carefully position
the gradients so that they reveal just enough
of the image for the best possible effect.

AFTER

More contrast

and less detail

Street objects such as people
and cars are made to look
artificial by reducing their detail
and boosting colour and contrast

Export To quickly save out the image,

right-click on the image and go to Export
and select the location on your PC to save it
to. Choose file format and set up the various
parameters for next time using the presets.
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Adda
sky with
more drama

Give your landscapes
atmosphere with moody
storm clouds

ow often do you arrive at an amazing
location, only to find the atmosphere

and mood isn’t what you wanted?
Perhaps the Sun is too high or the sky is just
clear and bland - should you put up with this,
or is there another option?

Adding a cloudy or moody sky in post-
production is a great way to introduce more
drama into your scene, but there are a few
tricks to keep in mind.

First, start collecting cloud and sky
photographs as soon as possible. Keep
a camera with you at all times. Many
photographers build a library of potentially
helpful skies, ready to make use of them in
post-production when the need arises.

If you want the sky to look natural, as though
it were really there at the time of capture, use
the same lens and approximately the same
camera angle to photograph the sky as you
did for the landscape. When you're building
your cloud and sky library, consider the focal
lengths and shooting angles that you most
commonly use.

Photographs with complex horizon lines and
fine detail are more challenging to edit, unlike a
photograph such as the one shown here, which
has a relatively simple horizon line.

Right

Ani, eastern Turkey

The Church of the Holy Redeemer was
photographed on a blue-sky day, but this isn't the
mood that the photographer wanted to convey.
The solution: add in a more impressive sky
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WATCH FOR FINE DETAILS
It can be easy to miss little areas
like windows when droppingina
sky — but avoid doing so or you
will give the game away.

MATCH THE

HORIZON TONES

If you look at real landscapes,
the sky is often (but not always)

lighter towards the horizon. You
PICK A GOOD SKY may wish to lighten the sky just
Try to match your new sky % above the horizon to complete
to the landscape below, both o : 3 your edit.
in terms of light, colour and r
lens angle.

BEFORE

Open both files in Photoshop

There are many ways you can
combine two photographs into a
single file. If you're new to layers,
begin by opening both the files so
you can see them on the screen.

Copy sky file Click on the

image of the sky, select all of it
(Select>Select All or Ctrl/Cmd+A).
Copy it (Edit>Copy or Ctrl/Cmd+
C). At this stage you can close the
photograph of the sky if you wish.
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Layers
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Paste in the sky Open the
Layers panel (Window>Layers) - T ———
and ensure the landscape layer is ]
active (click on it). Paste the sky on 2 == ‘E et
top (Edit>Paste or Ctrl/Cmd+V). You
now have two layers. Hide the sky g BT
layer by clicking on the eye icon.

“Nomal < opacty: 100% [=

Select the sky to remove

Click the landscape layer in the
Layers panel and make a selection of e )
the sky. With a blue sky like this, the : = kS T
Quick Selection Tool worked well. It is = ' SEOAN 20 T Lo
important to make this selection ‘ : o Y —
as accurate as possible. T ——

< - E@“ Layer 1
Add a mask In the Layers panel —|

turn on the sky layer (click the , o . | 2 b o
eye icon) and make it active. Now : '
click the Add Mask icon at the
bottom of the Layers panel or Layer>
Layer Mask>From Transparency.

Normal % Opacity: 100% [
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Refine the mask Enlarge your
image view up to 100 or 200%
and look carefully along the edges
where the sky meets your landscape.
For a perfect result, you may need
to adjust the mask by painting on it
with a small white or black brush.

Add interest below Use
adjustment layers to add colour,
contrast and interest to the landscape

below. Place the adjustment
layers below the sky layer and the
adjustments will not affect the sky.

Add interest above To add

colour, contrast and interest to
the sky, add your adjustment layers
above the sky layer, but then create
a Clipping Mask (Layer>Create
Clipping Mask) so it only affects the
image layer directly below.

Refine the edit To edit the

image as a whole (both the sky
and the landscape below), just add
in adjustment layers at the top of the
Layers panel as normal, and don't
create a Clipping Mask.

1 No limit with layers The final
image uses a total of 27 layers
and adjustments layers, but each layer
is just a small adjustment, refining
and perfecting the rendition. How
many layers you add is up to you!
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AFTER

An atmospheric improvement
While not ideal for a travel brochure,
the final rendition is much closer

to the feeling and-atmosphere the
photographer had in mind

B K @B @ B B B
2 0 ® ©® ® ©® 0 o ¥

e

B OE H

B $ @ § B § B §

Photography Tips, Tricks & Fixes 175




SUBSCRIBEANDSAVEUPTO 74 7%

Every issue of your subscription, delivered direct to
your door. Print & digital editions available.

THE ESSENTIAL GUDE TO CLASSC GAMES:
a

ETOUCHING

EXPERT EU\'UNG'E\JIDES TO IMF,

‘, » D|g|ta| Prockeal NI —
Photog =

| swdphotographercoui

:3\~
(

‘pioneering hybrid drums
Bbiggest stars in music 5

myfavouritemagazines.co.uk



WIN! A MONTH'S MEMBERSHIP AT ARCHERY FIT!

BOW - B
INTERNATIONAL y::: ‘ %egsatrnis
STUBB b

BUFFY < FIREFLY - MAD MEN - SEINFELD - SHERLOCK - STAR TREK - THE WALKING DEAD - N-FILES

THE

STRANGER
THINGS

DISCOVER MORE GREAT GUIDES & SPECIALS

From photography to music and technology to field sports,
there’s something for everyone.

Amazon
- Echo

The Complete Manual

independent handbook for Amazon Echo users i

Hitlerhad  Sovietshadwon Napoleonhad
invaded Britain? the Space Race? won at Waterloo?

Our magazines and binders make perfect gifts
too. And don’t worry if you’re not quite sure which
titles they’ll enjoy the most because we have a
great choice of gift vouchers available to buy.

«” No hidden costs [ Shipping included in all prices €3 We deliver to over 100 countries {g Secure online payment

- L . . . .
FuTure Myfavouritemagazines  myfayouritemagazines.co.uk

- r Official Magazine Subscription Store



HOW TO USE

o

To access FileSilo, please visit www.filesilo.co.uk/bks-1700

O Follow the on-screen O Onceyouhave O You canaccess
instructionsto create loggedin, youare FileSiloonany
an account with our secure freeto explore the wealthof : desktop, tablet or
FileSilo system, loginand content available on FileSilo, : smartphone device using
unlock the bookazine by from great video tutorials any popular browser (such
answering asimple question - andexclusive online guides as Safari, Firefox or Google
. aboutit.Youcan - tosuperbdownloadable Chrome). However, we
thenaccessthe resources. And the more recommend that youusea
content for free bookazines you purchase, desktop to download
atanytime,and the more your instantly content, as youmay not be
downloaditto accessible collection of able to downloadfiles to
your desktop. digital content will grow. your phone or tablet.

O If you have any
problems with

accessing content on
FileSilo, or with the
registration process, take a
look at the FAQs online or
email filesilohelp@
futurenet.com.

(oo e flesilohelp@futurenet.com

o | =
o filesilohelp@futurenet.com

Ca:

« Arapidly growing library . orn disc p:

Photoshop Bookazines
R BsHoP Photographer
and(gid iCreate

L

7 Praview &

Praset: | Custom

Remove: Gaussan Bur °

o ¥ Shadows

Fade Amount: = =[] %

Tonal Width: =
& Radiug; g | i
| Higntights

Fade Amount: 0 %

Tonal Width; = 50 |9%

« Updated continually with cool resources « Digital magazine owners can get the content too!

« Keep your downloads organised . ribers get access to all content

ges to ruin your beautiful magazines
« Browse and access content from anywhere « Clickon a brand below to get started!

REGISTER

80 BOKEH BRUSHES







Photography

Tips, Tricks &Fixes

Capture stunning vistas, improve
your macro skills and learn the secrets
behind great wildlife photography

Create striking compositions,
shoot amazing panoramas
and use advanced techniques

Fixeq

Enhance your portraits,
fix imperfections and add
gorgeous colour effects

@ Brushes, actlons,f' Iters& more

e ﬁ Rk

80 BOKEH BRUSHES

The ultimate creative assets
v/ 100 essential brush strokes
v/ 20 skin retouching actions

v/ 80 beautiful bokeh brushes

- v/ Gorgeous faded film filters Eﬁﬁ

100

Essential Brush Strokes

BOOKAZINE

?n R ccccc mng/\ rrrrr

4



